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Introduction 

 

The purpose of this document is to provide a walk-through of the features of the DAVE™ Death 
and Fetal Death modules.  These features include registration, amendments, order processing, 
and issuance of death and fetal death events.  DAVE™ also supports common forms of reports 
required by State and Local Registrars and is available 24 hours per day, 7 days per week.   

User Guide Conventions 

To aid in understanding the content of this guide the following conventions are used: 

 Information icons in blue highlight boxes feature additional information regarding each topic 

 Caution icons in yellow boxes warn of actions that may result in a negative user experience 

 Red warning icons focus on actions that are prohibited in the application 

>> Italics reference labels, buttons, hyperlinks, and navigation paths 
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1. General Recommendations 

1.1 Web Browsers 

DAVE™ is a web-based application leveraging the latest browser technology. While the most 
recent version of Microsoft’s Internet Explorer (IE) is recommended, DAVE™ also supports the 
use of Mozilla/Firefox and Chrome browsers.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 IE is the only browser that currently supports the DAVETM Biometric feature. 

 

 As a general rule, do not use a browser’s 
back button while working in the DAVETM 
application. This could result in the loss of data.  

 
 

 

 Where available, use the page specific Back, Return or Cancel buttons to return to a 
previously viewed page. 
 Use Application 

Navigation 

Do Not Use 
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1.2 Creating an IE Favorite or Desktop Shortcut 

Create an IE Favorite or Desktop Shortcut for easy one-click access to the DAVE™ application.  

Steps to Add a Favorite: 

1. Navigate to the DAVETM website 
2. From the IE Toolbar select Favorites > Add to Favorites  

 

 
3. Select the Add button on the Add a Favorite dialogue box. The Name fills automatically and 

can be changed if desired. The link is now saved in the IE Favorites List. 

 

Steps to Add to Favorites Toolbar 

1. Navigate to the DAVETM website 
2. From the IE Toolbar select Favorites > Add to Favorites Bar  
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3. Right-click on the Logon item that now appears in the Favorites toolbar and select 

rename  
 

 
 
 
 
 
 
 
 

 
 
4. Enter a name that is an easy to remember reference to the DAVETM website and select 

OK 
 
The New Favorites Toolbar Shortcut is ready for use 
 

 
 

Steps to Add a Desktop Shortcut: 

1. Navigate to the DAVETM website login page 
2. From the IE toolbar select File > Send > Shortcut to Desktop 
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3. This creates an icon on the desktop that quickly launches IE and opens the DAVE™ login 

page. Right-click on the icon and select rename to rename the shortcut. 
 

 
 



 

 

2. Getting Started  

2.1 Logging into DAVETM 

2.1.1 First time Login 

 
 Navigate to the DAVE™ login page. Enter the Username and temporary Password 

assigned by the system administrator. Select the Login button. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 If the user logging in is associated with more than one office or location, a list of available 
offices will be presented. Select the desired office.   
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 At first login, or to update or change a password, the user will be presented with the 

following prompts: 
 

 Enter the temporary/current password in the Old Password field 

 Create and enter a new password in the New Password field 

 Re-enter the new password in the Confirm Password field 

 Choose a Security Question 

 Enter a Security Answer 

 Choose Save 
 

 

 The confirmation page will display. Select Continue to be taken to the Home Page or 
Logoff to exit DAVE™. 

 

 

 

 

 

 

 See section 2.6 Change Password for information regarding changing existing 
passwords 
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2.1.2 Forgot Password 

 

At login, if an incorrect Username and/or Password is entered, the application displays an error 
message:   

 

 

 

 

 

 

 

 

Steps to follow if a user has forgotten their password: 

1. Select the Forgot your password? link to open the Request New Password page 

2. Enter the username  

3. Type in the code displayed by the security Captcha  

4. Select the Next button 

 

 

 A CAPTCHA is a challenge-response test most often placed within web forms to 
determine whether the user is human.  The purpose of CAPTCHA is to block form 
submissions by spambots, automated scripts used to post spam content on commercial 
websites.  

 Passwords must be at least 8 characters in length and must contain at least one 
uppercase letter and one number. The use of “Strong” passwords is recommended. 
 

A “Strong” password: 

 Is at least 8 characters long and contains uppercase and lowercase letters, 
numbers and keyboard symbols 

 Does not contain a complete word 

 Is significantly different from previous passwords 

 Does not contain your user name, real name or company 



State of Arizona DAVETM User Guide  

 

  12 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

 

 

5. If the Username is found in the system and the Captcha image identified correctl, the user’s 
Security Question will be displayed.  Key in the correct answer to the security question and 
select the Next button 

 

6. The user will be allowed 3 attempts to correctly answer the security question. If upon the 
third attempt the answer remains incorrect, an error message will be displayed and the user 
will need to contact the system administrator to have their password reset. 

7. If the answer to the security question is correct, an email will be sent to the email address 
on file for the user within the DAVE™ system.  This email will contain a temporary password 
that the user can then use to login. 

 

 

  

 Once a user receives a temporary password, they should follow steps in section 2.1.1, 
First Time Login, to set a new password.  
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2.1.4 Change/Update Password 

Steps to Change Password: 

1. To update an existing password, from the main menu select Main > Change Password 
 

 
 

 

 

 

 

 

Steps to Update Password: 

Every 90 days you will be required to reset your password. As the 90 day mark approaches, a 
pop-up message will appear at login displaying the days remaining until password expiration 
and asking if you want to change your password Now or Later. 

1. Selecting Later will take you to the Home Page 

2. Selecting Now will take you to the Password Reset page 

 

 
 

  

 User can now follow steps in section 2.1.1, First Time Login, to set a new password.  
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2.3 Messages 

The completion of a case most often depends on the input and/or actions of more than one 
user. DAVE™ provides the ability to send internal messages and external emails to 
communicate outstanding needs. Some messages are initiated by system users, while others 
are system-generated. 

 

 

2.3.1 View Messages 

Steps to View Messages in DAVE™: 

1. Select Main > Messages from the Main Menu at the top 
of the screen or choose the Messages Fast Link icon on the 
Home page. 
 

 
 
 
 
 
 
 
 

 
2. The Messages pane displays all messages received by the current user  
 

 
 
3. To view a message Select the sender’s name in the From column  
 

 It is a recommended practice to check Messages on first login and throughout the 
work day 
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4. The message displays. Choose Close to return to the list of messages. 

 

2.3.2 Create and Send Messages 

 

 

 

 Messages and emails can be sent to a single user, multiple users, or all users within a 
facility. 
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Steps to Create and Send Messages: 

 

1. Select Main > Messages from the Main Menu at the top 
of the screen or choose the Messages Fast Link icon on the 
Home page. 
 
 

 
 
 
 
 
 

 
 
2. In the Messages pane select Send Message to compose a new message. 
 

 
 
3. A blank message displays with three required header fields: Recipients, Send By and 

Subject 
 

 
 
 
 

Steps to Add Recipients: 

1. Select the Recipients link in the message header to display the Choose Recipients popup  

 Red arrows  indicate required fields  
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2. To send a message to a specific user, Choose Person from the Type of Search 
dropdown list. 

 

 

3. Enter the First and Last name of the person you wish to send a message to then select 
Find.  
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4. A successful search will return the name and user type of the person you wish to send a 
message to. To add this person as a Selected Recipient, select the checkbox next to the 
name and then select Add. 

 

 

 

 

 

 

 

 

 

5. To send a message to all users within a facility, select 
Organization from the Type of Search dropdown list.  

 
 

 

6. Select Find to return all organizations stored in the DAVE™ database that match the 
search criteria entered or broaden the search by entering a partial organization name 
followed by the wildcard (%) character 

 

 

 

 

 Use caution when sending a message to an organization as the message is sent to 
every user associated with the selected facility. If the message is not meant for every user 
at that location, it is recommended that the Person search be used instead. 
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5. To add an organization as a Selected Recipient, select the checkbox next to the 
organization name and then select Add.  

 

6. Select Save, and three recipients, one person and two organizations, will now appear in 
the message Recipients list. 

 

 

 

 
 
 

 

 

 

 

 To delete a recipient, select the checkbox next to the desired name and select the 
Remove Recipient button.  

 To add additional recipients, repeat the same search process described above. 
DAVE™ will retain the selected names and allow the user to perform further searches. 
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7.  The second required message field to complete is Send By which determines how the 
message will be delivered.  

 

Send By Option Action 

Email and Notification Sends the message via external e-mail and internal messaging.   

Email Sends the message to an external e-mail address only. 

Notify  Sends message via internal messaging only. 

 

8. The last required field is entry of a Subject in the subject line.  
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9. Once all required fields are completed, add the text of 
your message and select Send to send the message 
to the listed recipients. A confirmation pop-up will then 
display. 

 
 
 

 

 

 

 

Upon selecting Send, If any required field is not yet complete, the application will prompt the 
user to fill out the missing data.   

 

 

 

 

 

2.3.3 Delete Message(s) 

 

 

 
Steps to Delete Message(s): 

1. To delete a single message, select the checkbox next to the message.  This enables the 
Remove from List button.  Select Remove from List to delete the message.   

 

 Deleted messages cannot be restored.  Do not delete a message unless absolutely 
sure it will not be needed later. 
 

 Selecting the Cancel button will close out the message without sending and return the 
user to the Home page.   
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2. To delete all messages, select the “Select All” checkbox to the right of the Date Sent column 
header. This selects all messages. Select Remove from List and all messages will be 
deleted. 

 

If the “select all” checkbox was marked in error, simply re-select. The checkmarks will be 
removed from the messages. 

 

2.4 Current Activities 

The Current Activities page displays a list of work queues containing records requiring 
attention. The listing is unique to each user and serves as a “to do” list. As with Messages, 
frequent monitoring of Current Activities is encouraged. 

Steps to Access Current Activities: 

1. From the Main Menu select Main > Current Activities or select the Current Activities Fast 
Link icon on the Home Page 

 
 
 

 

 

 



State of Arizona DAVETM User Guide  

 

  23 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

1. The Current Activities page lists queue names, the type of records in each queue, case 
count and age of the oldest case within each. 

 

 

 

 

2. Selecting a Queue Name allows access to records within the queue. In this example, the 
Certification Required queue is selected. 

 

3. Upon selection, the Search By Registration Work Queue page opens displaying a list of all 
records within the selected queue.   

 

 

 See section 13 Queues for more information regarding use of queues in DAVETM 

  If a queue does not contain cases, it will not be displayed. 

 If a user does not have security access to a specific queue it will not be displayed.  
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2.5 Main Menu 

The menu at the top of every screen is referred to as the Main Menu and is used to navigate 
the DAVE™ application.  

The Main Menu is dynamically created and will display differently for different user types based 
on assigned user security privileges.   

 

 

 

 

 

 

 

 

 

 

 

 

 

2.6 Change Office 

Some users may be authorized to view and/or edit cases in more than one facility. The Change 
Office feature allows users to log out of one location and begin working cases in another.  

Steps to Change Office: 
 

1. From the Main Menu, select Main > Change 
Office  

 
 
 
 
 
 
 
 

System Administrator Main Menu 

Funeral Director Main Menu 

Medical Certifier Main Menu 
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2. A confirmation pop-up will be displayed. Select the OK 

button to change office 
 
 
 
 
 
 
3. The Login page appears with a list of facilities associated with the user. Re-enter the 

password and select a new office 

2.7 Logging Out of DAVETM 

It is good practice to log out of the DAVETM system whenever you step away from your desk or 
workstation.  

There are two ways to logout of DAVE™: 

1. Select the Logout button from the Main Menu bar 
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2. Select Main and Logout 

 

 

 

 

 

If a user is inactive for longer than 90 seconds, the system will present a session timeout 
warning:  

 

 

 

 

 

 

 

The session time out allows the user 90 seconds to select Continue Your Session to avoid 
being automatically logged out. 

If no interaction from the user occurs during this timeframe, the user’s DAVE™ session will 
expire.

 

 

 Selecting Click here to logon returns the user to the Login page. 
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3. Site Navigation 

Using the computer keyboard as a navigation aid is an efficient way to move through the 
DAVETM application. To effectively navigate in this way, it’s important to understand Focus. 

3.1 Focus Navigation 

Focus determines which field or user interface control is ready to receive user action.  

 

 
 
If an empty text box has focus, a flashing cursor appears in the far left hand side of the field. 
As the user types, text is displayed. 

 

 

 

If a Dropdown menu has focus it will be highlighted in blue. Once the dropdown is opened, a 
user can choose from a list of values. 

 

A Checkbox or Radio Button will be surrounded by a dotted line when it receives focus. The 
box can then be selected by the user by pressing the keyboard space bar.  

 

Passing the Focus: Moving between these controls is a matter of passing the focus. This is 
accomplished by using the following keyboard shortcuts: 

 The Tab key advances the focus forward 

 Alt+Tab (holding down the Alt key while pressing Tab) passes the focus back to the 
previous control.  

 
Every page is structured a little differently.  Exactly where Tab and Alt+Tab send the focus 
will vary, but it should always advance logically from one control to the next. 
 

 What is a User Interface Control? Any element on a web page a user can interact 

with such as a text box or dropdown menu 
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3.2 Interactive Controls and Features 

Standard and custom user interface controls are built into the DAVE™ application to assist 
users in entering data accurately and efficiently. 

3.2.1 Dropdown Lists 

Dropdowns provide pre-defined lists of values, eliminating the need to manually key data. 
Select the down-arrow icon to display a list of selectable options. The value selected is passed 
to the text box field. 

 

Dropdown Menu keyboard shortcuts: 

1. Choose an option without expanding the list: If the dropdown is highlighted and the 
desired value is already known, simply type the first letter. For example, F could be 
entered to select Father. However Facility of Birth appears first. Choosing F again 
advances to the next value beginning with the letter F.  

 

 

 
2. Use a keyboard combination to open the list: If the dropdown menu is highlighted, use 

the keyboard combination Alt+Down-arrow to open the list. Alt+Up-arrow closes the list. 
 
3. Navigate the list without expanding the dropdown: When the dropdown menu is 

highlighted, use the keyboard’s up and down directional arrow keys to scroll through the 
list. 

 

3.2.2 Standard Date Format 

DAVETM uses a standard date format but is flexible enough to recognize and convert other 
formats users may enter. Formats accepted for conversion are illustrated below: 
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Input Formats Typed As: System Converts to: 

MM-DD-YYYY 

  

MM/DD/YYYY 

  

MMDDYYYY 

  

MonDDYYYY 

  

Mon/DD/YYYY 

  

Mon-DD-YYYY 

  

 

 

 

 

 

 

 

 

 

 

 Selecting F12 will automatically key today’s date into the selected date field 
 

 Entry of dates in any other date format will result in an error. 
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3.2.3 Icons and Controls 

Standard and custom user interface controls are built into the DAVE™ application to assist 
users in entering data accurately and efficiently.   

 Auto-populate Button: Automatically populates information in one field based on data 
entered in another. For example, based on data entered in the Date of Birth field, selecting the 
Auto-populate button calculates the age and populates the Age field. 

 

Calendar Icon: Launches the interactive Calendar and is placed next to date entry fields. 

The Interactive Calendar is an alternative to manually entering the date.  

1. Launch the calendar by selecting the Calendar Icon next to the date entry field: 

 

2. Select a Month and Year from the dropdown menus. 

 
3. Select the specific day. Once the day is chosen, the calendar will close and enter the 

date into the date field. 
 

 
 
 
 
 

 Selecting the calendar’s Today link enters the current date in the date field.  Pressing 
the F12 button on your keyboard does this as well. 
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 Checkboxes: Checkboxes allow users to make one or more selections from a variety 

available options. To select or de-select a checkbox, simply click inside the box  . 

 

 

 

 

 Buttons initiate various functions within the 
application.  They are used to navigate the application, accept data input, write information to 
the database, and trigger the processing of underlying system code. 

  Fix Icon: Appears in the DAVE™ Validation frame only. Selecting this icon will place 
the focus or cursor in the item containing invalid information. 

Label Control: Identifies a nearby text box or other control. 

Indicates what type of information is expected in that control.  

 LOV Icon: A DAVE™ specific search element that returns a grid of selectable data.  

 LOV Icon: A search tool used in the DAVETM application.  

 LOV Eraser Icon:  Removes values selected using the LOV search tool.  

Place Search Icon: Launches a popup that facilitates the entry of city, state, county and/or 
country.  

 Radio Buttons: Allows the user to choose only one of a predefined set of options   

 Required Controls: All controls accompanied by small red arrows are mandatory and must 
be completed or attempts to save the page will cause a pop up error message to appear.  The 
data must be completed before the user can continue. 

  Show Tooltips Checkbox: The Show Tooltips checkbox under the Help 
menu controls whether ‘hint’ text is displayed when hovering over an icon or control.  

 
Text Box Control: Allows user to enter information that will be used by the 
program. Can be formatted to accept only text, a combination of text and 
numbers, numbers only, or dates.   

 If a Checkbox or Radio Button has focus:  

 Use the Spacebar to “press” and select the button, or 

 Use the Enter key to “press” and select the button 
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 Table Paging: When a table of data contains more rows 
than can be displayed on a single page, DAVE™ provides a set of controls located at the 
bottom of the search results page that displays the page currently selected, the total number 
of pages of search results, and links to the other search result pages.   

 

The number of the selected page appears as bold text. The First and Last links allow users to 
easily jump to the beginning or ending of the search results. 

In addition to providing links to quickly access the First page, pages 1 – 10, and the Last page 
of the search results, the total amount of pages available for selection can be easily revealed 

by selecting the ellipsis link ( … ). 

     

If the number of records returned is greater than the system preference for the maximum 
records allowed, DAVE™ will display a warning message encouraging the user to refine search 
criteria. The message below was displayed on the search results page when a user attempted 
to search for all death records within a 2 year time span. 

Not all pages will require table paging.  In some cases it will be more useful to show a very 
large result set and use scroll bars to see the records that extend below the browser window. 

3.2.4 Zip Code Auto-Populate Address 

Zip code based auto-population controls are built into the DAVE™ application to assist users 
in entering address data accurately and efficiently.   
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The Zip Code field appears as the first entry amongst the address location fields of: City or 
Town, County, State and Country.  
 
Upon entry of the Zip Code, the City or Town, County, State and Country fields will auto-
populate. 
 

 

If the Zip Code entered has multiple City or Town or County associated options, the system 
will display a list of valid values to choose from. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 The Zip Code auto complete feature is optional and can be turned off in DAVE through 
System Preferences. 
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4. Death Registration Basics 

4.1 Initiating Death Records 

The creation and registration of a death record typically involves at least three participants: 

 

 
  

Funeral Director 
Certifying Medical Professional: 
Attending Physician or 
Coroner/Medical Examiner 

State or County Registrar’s Office 
 

 

The number of particpants may change: 

 When a case is referred to a Medical Examiner 

 When a case is transferred from one Funeral Home to another 

 When the state allows a separate individual to “pronounce death” 

 When a local registrar is involved 
 

4.2 Death Record Ownership 

DAVE™ separates the ownership of the death record into two sections:  

Personal Information Owner: Ultimately responsible for obtaining the personal information, 
filing the death certificate, and disposition of the decedent. 

Medical Information Owner: The office or medical facility completing the medical information. 

Below are some illustrations of how initiation and ownership of the death record may change 
in DAVE™: 

1 

 

A Funeral Director 
initiates the case and 
becomes owner of the 
Personal Information 
 

 

A Medical Facility finds the 
case in DAVETM and takes 
ownership of the Medical 
Information  
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2 

 

A Medical Facility 
initiates the case and 
becomes owner of the 
Medical Information 
  

A Funeral Director finds the 
case in DAVETM and takes 
ownership of the Personal 
Information 
 

3 

 

The case is initiated neither by a Funeral Home nor a Medical Facility.  
The County or State Registrar’s Office enters both Personal and Medical 
Information from a paper document. 
 
 

4 

 

Occasionally, there may not be a Funeral Home involved in a case, such 
as in the case of an indigent death.  When there is no Funeral Home 
involved, a Medical Facility or the Medical Examiner’s office becomes the 
owner of both the Personal Information and Medical information and are 
responsible for submitting the entire record.   

 

 

4.3 Death Registration Menu 

The Death Registration Menu provides links to a series of pages that are used in the 
submission and registration of death records.  Menus in DAVE™ are built dynamically based 
on user security profiles.  This means that a state office worker will be presented with a different 
set of pages and menu options than a funeral home user. These options can also change over 
the processing life of the death record.  

 

 

 

 

 

 

 

 

 

 

 The death registration functions in DAVE™ are restricted based on case ownership. 
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The pages that comprise the Death Registration Menu are grouped into sub-menus.  

 
Personal Information – Pages for gathering personal 
information about the decedent, such as family information and 
relevant details of the decedent’s life before death occurred, as 
well as disposition details and any funeral home information. 

 
 
 
Medical Certification – Pages for entering information 
surrounding the death of the decedent and specific medical 
details. 
 

 
 
Registrar – Pages for entering local or state registrar related 
information. 
 

Other Links – Pages appearing under this sub-menu allow 
the user to enter additional information related to the death 
registration, such as comments and correspondence, ordering 
certified copies, etc.  
 
 
 
 
 

 

 

 

 

 

 
 

 

 

 

 

 All sub-menus may not be available to all users.   
 
Even if a sub-menu is presented, different pages and items 
available to view or enter within the page may be displayed 
within each sub-menu, depending on individual user 
security.  
 
For example, in most cases, a medical certifier will see the 
Personal Information sub-menu, yet only the Decedent 
Page will be listed under this sub-menu. As well, the 
medical certifier will have limited ability to enter or edit items 
within the Decedent page itself. 
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4.4 Start a New Death Case 

The first step in creating a new death record is to search for any existing records on order to 
prevent the creation of duplicate cases.  

1. From the Main Menu select Life Events > Death > Start/Edit New Case 

 

 

 

 

 

2. To start a new case, all required fields, (denoted by red arrows ), must be completed.  

 

 

 

 

 

 

 

 

 

 

 

 

 

When selected the Lookup icon   provides a Place Search popup.  

The Place Search popup provides the user the ability search the list and select a place.  

Three search options are available:  

 Enter the full County Name and select 
Search.  

 Enter a partial County name followed by 
the wildcard symbol and select search. 
Example entering gr% will return all 
places that start with the letters “br”.  

 Browse the list for the correct location 
and click Select. 
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3. Once all required search criteria has been entered, select the Search button.  DAVE™ will 
use the criteria entered to search for existing records.  

4. If no matching records are returned, the Results screen will display a message indicating 
so.  

5. Select Start New Case to create the new record  

 

 

 

 

 

 

 

  If any matching records are found, they will be displayed on the Results screen: 
 

 

 

 

 

Select Preview to view a summary of the case and make sure it is not a duplicate. 

A summary of the selected case will be displayed in a  Preview pane:   

 

 

 

 

 

 

 

 

 

 If it is determined the case is a duplicate, choose the Select link to be taken to the 
existing Death Registration for the record to view and/or edit the case. 

 

 If it is determined the case is not a duplicate, select the Start a New Case button. 
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4.5 Death Personal Information Pages 

4.5.1 Decedent 

The first page of Items to Enter under the Personal Information submenu is the Decedent 
page. 

 
Medical Instituition or Tribal Law Enforcement Authority will be entirely responsible for 
registration of record:  Select ‘Yes’ if the medical institution or tribal authority submitting the 
record will complete all portions of the registrtaion and a Funeral Home will not be involved. 
 
Decedent’s Legal Name: Enter the First, Middle, and Last name of the decedent. Suffix is 
used to record generational suffixes such as Jr., III, etc. 

Aliases: If the decedent was known by more than one name, select 
Add/Edit Alias Names. 

 

 

 

 

The Aliases popup will display.  To add a new name, select the New 
Alias button.  

 
 



State of Arizona DAVETM User Guide  

 

  40 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

Complete the name fields and select Save.   

 

 

 

 

 

The Save and Cancel links are now replaced by Edit and Delete links; which can 
be uses to edit or delete the entered alias name.  

Selecting New Alias, at this point, allows you to enter another alias name 
for the decedent, if they have multple alias names.  

 

Selecting the Close button will return to and refresh the Decedent page displaying the newly 
entered alias name(s).  

 
 
 

 
 

 

 

 

 

 

 

 The Decedent page will not display more than two alias names at a time. A More link is 
displayed which, when selected, displays the full list of alias names. 
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Sex: The Sex dropdown is populated with the selection made when the 
case was created. If the selection was made in error, choose the 
correct value from the dropdown. 

Social Security Number: Enter the decedent’s social 
security number in in the Social Security Number field.  
If decedent has no SSN, select None.  If the 
decedent’s SSN is not known, select Unknown. 

Date of Birth and Age: Enter the Date of Birth manually or select the Calendar  icon to 
launch the Interactive Calendar. 

Enter the decedent’s age at time of death manually, or use the Auto-populate icon  to 
calculate the age entered in the Date of Birth field.  If the decedent was Under 1 Year old at 
the time of death leave the Age field empty and fill in the Months and Days.  If decedent was 
Under 1 Day old at the time of death, then fill in the Hours and Minutes fields. 

 

 

 

Verify SSN: Upon completion of the Decedent Name, SSN and Date of Birth, the Verify SSN 
link enables. When selected, the DAVE™ application establishes a connection with the Social 
Security Administration and verifies the SSN against information in their database.   

 

 

 

 

When the Verify SSN link is activated, the Decedent page will refresh and SSN Verification 
Status will change from UNVERIFIED (0) to PENDING (0) message displayed.  This indicates 
communication has been initiated with SSA.  Once the SSN verification results are known, the 
appropriate message will display. 

Decedent’s Birth Place: Enter the decedent’s place of birth. If needed, the Places Lookup  
icon can be used to allow selection of the correct City, County, State and Country from a list. 
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The system also includes a predictive text feature that attempts to determine the place being 
entered while typing. Possible matches for City, County, State or Country will be displayed. 

 

Armed Forces: Select the appropriate answer 
regarding US military service.  

Once the Decedent page is complete, select a navigation button at the bottom of the page: 

 

Selection of the Next button will save the data entered and proceed to the next page. 

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries, the Save button to save changes without leaving the page, or 
the Return button to return to the Start/Edit New Case page. 

 

 

4.5.2 Resident Address 

The Resident Address page Items to Enter record the decedent’s last known address. 

Street Address: The components of the Street Address are the Street Number, Pre-
Directional, Street Name, Street Designator, Post-Directional and Apartment/Suite.  The Street 
Designator and the Pre- and Post-Directionals can be selected from a drop-down list.  
 

 

 More information on record validation can be found in section 6 - Validation of Records 
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City, County, State, Country, Zip: If needed, the Places Lookup  icon can be used to allow 
selection of the correct City, County, State and Country from a list. 

The system also includes a predictive text feature that attempts to determine the place being 
entered while typing. Possible matches for City, County, State or Country will be displayed. 

 

Inside City Limits: Make a selection from the Inside City Limits? dropdown list to indicate 
whether or not the Decedent’s last known address was within city limits. A selection of 
‘Unknown’ is avaliable in the list. 

How Long In State: This item consists of two fields, in the first field the number corresponding 
to how long the decedent resided in Arizona should be entered. From the second field 
dropdown list a selection should be made to define the value entered in the first field as either 
hours, days, months, years, etc. 

Resided in Arizona Tribal Community at Time of Death: Select either Yes, No, or Unknown. 

If Yes, Select Tribe: If ‘Yes’ was selected from the Resided in Arizona Tribal Community at 
Time of Death, then the tribe of residence should be selected from this dropdown. 

Once the Resident Address page is complete, select a navigation button at the bottom of the 
page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous  

 

 

 

 

 

 

 

 More information on record validation can be found in section 6 - Validation of Records 
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4.5.3 Family Members 

The Family Members page Items to Enter collect the first, middle and last names of the 
decedent’s parents and spouse name information, if applicable. First and Last name fields are 
required. Middle can either be middle name or middle initial.  

Marital Status: Make a selection from the Marital Status dropdown. If 
unknown, select Unknown. 

 

 

Surviving Spouse’s Name: This field is completed if the decdent has a surviving spouse.  If 
the decedent is male, the maiden name of the surviving spouse should be entered in the Last 
Name field. 

Father’s Name: The decedent’s father’s name should be entered here. 

Mother’s Maiden Name Prior to First Marriage: The decedent’s mother’s maiden name, 
(name prior to first marriage), is collected here. 

Last Name of Surving Spouse: This field is completed if the decdent has a surviving spouse.  
If the decedent is female, the current last name of the surviving spouse should be entered.  If 
the decedent is male, then the spouse’s last name prior to first marriage should be entered. 

Once the Family Members page is complete, select a navigation button at the bottom of the 
page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   
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4.5.4 Informant 

The Informant page Items to Enter are designed to gather information about the person 
reporting the death. This may be a spouse, family member, or someone who is not related to 
the decedent.  

Informant Name: Enter Informant’s First, Middle, Last name and Suffix. First and Last name 
are required fields. Middle can either be middle name or middle initial.  

 
Relationship to Decedent: Select the Informant’s relationship to the 
decedent. If not listed, choose Other (Specify) and enter the 
relationship in the Other specify field. 
 
 
 
Address: Enter the Informant’s Address. If needed, the Places Lookup 

 icon can be used to allow selection of the correct City, County, 
State and Country from a list. 
 

The system also includes a predictive text feature that attempts to determine the place being 
entered while typing. Possible matches for City, County, State or Country will be displayed. 

 

 More information on record validation can be found in section 6 - Validation of Records 
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Once the Family Members page is complete, select a navigation button at the bottom of the 
page: 

 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

4.5.5 Disposition 

The Disposition page Items to Enter records the disposition details including the Method, 
Date, First and Secondary Place and Facility responsible.  

 

 More information on record validation can be found in section 6 - Validation of Records 
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Method of Disposition: Make a selection from the Method of 
Disposition dropdown list. If the method does not appear in the 
list then Other can be selected and a method of disposition 
can be specified in the Other Specify text entry box. 

 

 

 

 

 

 

  
 If the Method of disposition indicates that there are two places of disposition, such as 

Donation/Burial, Donation/Cremation, or Donation/Entombment, then the additional fields 
needed to collect the Place and Address for the secondary disposition will be displayed. 
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Date of Disposition: Enter the Date of Disposition manually or select the Calendar  icon to 
launch the Interactive Calendar. 

Place of Disposition: The Place of Disposition can be entered manually or the LOV Lookup 

 icon can be used to launch the Lookup Place of Disposition search tool. 

 

 

1. In the Faclity Name field, enter the full name of the facility, if known, and choose Search.  

If the full name of the facility is not known, enter at least two letters followed by the percent 
sign (%), then select search to perform a wildcard search. 

2. A list of available facilities will be returned. Select the Select link next to the correct facility 
in the list.  

 

 

 

 

 

 

The selection system-fills all of the corresponding fields for Place of Disposition on the 
Disposition page.  
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To clear the entry made for Place of Disposition, select the eraser icon . 

 

 

 

 

 

 

 

Funeral Director/Funeral Home:  For state users keying death information there are three 
ways to complete the Funeral Director/Funeral Home information.   

1. Manual entry of each item; 

2. The Funeral Director License Number and auto-populate  icon; or 

3. The standard LOV Lookup controls  
 

Steps for using Funeral Director License Number to complete  

1. Enter a Funeral Director’s License Number  

2. Select the auto-populate icon 

 

 The Place of Disposition Lookup filters results based on the selection made in the Method of 
Disposition dropdown.  For example, if method selected is Burial, the lookup will include a list 
of cemeteries; if Cremation, a list of crematories, etc.   
 

 If a funeral director is entering the record the Funeral Director Name and Funeral Home 
will be system filled at the start of the record. These fields will display the name of the funeral 
director user who started the record and the funeral home the user is logged in at. If necessary, 
the Funeral Director name can be changed, but only to another funeral director within the same 
funeral facility. 
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The system will then auto-populate the Funeral Director name and the associated Funeral 
Home information. 

 

Steps for using the Standard LOV Lookup to complete 

1. Select the LOV lookup tool  to search for a funeral director. 

2. Enter in the Last and First Name of the funeral director; if known.  If not known a wildcard 
search can be performed by entering at least two characters in the Last name field followed 
by the percent sign (%). 

 

 

 

 

 

 

 

3. From the Search Results List, select the Select link next to the correct Funeral Director. 
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The system will then auto-populate the Funeral Director name and the associated Funeral 
Home information. 

\\ 

 

 

 

 

 

 

Once the Disposition page is complete, select a navigation button at the bottom of the page: 

 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

 

 

 

 

Auto-population of the Funeral Home data will occur only if the Funeral Director 
selected is associated with a single funeral home. If the Funeral Director is associated 
with multiple funeral homes, the correct funeral home data must be manually entered 
or searched for and selected. 
 
To search for a funeral home 

1. Select the Funeral Home LOV lookup tool   
2. In the Facility Name field enter the full name of the facility or use a wildcard search 
by entering the first two letters followed by a % and selecting search 
3. Select the correct funeral facility from the search results list and the system will 
auto-populate it on the page. 

 

 More information on record validation can be found in section 6 - Validation of Records 
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4.5.6 Decedent Attributes 

The Decedent Attributes page Items to Enter collect information pertaining to the decedent’s 
occupation, education, ancestry and race.  This information is vital to other state and federal 
agencies and can impact funding for various programs.  Therefore, it is crucial the information 
collected be as accurate as possible. 

Format Change: The 2003 US Standard Certificate Revision included format changes for the 
collection of race, ancestry and education data. The DAVE™ application provides the prior 
version of the Decedent Attributes page for those deaths occurring before January 1, 2010 
when Arizona adopted the revision. 

Prior Decedent Attributes page: 

 

Current Decedent Attributes page: 

Decedent’s Occupation and Industry: In the first two fields, enter the Decedent’s 
Occupation and Decedent’s Industry.  
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Decedent’s Education: Select decedent’s education level from the dropdown list. If not 
known, select Unknown. 

 

 

 

 

 

Hispanic Origin: Select a value which indicates the decedent’s Hispanic Origin. More than 
one value can be selected. 

 

If Other is selected, a text field will display below Other in which the selection can be specified. 

Decedent’s Race: Select a value which indicates the decedent’s Race. More than one value 
can be selected. 

 

 Occupational data can be important in calculating workplace mortality statistics and 
should be as specific as possible. 
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If American Indian or Alaska Native is chosen, two dropdowns listing possible tribe affiliation(s) 
will be displayed. Select the decedent’s specific tribe(s) using one or both of the dropdown 
boxes. 

If Other(Specify), Other Asian or Other Pacific Islander are selected, two text fields will be 
displayed in which the selection can be specified. 

 

 

Once the Decedent Attributes page is complete, the Personal Information section of the death 
record is also complete. Select a navigation button at the bottom of the page: 

 
 

Selection of the Next button will proceed to the next page and save the data entered. In this 
case the next page is also the first page in the Medical Information section, Pronouncement.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

 

4.5.7 Sign a Death Record 

At this point in the process the Personal Information has been completed and a Funeral 
Director or Medical user responsible for entering this information will need to Affirm and Sign 
the record. 

 

 

 

 If the case is not registered and the date of death is changed from a date that is after 
the adoption of the US standard 2003 certificate to a date prior, the values entered for 
those fields unique to the 2003 standard will be set to null and the 1989 US standard 
pages will be displayed.  
 
If the date of death is changed from a date that is prior to the adoption of the US standard 
2003 certificate to a date after, the values entered for those fields unique to the 1989 
standard will be set to null and the 2003 US standard pages will be displayed. 
 

 More information on record validation can be found in section 6 - Validation of Records 
 

 If the record is being entered at the State or a County Vital Records, affirmation and 
signature are not required and the steps for this process can be skipped.   
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The user affirming and signing the record should select the Validate Page button or Validate 
Registration link to check the record for errors and/or omissions.  

 

 

 

 

 

 

 

 

 

Once the record has passed all validation rules, a Sign link will appear at the bottom of the 
Personal Information submenu. 

 

 

 

 

 
 
 

Steps to Affirm and Sign the Personal Information 

1. Select the Sign link 

2. Place a checkmark next to all affirmations and select the Affirm button. 

 

 More information on record validation can be found in section 6 - Validation of Records 
 



State of Arizona DAVETM User Guide  

 

  56 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

3. An Authentication successful message will be displayed and a checkmark placed next to 
the Sign link indicating the Personal Information has been affirmed.  

Once the record is signed, the pages within the Personal Information sub-menu are locked and 
cannot be edited.  

If the record is not yet registered and updates need to be made to any of the items in the 
Personal Information section, the record can be unaffirmed/unsigned. Doing so unlocks the 
pages within the Personal Information sub-menu so they can once again be edited. 

Steps to Unaffirm and Unsign the Personal Information 

1. To unsign the registration, select the Sign link.   

 

2. Select Unsign.  

3. Select OK to confirm the reversal. 

Once unsigned, the pages are again available for editing. 
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4.6 Death Medical Information Pages 

4.6.1 Pronouncement 

The first page of Items to Enter under the Medical Information submenu is Pronouncement, 
which captures the date and time of death. 

 
Date of Death: The Date of Death field is auto-populated based on the date entered on the 
Start/Edit New Case page when the record is created.  
 
If the original date entered is incorrect it can be updated by either entering the Date of Death 

manually or select the Calendar  icon to launch the Interactive Calendar.  This is a 

required field as indicated by the red arrow  and must be completed for all death 
registrations. If the date of death is unknown enter: 99-99-9999. 
 

 

The Date of Death is a required field as indicated by the red arrow    and must be 
completed for all death registrations.  
 

 

Date of Death Modifier: The Date of Death Modifier adds descriptive information relating to 
the Date of Death. There are two options to select from: 

Modifier Description 

Actual Date of Death  The date entered is the actual date of death  

Found Date of Death It is known when the deceased’s body was found, but a 
date of death cannot be determined 

 
Time of Death: Enter the hour and minute of death and make a selection from the 
AM/PM/Military dropdown. 
 

 Date of Death cannot be unknown. 
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Time of Death Modifier: The Time of Death Modifier adds descriptive information relating to 
the Time of Death. There are three options to select from: 

Modifier Description 

Actual Time of Death  The time entered is the actual time of death  

Unknown Time of Death Time of death is unknown 

Found Time of Death It is known when the deceased’s body was found, but 
a time of death cannot be determined 

 

 

 

 

 

Once the Pronouncement page is complete, select a navigation button at the bottom of the 
page: 

 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

 

 If the Date of Death year was keyed incorrectly and the record has been registered, 
the date cannot be corrected or amended. The user must void the existing record and re-
enter a new case with the correct year of death. 
 
It is not necessary to void a registered case to correct or amend only the month and day 
of death. 
 

 For unknown Time of Death enter 99:99 the Time of Death Modifier will automatically fill in 
with ‘Unknown.’ 
 

 More information on record validation can be found in section 6 - Validation of Records 
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4.6.2 Place of Death 

The Place of Death Items to Enter capture data regarding where the death occurred.  This 
could be a hospital, home address or some other location. 

 
 

Type of Place of Death: From the Type of Place of Death 
dropdown, select the type that best matches the location 
where death occurred.  

If Other (specify) is chosen, enter the information on type of 
place of death into the Other Specify text box. 

 

Facility Name:  

If Decedent’s Residence is selected from the Type of place of death dropdown, the 
Address fields for Place of Death will be auto-populated with the information entered on the 
Resident Address page. If no information has been entered on the Resident Address page, the 
residence address can be manually entered. The Facility Name field is not required and will be 
disabled. 

If Other (specify) is selected from the Type of place of death dropdown, the facility name. 
(if known or applicable), and address fields should be manually entered. The facility name field 
can be left blank. 

For all other Type of Place of Death dropdown selections,the Place of Death can be 

entered manually or the LOV Lookup  icon can be used to launch the Lookup Place of Death 
search tool. 

Steps to Use the Place of Death Lookup 

1. In the Faclity Name field, if known, enter the full name of the facility and choose Search.  
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If the full name of the facility 
is not known, enter at least 
two letters followed by 
the %, then select search 
to perform a wildcard 
search.  

 

 

 

2. A list of available facilities will be returned. Select the Select link next to the correct facility 
in the list.  

 

 

 
The selection system-fills all of the corresponding fields for Place of Death on the Place of 
Death page.  

To erase the entry made for Place of Death choose the eraser icon . 

 

 

 

 

 

 
 

Medical Record Number: If known, the decedent’s 
Medical Record Number can be entered.  

 

 The Place of Death Lookup filters results based on the selection made in the Type of 
Place of Death dropdown. For example, if method selected is Inpatient, Emergency or 
Dead on Arrival, the lookup will filter the search to include hospitals; if Hospice, a list of 
hospices, etc.   
 

 If the Type of Place of Death selected matches the facility type assigned to the user 
completing the Medical Certification pages, then the Place of Death will be system-filled  
with the facility name and address the user is logged in under.   

 The Medical Record Number can be referenced later to Search for or Locate the case.   

 Facilities not listed in the LOV lookup tool can be entered by typing the Facility Name 
and address information manually.  All out-of-state records will contain non-listed facilities. 
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Once the Place of Death page is complete, select a navigation button at the bottom of the 
page: 

 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

 

4.6.3 Cause of Death 

The Cause of Death page Items to Enter capture the data regarding the primary and 
underlying conditions which lead to the decedent’s death.  

 

 

 

 More information on record validation can be found in section 6 - Validation of Records 
 

 Attention to detail and specificity is essential when completing this page. 
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The Cause of Death page consists of two parts: 

Part 1 is for reporting the chain of events leading directly to death. The Immediate Cause,  (the 
final disease, injury, or complication directly causing death), is listed on line a. The underlying 
cause(s), (chain of events that led to the immediate cause), is listed in lines b through d. 

Approximate Interval Onset to Death: To the right of each of the lines 
Part 1 there is a corresponding Approximate Interval Onset to Death 
field. For each cause listed in Lines a-d an Approximate Interval Onset 
to Death must also be completed. While every line on the Cause of 
Death form will not necessarily be used for all deaths, lines that are used 
must be filled in sequentially. 

 

 

 

 

 

Part 2 is for reporting all other significant diseases, conditions, or injuries that contributed to 
death. 

 

Spell check: Spell check functionality is available for Cause of Death lines a-d and the Other 
significant conditions field.   
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1. After making an entry, select the Spell Check icon located below the line. 

 

 

 

2. DAVE™ will check all phrases entered and highlight any misspelled entries. 

 

 

 

3. Select the highlighted word. A list of possible corrections is displayed.  Select an option 
from the list to replace the misspelled word. 

 

 

 

 
 

4. Upon correction of all misspelled entries in a line, the Spell Check icon will be replaced with 
a Corrected icon. 

 

 

 

5. Alternately, all lines can be spelled checked simultaneously by selecting the Check Spelling 
button located at the bottom of the Cause of Death page. 
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DAVE™ will check all phrases entered on all lines and highlight any misspelled entries. You 
can then select the phrases and use the same control as in step 3 above to view and select 
suggested properly spelled words. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once the Cause of Death page is complete, select a navigation button at the bottom of the 
page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous page. 

  
 

 

 

 

 

 

 More information on record validation can be found in section 6 - Validation of Records 
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4.6.4 Other Factors 

The Other Factors page Items to Enter capture additional information relevant to death. 

Autopsy Performed: Select either Yes or No from the Autopsy Performed dropdown list to 
indicate whether or not an autopsy was performed.  

Autopsy findings available to complete cause of death: Select either Yes or No from the 
Autopsy finding available to complete the cause of death dropdown list to indicate whether or 
not the autopsy findings were used to complete the cause of death.  

 

 

If decedent was female, was decedent pregnant within the last year? Make a selection 
from the dropdown to indicate whether or not the decedent was pregnant at time of death.  

 

 

 

 

 

 

Did tobacco use contribute to death? Make a selection of Yes, No, Probably, or Unknown 
from the dropdown to indicate if smoking contributed to death. 

Manner of Death: Make a selection from the dropdown list to 
indicate the manner in which death occurred. Natural should be 
selected unless the cause of death entered indicated some form of 
trauma or injury. 

 

 

 If the selection for Autopsy Performed is No, then the Autopsy Findings field is not required 
and will be disabled. 
 

 The Was decedent pregnant question is not required and will be disabled if the decedent is 
male or if the decedent is a female less than 10 or greater than 64 years old. 
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Was Medical Examiner contacted? Select either Yes or No from the Was Medical Examiner 
Contacted dropdown list to provide information on whether or not a medical examiner was 
contacted. 

ME Case Number: If Yes is selected for the Was Medical Examiner contacted question, the 
ME Case Number field will become enabled. If known the ME Case Number should be entered 
into this field. 

Once the Other Factors page is complete, select a navigation button at the bottom of the page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

 

 

 

 

 

 

 

 

 

 

 

 The options available in the Manner of Death dropdown are displayed based on user 
security privileges. For example a Medical Certifier may only be granted the ability to select 
Natural or Accident from the list; whereas a Medical Examiner would see the full list of options. 

 More information on record validation can be found in section 6 - Validation of Records 
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4.6.5 Injury 

The Injury page Items to Enter capture information for cases where the manner of death is 
not natural.  These items help clarify the date, time, activity and location where the injury events 
that lead to death. 

ME Case Number: If an ME Case Number was entered on the Other Factors page, it will 
display here. If no ME Case Number has been entered, this area will remain blank. 

Date of Injury: This is the date injury occurred that led to the decedent’s death, but not 
necessarily the actual date of death (i.e., decedent was in an accident and lived several days 

after). Enter the Date of Injury manually or select the calendar icon  to launch the 
interactive calendar. 

Date of Injury Modifier: After entering the Date of Injury, choose a Date of Injury Modifier. 
The Date of Injury Modifier adds descriptive information relating to the Date of Injury. 
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Time of Injury: Enter the hour and minute of death and make a selection from the 
AM/PM/Military dropdown. 

 
 
 

Injury at Work: If injury occurred on the job, select Yes from the Injury at Work dropdown.  
Otherwise, select No or Unknown.  

Place of Injury: Select the option that best describes 
the place where the injury occurred. 

If Other Specify is selected, an entry must be keyed 
in the corresponding Other (Specify) text entry 
control. 

 

 

 
 

 

 

Injury Location: Provide the address where the injury occurred. 

 
 
 
 
 
 
 
 
 

 For unknown Time of Injury enter 99:99 the Time of Injury Modifier will automatically fill in 
with ‘Unknown.’ 
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Describe how injury occurred: Enter a description of the circumstances surrounding the 
injury here. 

 

If Transportation injury Specify: If the injury resulted from a 
transportation mishap, make a selection from the If Transportation 
injury Specify dropdown.  

If Other Specify is selected, fill out the corresponding Other Specify 
field as well.  If fatal injury is not transportation related, leave both of 
these fields blank. 

 

Once the Other Factors page is complete, select a navigation button at the bottom of the page: 

 

Selection of the Next button will save the data entered 
and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

  

 More information on record validation can be found in section 6 - Validation of Records 
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4.6.6 Certifier 

The Certifier page is used to record the type, license number, name, title, and address of the 
person legally responsible for certifying the decedent’s cause of death.   

 
Pre-authorize Cremation Clearance: This checkbox is only available to Medical Examiner’s 
whom have intiated entry of the fetal death record. Selection of this checkbox allows the 
Medical Exminer to pre-authorize cremation clearance if the method of disposition is selected 
as cremation. 

 
Certifier Type: The Certifier Type dropdown provides a lists of 
the different types of medical professionals who approve and 
certify the medical information provided in regards to the 
decedent’s death.  

 

 
 
Certifier Name/Certifier Address: There are three ways to complete the Certifier information.   

1. Manual entry of each item; 

2. The Certifier License Number lookup and auto-populate  icon; or 

3. Standard LOV Lookup controls  

 

  



State of Arizona DAVETM User Guide  

 

  71 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

Steps for using Certifier License Number to complete  

1. Enter a Certifier’s License Number  

2.  

 

 

 

 

3. Select the auto-populat icon 

The system will then auto-populate the Certifier name and the associated Certifier Address 
information. 

Steps for using the Standard LOV Lookup to complete 

1. Select the LOV lookup tool  to search for a certifier. 

2. Enter the Last and First Name of the certifier; if known.  If not known, a wildcard search 
can be performed by entering at least two characters in the Last name field followed by %. 

 

Auto-populate 
icon 
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From the Search Results List Select the link next to the correct Certifier. 

3. The system will then auto-populate the Certifier name and the associated Certifier Address 
information. 

 

 

 

 

 

Date Signed: Enter the Date Signed by the certifier 

manually, or select the calendar icon  to launch the 
interactive calendar. 

 

 

 

 If a medical certifier is entering the record the Certifier Name and Certifier Address will 
be system-filled when the case is created with the name of the certifier who started the record 
and the medical facility selected at log in. 
 
Once this auto-completion has occurred the Certifier Name and Certifier Address can be 
updated by selecting the Eraser icon to clear the current entries and then following the steps 
above to enter the new certifier information. 
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Once the Certifier page is complete, the Medical Information section of the death record is also 
complete. Select a navigation button at the bottom of the page: 

 
 

The Next button is not available here as this is the final medical information page to complete 
within the Death Registraton menu.  

Options for selection are the Validate Page button to check the page for errors, the Clear button 
to clear all entries, the Save button to save changes without leaving the page, or the Return 
button to return to the previous page.  

 

 

4.6.7 Certify a Death Record 

At this point in the process the Medical Information has been completed and a Medical Certifier 
responsible for entering this information will need to Affirm and Certify the record. 

 

 

The user affirming and signing the record should select the Validate Page button or Validate 
Registration link to check the record for errors and/or omissions.  

 

 

 

 

 

 

 

 

 

Once the record has passed all validation rules, a Certify link will appear at the bottom of the 
Medical Information submenu. 

 More information on record validation can be found in section 6 - Validation of Records 
 

 If the record is being entered at the State or a County Vital Records Office, affirmation and 
certification are not required and the steps for this process can be skipped.   
 

 More information on record validation can be found in section 6 - Validation of Records 
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Steps to Affirm and Certify the Medical Information 

1. Choose the Certify link 

2. Select the checkbox next to the listed affirmations and then select Affirm. 

 

3. An Authentication successful message will be displayed and a checkmark placed next to 
the Certify link indicating the Personal Information has been affirmed.  

Once the record is certified the pages within the Medical Information sub-menu are locked and 
cannot be edited.  

If the record is not yet registered and updates need to be made to any of the items in the 
Medical Information section, the record can be unaffirmed/uncertified. Doing so unlocks the 
pages within the Personal Information sub-menu so they can once again be edited. 

Steps to Unaffirm and Unsign the Medical Information 

1. To unsign the registration, select the Certify link.  
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2. Select Uncertify.  

3. Select OK to confirm the reversal. 

Once uncertified, the Medical Information pages are again available to edit. 

 

5. Fetal Death Registration Basics 

5.1 Initiating Fetal Death Records 

The creation and registration of a fetal death record typically involves just one particpant: 

 

Certifying 
Medical 
Records 
Professional 

 

Particpants may change: 

 When a Funeral Home is involved  

 When a Medical Examiner is involved 

 When the State or County Registrar is involved 

5.2 Fetal Death Record Ownership 

DAVE™ separates the ownership of the fetal death record into two sections:  

Personal/Disposition Information Owner: The office or medical facility responsible for 
disposition and completion of the personal information. 

Medical Information Owner: The office or medical facility responsible for completion of the 
medical information. 
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Below are some illustrations of how ownership and intiation of the death record may interact in 
DAVE™: 

1 

 

The case is started and completed by the Medical Facility where the 
event occurred. The Personal and Medical information ownership is the 
responsibility of the Medical Facility.     

2 

 

A Medical Facility 
initiates the case and 
becomes owner of the 
Personal and Medical 
Information 
 

 

The Medical Facility 
transfers ownership of the 
Personal information to a 
Funeral Director 

3 

 

The case is started and completed at the County or State Registrar’s 
Office who assumes ownership of and responsibility for transcribing both 
Personal and Medical Information from a paper document. 
 

4 

 

Occasionally, there may not be a Medical Facility involved in a case. In 
these instances the Medical Examiner’s office becomes the owner of 
both the Personal Information and Medical information and is responsible 
for completing the entire record.   

 

 

5.3 Fetal Death Registration Menu 

The Fetal Death Registration Menu provides links to the pages that are used in the submission 
and registration of death records.  Menus in DAVE™ are built dynamically based on user 
security profiles.  This means that a state office worker will be presented a different set of pages 
and menu options than a medical facility user. The pages available may vary over the 
processing life of a fetal death record.   

 

 

 

 

 

 The fetal death registration functions in DAVE™ are restricted based on case ownership. 
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The pages that comprise the Fetal Death Registration Menu are grouped into sub-menus.  

 

Personal Information – Pages for gathering personal 
information, such as information regarding the mother and 
relevant details of the mother’s health before the fetal death 
occurred. 

 
 
 
Medical Information – Pages for entering information regarding 
medical factors of the fetal death. 
 
 
 
 
 
 
 
Registrar – Pages for entering local or state registrar-targeted 
information. 
 
 
Other Links – Pages appearing under this sub-menu allow the 
user to enter additional information related to the fetal death 
registration, such as disposition, comments and 
correspondence, etc.  
 

 

 

 

 

 

 

 

 

 

 

 

 All sub-menus may not be available to all users.  Even if a sub-menu is presented, 
different pages and items available to view and/or enter within the pages may be displayed 
depending on security privileges granted to the user.  
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5.4  Start a New Fetal Death Case 

The first step in entering a new fetal death record is to search for any existing records to prevent 
the creation of duplicates.  

1. From the Main Menu select Life Events > Fetal Death > Start/Edit New Case 

 

 

 

 

 

2. To start a new case the the required fields, (denoted by red arrows ), must be completed.  

 

 

 

 

 

 

 

 

 

 

 

 

 When selected the Lookup icon  provides a Place Search popup.  

The Place Search popup provides the user the ability search the list 
and select a place.  

The three available search options are:  

 Enter the full County or City 
Name and select Search.  

 Enter a partial County or City 
name followed by the wildcard 
symbol and select search.  For 
example, entering “gr%” will 
return all places that start with 
the letters “gr”.  

 
Browse the list for the correct 
location and click Select. 
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3. Complete the required fields and select the Search button. DAVE™  will use the criteria 
entered to search for matching records.  

If no matching records are returned, the Results screen will display a message indicating so.  

4. Select Start New Case to create the new record  

 

 

 

 

 

 

 

  If a matching record is found, the Results screen will display that case in the results list.  
 

 

 

 

 

         Select Preview to view a summary of the case and ensure it is not a duplicate. 

          A Preview of the case, in summary form, will display below the Results page list.  

 

 

 

 

 

 

 

 

 

 If it is determined the case is a duplicate choose the Select link to be taken to the Death 
Registration page to work on or review items for that case. 

 

 If it is determined the case is not a duplicate, select the Start a New Case button. 
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5.5 Fetal Death Personal Information Pages 

5.5.1 Fetus 

The first page of Items to Enter under the Personal Information submenu is the Fetus page. 

 

The items entered on the Start Edit New Case page will be system filled on the Fetus page, 
such as Fetus First and Last Name, Date of Delivery, and Sex. If any of these items were 
entered incorrectly upon starting the fetal death record, they can be updated on this page. 
 
Will Funeral Director be responsible for final disposition: This question is available for 
completion to the medical facility completing the record. It is defaulted to ‘No’ and should only 
be updated to ‘Yes’ if a funeral director will be involved in completing the personal and 
disposition information for the fetal death record. 

Fetus Name: In many cases the parents will not choose to name the fetus. If the fetus is not 
named, select the Not Named checkbox. Otherwise, enter the fetus First, Middle, and Last 
name. Suffix is used to record generational suffixes such as Jr., III, etc. 

Date of Delivery: The Date of Delivery dropdown is populated with the information entered 
when the case was created. If the date entered was incorrect, enter the Date of Delivery 

manually or select the Calendar  icon to launch the Interactive Calendar. 

Time of Delivery: Enter the hour and minute of delivery and make a selection from the 
AM/PM/Military dropdown. 

Sex: The Sex dropdown is populated with the selection made when the case was created. If 
the sex entered was incorrect, choose the correct value from the dropdown. 

Once the Fetus page is complete, select a navigation button at the bottom of the page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the Start/Edit New Case page. 

 
 More information on record validation can be found in section 6 - Validation of Records 
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5.5.2 Mother 

The Mother page Items to Enter are designed to gather information about the mother 
including current legal name and name prior to first marriage. The First and Last name fields 
are required. Middle can either be middle name or middle initial. 

 

Mother’s Current Legal Name: Enter the First, Middle, and Last name of the mother. Suffix 
is used to record generational suffixes such as Jr., III, etc. 

Mother’s Name Prior to First Marriage:  If Mother’s Name Prior 
to First Marriage is the same as the Current Legal Name simply 
select the Copy Current Legal Name button. This will copy the 

First, Middle, Last Name and Suffix from Mother’s Current Legal Name into the 
corresponding Mother’s Name Prior to First Marriage fields. 

If the mother’s name differs between Mother’s Current Legal Name and Mother’s Name Prior 
to First Marriage, then enter the First, Middle, and Last name of the mother prior to first 
marriage. Suffix is used to record generational suffixes such as Jr., III, etc. 

Date of Birth and Age: Enter the Date of Birth manually or select the Calendar  icon to 
launch the Interactive Calendar. 

Enter the mother’s age manually, or use the Auto-populate icon  to calculate mother’s age 
based on the date entered in the Date of Birth field. 

Social Security Number: Enter the mother’s social 
security number in the Social Security Number field.  If 
mother has no SSN, select None.  If the mother’s SSN 
is not known, select Unknown. 

Mother’s Birth Place: Enter the mother’s place of birth. If needed, the Places Lookup  icon 
can be used to facilitate selection of the City, State, and Country from a list. 
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The system also includes a predictive text feature that attempts to determine the place being 
entered while typing. Possible matches for City, County, State or Country will be displayed. 
 

 

 

 

Once the Mother page is complete, select a navigation button at the bottom of the page: 

 

Selection of the Next button will save the data entered and proceed to the next page. 

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous  

 

 

5.5.3 Mother Address 

The Mother Address page Items to Enter record the mother’s residence address. 

Street Address: The components of the Street Address are the Street Number, Pre-
Directional, Street Name, Street Designator, Post-Directional and Apartment/Suite.  The Street 
Designator and the Pre- and Post-Directionals can be selected from a drop-down list.  

 

City, County, State, Country, Zip: If needed, the Places Lookup  icon can be used to allow 
selection of the correct City, County, State and Country from a list. 

 More information on record validation can be found in section 6 - Validation of Records 
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The system also includes a predictive text feature that attempts to determine the place being 
entered while typing. Possible matches for City, County, State or Country will be displayed. 

 

Inside City Limits: Make a selection from the Inside City Limits? dropdown list to indicate 
whether or not the mother’s residence address is within city limits. A selection of ‘Unknown’ is 
avaliable in the list. 

Resided in Arizona Tribal Community: Select the tribal community the mother resided in or 
select No, or Unknown. 

Once the Mother Address page is complete, select a navigation button at the bottom of the 
page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous  

 

 

5.5.4 Mother Attributes 

The Mother Attributes page Items to Enter collect information pertaining to the mother’s 
occupation, education, ancestry and race.   

Format Change: The 2003 US Standard Certificate Revision included format changes for the 
collection of race, ancestry and education data. The DAVE™ application provides the prior 
version of the Mother Attributes page for those fetal deaths occurring before January 1, 2013 
when Arizona adopted the revision. 

 More information on record validation can be found in section 6 - Validation of Records 
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Prior Mother Attributes page: 

Current Mother Attributes page: 

 

Mother’s Education: Select mother’s education level from the dropdown list. If not known, 
select Unknown. 
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Hispanic Origin: Select a value which indicates the mother’s Hispanic Origin. More than one 
value can be selected. 

 

If Other is selected, a text field will display below Other in which the selection can be specified. 

Mother’s Race: Select a value which indicates the Mother’s Race. More than one value can 
be selected. 

 

If American Indian or Alaska Native is chosen, two dropdowns listing possible tribe affiliation(s) 
will be displayed. Select the decedent’s specific tribe(s) using one or both of the dropdown 
boxes. 

If Other(Specify), Other Asian or Other Pacific Islander are selected, two text fields will be 
displayed in which the selection can be specified. 

Occupation: Enter Mother’s occupation. 

Kind of Business: Enter the business which the Mother was associated. 

 

 
 

 If the case is not registered and the date of delivery is changed from a date that is after 
the adoption of the US standard 2003 certificate to a date prior, the values entered for those 
fields unique to the 2003 standard will be set to null and the 1989 US standard pages will 
be displayed.  
 
If the date of death is changed from a date that is prior to the adoption of the US standard 
2003 certificate to a date after, the values entered for those fields unique to the 1989 
standard will be set to null and the 2003 US standard pages will be displayed. 
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Once the Mother Attributes page is complete, select a navigation button at the bottom of the 
page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous  

 

5.5.5 Marital Status 

The Marital Status page is used to gather Marital Information and enable the collection of 
Father information if applicable.   

 

Mother Ever Married: Make a selection of Yes, No , or Unknown from the dropdown. A 
selection of ‘No’ will disable the need to enter information in regards to the Was Mother Married 
at Delivery, conceptuon of anytime in between question. Mother Ever Married: Make a 
selection of Yes, No, or Unknown from the dropdown.  

A selection of ‘No’ will enable 
the Will Father information be 
collected on the Report 
question.  

 

 

A selection of ‘Yes’ will display two new pages,  used to collect father information: Father and 
Father Attributes, in the Fetal Death Registration menu. 

 More information on record validation can be found in section 6 - Validation of Records 
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Will Father information be collected on this report: If enabled, make a selection of Yes, No, 
or Unknown from the dropdown. A selection of Yes will enable two new pages in the Fetal 
Death Registration menu used to collect father information: Father and Father Attributes. 

 
Once the Marital Status page is complete, select a navigation button at the bottom of the page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous  
 

 

5.5.6 Father 

The Father page Items to Enter are designed to gather information about the father 
including father’s name. The First and Last name fields are required. Middle can either be 
middle name or middle initial. 
 

 

Father’s Name: Enter the First, Middle, and Last name of the mother. Suffix is used to 
record generational suffixes such as Jr., III, etc. 

Date of Birth and Age: Enter the Date of Birth manually or select the Calendar  icon to 
launch the Interactive Calendar. 

 More information on record validation can be found in section 6 - Validation of Records 
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Enter the father’s age manually, or use the Auto-populate icon  to calculate mother’s age 
based on the date entered in the Date of Birth field. 

Social Security Number: Enter the father’s social 
security number in the Social Security Number field.  If 
father has no SSN, select None.  If the father’s SSN is 
not known, select Unknown. 

Father’s Birth Place: Enter the father’s place of birth. If needed, the Places Lookup  icon 
can be used to facilitate selection of the City, State, and Country from a list. 

 

The system also includes a predictive text feature that attempts to determine the place being 
entered while typing. Possible matches for City, County, State or Country will be displayed. 
 

 

 

 

Once the Father page is complete, select a navigation button at the bottom of the page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous page. 
 
 
 

5.5.7 Father Attributes 

The Father Attributes page Items to Enter collect information pertaining to the mother’s 
occupation, education, ancestry and race.   

 More information on record validation can be found in section 6 - Validation of Records 
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Format Change: The 2003 US Standard Certificate Revision included format changes for the 
collection of race, ancestry and education data. The DAVE™ application provides the prior 
version of the Father Attributes page for those fetal deaths occurring before January 1, 2013 
when Arizona adopted the revision. 

Prior Father Attributes page: 

Current Father Attributes page: 
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Father’s Education: Select father’s education level from the dropdown list. If not known, select 
Unknown. 

 
 

 

 

 

 

Hispanic Origin: Select a value which indicates the father’s Hispanic Origin. More than one 
value can be selected. 

 

If Other is selected, a text field will display below Other in which the selection can be specified. 

Father’s Race: Select a value which indicates the Father’s Race. More than one value can be 
selected. 

 

If American Indian or Alaska Native is chosen, two dropdowns listing possible tribe affiliation(s) 
will be displayed. Select the decedent’s specific tribe(s) using one or both of the dropdown 
boxes. 
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If Other(Specify), Other Asian or Other Pacific Islander are selected, two text fields will be 
displayed in which the selection can be specified. 

 
Occupation: Enter Father’s occupation. 

Kind of Business: Enter the business which the Father was associated. 

 
Once the Father Attributes page is complete, select a navigation button at the bottom of the 
page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous  

 
 
 
 

5.5.8 Disposition 

The Disposition page Items to Enter collect information pertaining to the disposition including 
the Method, Date and Place of Disposition as well as the Funeral Home and Director 
responsible for disposition. 

 If the case is not registered and the date of delivery is changed from a date that is after 
the adoption of the US standard 2003 certificate to a date prior, the values entered for those 
fields unique to the 2003 standard will be set to null and the 1989 US standard pages will be 
displayed.  
 
If the date of death is changed from a date that is prior to the adoption of the US standard 
2003 certificate to a date after, the values entered for those fields unique to the 1989 
standard will be set to null and the 2003 US standard pages will be displayed. 
 

 More information on record validation can be found in section 6 - Validation of Records 
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Method of Disposition: Make a selection from the Method of 
Disposition dropdown list. If the method does not appear in the list 
then Other Final Disposition can be selected and a method of 
disposition can be specified in the Other Specify text entry box. 

 

 

 

 

Date of Disposition: Enter the Date of Disposition manually or select the Calendar  icon to 
launch the Interactive Calendar. 

Place of Disposition: The Place of Disposition can be entered manually or the LOV Lookup 

 icon can be used to launch the Lookup Place of Disposition search tool. 
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1. In the Faclity Name field, enter the full name of the facility, if known, and choose Search.  

If the full name of the facility is not known, enter at least two letters followed by the %, then 
select search to perform a wildcard search. 

2. A list of available 
facilities will be returned. 
Select the select link next 
to the correct facility in the 
list.  

The selection system-fills 
all of the corresponding 
fields for Place of 
Disposition on the 
Disposition page.  

 

      

 

 

 

 

 

 If the selected Method of disposition indicates that there are multiple places of 
disposition, then the additional fields needed to collect the secondary Place of Disposition 
may be completed at the bottom of the page. 
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Funeral Director/Funeral Home: There are three ways to complete the Funeral 
Director/Funeral Home information.   

1. Manual entry of each item; 

2. The Funeral Director License Number and auto-populate  icon; or 

3. Standard LOV Lookup controls  

 
Steps for using Funeral Director License Number to complete  

1. Enter a Funeral Director’s License Number  

2. Select the auto-populate button 

 

The system will then auto-populate the Funeral Director name.  Note that Funeral Home is 
system-filled with the facility selected at login. 

 

Steps for using the Standard LOV Lookup to complete 

1. Select the LOV lookup tool  to search for a funeral director. 

 If a funeral director is completing the disposition the Funeral Home will be system-filled 
with the name of the funeral home whom has ownership of the personal information. 
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2. Enter in the Last and First Name of the funeral director; if known.  If not known a 
wildcard search may be performed by entering at least two characters followed by a percent 
sign (%) in the Last name field.  

 

 

 

 

 

 

 

3. From the Search Results List select the Select link next to the correct Funeral Director. 

The system will then auto-populate the Funeral Director name.  Note that Funeral Home is 
system-filled with the facility selected at login. 

 

 

 

 

 

 

 
Is this a family disposition: Select Yes from the dropdown if the disposition is a family 
disposition. Select No if it is not. 

 Auto-population of the Funeral Home data will occur only if the Funeral Director 
selected is associated with a single funeral home. If the Funeral Director is associated with 
multiple funeral homes, the correct funeral home data must be manually entered or searched 
for and selected. 
 
To search for a funeral home,  

1. Select the Funeral Home LOV lookup tool   
2. In the Facility Name field enter the full name of the facility or use a wildcard search by 
entering the first two letters followed by a % and selecting search 
3. Select the correct funeral facility from the search results list and the system will auto-
populate it on the page. 
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Once the Disposition page is complete, select a navigation button at the bottom of the page: 

 
 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

5.5.9 Affirm the Fetal Death Record 

At this point in the process the Personal Information has been completed and the Funeral 
Director or Medical user responsible for this information will need to Affirm the record. 

 

 

 

 

 

 

The user affirming the record should select the Validate Page button or Validate Registration 
link to check the record for errors and/or omissions.  

 

 

 

 

 

 

 

 

 If the record is being entered at the State or a County Vital Records Office, affirmation is not 
required and the steps for this process can be skipped.   
 

 More information on record validation can be found in section 6 - Validation of Records 

 If both the Personal and Medical Information is being entered by a medical facility user, 
completing this individual affirmation step is not required. 
 
Once both Personal and Medical Information is complete an Affirm/Certify link will be made 
available allowing the medical facility user to Affirm the Personal Information at the same time 
as Certifying the Medical Information. 

 More information on record validation can be found in section 6 - Validation of Records 
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Once the record has passed all validation rules, an Affirm link will appear at the bottom of the 
Personal Information submenu. 

 

 

 

 

 

 

Steps to Affirm the Personal Information 

1. Select the Affirm link 

2. Place a checkmark next to all affirmations and select the Affirm button. 

 

3. An Authentication successful message will be displayed and a checkmark placed next to 
the Affirm link indicating the Personal Information has been affirmed.  

 

 

 

 
Once the record is signed the pages within the Personal Information sub-menu are locked and 
cannot be edited.  

If the record is not yet registered and updates need to be made to any of the items in the 
Personal Information section, the record can be unaffirmed. Doing so unlocks the pages within 
the Personal Information sub-menu so they can once again be edited. 

Steps to Unaffirm the Personal Information 

1. To unsign the registration, select the Affirm link.  
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2. Select Unaffirm.  

3. Select OK to confirm the reversal. 

Once unaffirmed, the Personal Information pages are again available for editing. 

 
 

5.6 Fetal Death Medical Information Pages 

5.6.1 Mother Health 

The Mother Health page is used to gather statistical data relative to the mother’s health and 
personal habits.  This data is used to analyze the effect of the mother’s health and behavioral 
habits on the fetus. 

Format Change: The 2003 US Standard Certificate Revision included format changes for 
the collection of mother’s health data. The DAVE™ application provides the prior version of 
the Mother Attributes page for those fetal deaths occurring before January 1, 2013 when 
Arizona adopted the revision.  

Prior Mother Health page: 
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Current Mother Health page:

 

Did Mother get WIC food for herself during this pregnancy? Make a selection of Yes, No , 
or Unknown from the dropdown. 

Height (feet/inches): Collection of this item consists of two numeric entry controls. Enter the 
mother’s height in feet in the first box and height in inches in the second. If the height is 
unknown then enter 99 in both boxes. 

Mother Pre-pregnancy Weight (pounds): Enter the mother’s weight (in pounds) prior to the 
current pregnancy. If weight is unknown enter 999. 

Mother Weight at Delivery (pounds): Enter the mother’s weight (in pounds) at delivery but 
prior to the actual delivery. If weight is unknown enter 999. 
 
Tobacco use during this pregnancy: Make a selection of Yes, No, or Unknown from the 
dropdown list.  Selecting ‘No’ will disable the need to collect the remaining tobacco related 
items. 
 

Cigarette smoking per day before and/or 
during pregnancy:  These items capture the 
mother’s use of tobacco (smoking) during the 
three months prior to the current pregnancy 
and during each of the 3-month trimesters of 
pregnancy. 

Enter the approximate number of cigarettes 
smoked and select Cigarettes from the 
dropdown. 

Once the Mother Health page is complete, select a navigation button at the bottom of the page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   
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Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous  

 

 

5.6.2 Place of Delivery 

The Place of Delivery Items to Enter capture data regarding where delivery occurred.  This 
could be a hospital, home address or some other location. 

 

Type of Place of Delivery: From the Type of Place of Delivery 
dropdown, select the type that best matches the location where 
delivery occurred.  

If Other (specify) is chosen, enter the information on type of place 
of death into the Other Specify text box. 

 

 

Facility Name:  

If Home, (Intended, Unknown if Intended, or Unintended), is selected, the Address fields 
for Place of Delivery will be auto-populated with the information entered on the Mother Address 
page. If no information has been entered on the Mother Address page, the address can be 
manually entered. For home deliveries, Facility Name is not required and will be disabled. 

If Other (specify) is selected from the Type of place of delivery dropdown, the facility 
name (if known or applicable) and address fields can be manually entered.  The facility name 
field can be left blank. 

If Unknown is selected from the Type of place of delivery dropdown, the Facility Name 
and address Street Number, Pre/Post Directional, Street Name, Street Designator, Apt./Suite 

 More information on record validation can be found in section 6 - Validation of Records 
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and Zip Code fields are not required and will be disabled. The City/Town, County, State and 
Country fields can be manually entered.  

For all other Type of Place of Delivery dropdown selections made, the Place of Delivery 

can be entered manually or the LOV Lookup  icon can be used to launch the Lookup Place 
of Delivery search tool. 

Steps to Use the Place of Delivery Lookup 

1. In the Faclity Name field, if 
known, enter the full name of 
the facility and choose Search.  

If the full name of the facility is 
not known, enter at least two 
letters followed by the %, 
then select search to perform 
a wildcard search. 

 
2. A list of available facilities will be returned. Select the Select link next to the correct facility 
in the list.  

 

 

Making a selection from the LOVE system-fills all of the corresponding fields for Place of 
Delivery on the page: 

To clear the entry made for Place of Delivery, select the eraser icon . 

 

 

 

 

 

 

 The Place of Delivery Lookup filters results based on the selection made in the Type of 
Place of Delivery dropdown. For example, if method selected is Inpatient, En Route or 
Hospital, the lookup will filter the search to include hospitals; if Birthing Center, a list of 
birthing centers, etc.   
 

 If the user completing this section is logged in at a Medical Facility the Place of Delivery 
will be auto-filled   with the facility name and address the user is logged in under. It can be 
changed if needed.  

 Facilities not listed in the LOV lookup tool can be entered by typing the Facility Name 
and address information manually.  All out-of-state records will contain non-listed facilities. 
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Once the Place of Delivery page is complete, select a navigation button at the bottom of the 
page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 
 

5.6.3 Prenatal 

The Prenatal page Items to Enter collect information pertaining to type and frequency of 
prenatal care administered to the mother.   

Format Change: The 2003 US Standard Certificate Revision included format changes for the 
collection of prenatal data. The DAVE™ application provides the prior version of the Prenatal 
page for those fetal deaths occurring before January 1, 2013 when Arizona adopted the 
revision. 

Pre-2003 Prenatal page: 

 
 

 More information on record validation can be found in section 6 - Validation of Records 
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Post-2003 Prenatal page:

 
 

Mother Medical Record Number: If known, the Mother’s Medical 
Record Number can be entered.  

 

 

Date Last Menses Began: Enter the Date Last Menses Began manually or select the 

Calendar  icon to launch the Interactive Calendar. If this date is unknown enter 99-99-
9999. If the month and year are known but the exact day is not enter 99 for the day but enter 
the month and year correctly. For example: 01-99-2016. 

In the Prenatal Care section, if the mother did not receive any prenatal care, select the No 
Prenatal Care checkbox.  If the mother did receive prenatal care, complete this prenatal 
information by entering the Date of First Visit, Date of Last Visit, and the Total Number of 
Prenatal Visits. 

 

If either date is unknown enter 99-99-9999. For either date, if the month and year are known 
but the exact day is not enter 99 for the day but enter the month and year correctly. For 
example: 01-99-2016. 

In the Previous Live Births section, make a selection from the dropdowns for Number Now 
Living and Number Now Dead 

 The Medical Record Number can be referenced later to Search for or Locate the case.   
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Date Last Live Birth: Manually enter the month and year only for the Date of Last Live Birth. 

If this is the mother’s first delivery, select ‘None’ from both the Number Now Living and Number 
Now Dead dropdown list list.  Selecting none from both lists disables the Date of Last Live Birth 
control as it is not required in this instance.  

If the Number Now Living and/or Number Now Dead are unknown, select ‘Unknown’ from the 
dropdowns.  Doing so will auto-populate the Date of Last Live Birth with 99/9999 and disable 
the control. 

The Other Pregnancy Outcomes (Spontaneous or Induced Terminations or Ectopic 
Pregnancies) section is used to collect information regarding previous pregnancies that did not 
result in a live birth.   

 

Make a selection from the Number of Other Pregnancy Outcomes dropdown.   

In the Date of Last Other Pregnancy Outcome field, enter the month and date that the last 
pregnancy terminated.   

If this is the mother’s first pregnancy, select ‘None’ from the Number of Other Pregnancy 
Outcomes dropdown. Doing so disables  the Date of Last Other Pregnancy Outcome control 
as it is not required in this instance. 

If the Number of Other Pregnancy Outcomes is unknown, select ‘Unknown’ from the dropdown.  
Doing so will auto-populate the Date of Other Pregnancy Outcome with 99/9999 and disable 
the field. 

Make a selection of Yes, No, or Unknown from the Was the prenatal record available for 
completion of the fetal deah report? dropdown. 

 

Make a selection from Serology on Mother. 
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Once the Prenatal page is complete, select a navigation button at the bottom of the page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

5.6.4 Pregnancy Factors 

The Pregnancy Factors page Items to Enter collect information related to conditions suffered 
or experienced by the mother which may have resulted in complications during labor, or 
created health implications for the mother and/or fetus.  

  

Risk Factors for this Pregnancy and Infections Present and/or Treated During this 
Pregnancy allow for multiple selections, meaning that the user can select one or as many of 
the conditions that apply.  Select the None Of The Above if none of the conditions apply. 
Select Other (specify) if a condition applies but is not available to select. 

 

 More information on record validation can be found in section 6 - Validation of Records 
 

 At least one selection must be made within each section. 
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Once the Pregnancy Factors page is complete, select a navigation button at the bottom of the 
page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

5.6.5 Delivery 

The Delivery page Items to Enter  record the procedures used and conditions present during 
the delivery process. 

 

The Method of Delivery section is used to describe how the fetus was delivered. On this page 
the user will make selections from the available dropdowns for the following items: 

 Was Delivery with Forceps Attempted but Unsuccessful? 

 Was Delivery with Vacuum Extraction Attempted but Unsuccessful? 

 Fetal Presentation at Delivery 

 More information on record validation can be found in section 6 - Validation of Records 
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 Final Route and Method of Delivery 

 Hysterotomy/Hysterectomy 
 

 

If Cesarean, was a Trial of Labor Attempted? will only be enabled if Cesarean was selected 
from the Final Route and Method of Delivery dropdown above. 

The Maternal Morbidity section collects information on any serious complications 
experienced by the mother associated with labor and delivery.  Multiple selections are allowed.  
Select None of the Above if none of the conditions were experienced by the mother during 
delivery. 

 
 
 

The Characteristics of Labor and Delivery section collects information in regards to labor 
and delivery. Multiple selections are allowed.   

 

A selection of Yes, No, or Unknown must be made from the Mother Transferred for maternal 
medical or fetal indication prior to delivery dropdown at the bottom of the page.   

 At least one selection must be made within the Maternal Morbidity section. 
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Selecting Yes from the dropdown will display a new section where the Transfer Facility 
information is entered. 

 

 

 

The Transfer Facility may be entered manually or the LOV Lookup  icon may be used to 
launch the Lookup Mother Transfer Facility search tool. 

 Steps to Use the Mother Transfer Facility Lookup 

1. In the Faclity Name field, if 
known, enter the full name of 
the facility and choose 
Search.  

If the full name of the facility is 
not known, enter at least two 
letters followed by the %, 
then select search to perform 
a wildcard search. 

2. A list of available facilities will be returned. Select the Select link next to the correct 
facility in the list.  

 

 

The selection system-fills the facility name for Transfer Facility on the page.  

 

 

 

To erase the entry made for Place of Delivery choose the eraser icon . 

 
Once the Delivery page is complete, select a navigation button at the bottom of the page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 Facilities not listed in the LOV lookup tool can be entered by typing the Facility Name 
information manually.   
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5.6.6 Fetal Attributes 

The Fetal Attributes page Items to Enter are used to record information relative to the fetus at 
time of delivery. 

 

Weight of Fetus: Enter the fetus weight in Grams. 
 
Obstetric Estimate of Gestation (weeks): Enter the obstetric estimated gestation of the 
fetus in weeks. 

Plurality: Select the plurality for this delivery.  If only one delivery occurred select Single. For 
multiple deliveries select the corresponding plurality.  

Delivery Order: If Plurality is Single then Delivery Order will be disabled. For multiple 
deliveries select the delivery order of this fetus from the dropdown. 

 

The Congenital Anomalies selections are used to gather information related to any 
abnormal conditions (congenital anomalies) of the fetus. Multiple selections can be made.  If 
none of the conditions apply, select “None of the anomalies listed above.” 
 
 
Once the Fetal Attributes page is complete, select a navigation button at the bottom of the 
page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

 More information on record validation can be found in section 6 - Validation of Records 
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Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

5.6.7 Cause/Conditions Contributing to Fetal Death 

The Cause/Conditions Contributing to fetal death page Items to Enter record initiating and 
contributing causes and conditions that lead to fetal death.  

 
The Cause/Conditions Contributing to fetal death page is separated into two sections: 

 

 More information on record validation can be found in section 6 - Validation of Records 
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1. Initiating Cause/Condition: Is for reporting a single condition that most likely began 
the sequence of events that resulted in the death of the fetus. 

2. Other Signification Causes or Conditions: Is for reporting all other conditions 
which resulted in the death of fetus. Whereas only a single initiating cause or 
condition may be entered, multiple other causes or conditions may be selected. 

 
Regardless of which section is being completed, causes or conditions within each control are 
entered in the same manner.  

If the cause of fetal death was due to a condition or disease of the mother, enter this 
information in the Maternal Conditions/Disease (Specify) text field. 

 

If the cause is related to Complications with the placenta, cord, or Membranes, make a 
selection from the checkboxes provided. If none of the checkboxes are applicable, select the 
Other (specify) checkbox to manually enter the cause/condition. 

 

The remaining cause items allow for manual entry of information regarding Obstetric or 
Pregnancy Complications as well as any Fetal Anomalies, Injuries, Infections or Other 
Conditions/Disorders that caused fetal death. 
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In some cases the cause or conditions that contributed to the death 
of the fetus may not be known.  In these instances select the 
Unknown checkbox. 

In some instances the mother may have opted for an elective 
abortion. In these instances select the Elective Abortion checkbox. 

 
Estimated Time of Fetal Death: Make a selection from the dropdown. 
 

 
 
The preceding dropdowns indicate whether or not an autopsy and/or histological placental 
examination were performed and used in determining the cause of the fetal death. Make 
selections from all three dropdowns.  
 

 
 
If “No” is selected from both the Autopsy Performed and Histological Placental 
Examination Performed dropdowns, the Autopsy or Histological Placental Examination 
used in Determining Cause of Fetal Death dropdown will default to “Not Applicable” and be 
disabled. 

The remaining dropdowns record placental and fetal appearance as well as information on 
whether the Medical Examiner was contacted in regards to the fetal death.  

 

Make a selection from each of dropdown. If an ME Case number has been assigned to the 
record, enter it here. 

Once the Cause/Conditions Contributing to fetal death page is complete, select a navigation 
button at the bottom of the page: 

 

Selection of the Next button will save the data entered and proceed to the next page.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   
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5.6.8 Reporter 

The Reporter Items to Enter capture information regarding the person who completed the 
fetal death report.  

 

The name of the person completing the report can be manually entered or the standard LOV 
lookup tool can be used to search for the reporter. 

Steps for using the Standard LOV Lookup to complete 

1. Select the LOV lookup tool  to search for the reporter. Enter in the Last and First 
Name of the reporter; if 
known.  If unknown, a 
wildcard search can be 
performed by entering at least 
two characters in the Last 
name field followed by %. 

2. From the Search Results 
List select the Select link 
next to the correct 
Certifier. 

The system will then auto-populate the Certifier name and the associated Certifier Address 
information. 

 

 More information on record validation can be found in section 6 - Validation of Records 
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Date Report Completed: Manually enter the date the report was completed or select the 

calendar icon  to launch the interactive calendar. 

 

 

 

Once the Reporter page is complete, the Personal Information section 
of the fetal death record is also complete. Select a navigation button at 
the bottom of the page: 

 
 

Selection of the Next button will save the data entered and proceed to the next page.  In this 
case the next page is also the first page in the Medical Information section, Prenatal.   

Other options include selection of the Validate Page button to check the page for errors, the 
Clear button to clear all entries since the last save, the Save button to save changes without 
leaving the page, or the Return button to return to the previous   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 More information on record validation can be found in section 6 - Validation of Records 

 If the user completing this section is logged in at a Medical Facility the Reporter page will 
be auto-filled with the name of the user logged in and the Date Report Completed will be  
auto-filled with the date the user affirms the report.  
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5.6.9 Attendant/Certifier 

The Attendant/Certifier page Items to Enter capture information relevant to the person or 
persons attending and/or certifying the delivery. 

Pre-authorize Cremation Clearance: This checkbox is only available to Medical Examiner’s 
whom have intiated entry of the fetal death record. Selection of this checkbox allows the 
Medical Exminer to pre-authorize cremation clearance if the method of disposition is selected 
as cremation. 

Attendant at Delivery: May be completed manually or the LOV lookup tool  can be used to 
search for and select the attendant. 

Steps for using the Attendant Lookup LOV Lookup to complete 

1. Select the LOV lookup tool  to search for a certifier. 
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2. Enter the Last and First Name of the attendant; if known.  If not known a wildcard search 
may be performed by entering at least two characters in the Last name field followed by %. 

 

 

 

 

 

 

From the Search Results List, select the link next to the correct Attendant. 

3. The system will then system fill the Attendant name and the associated Attendant 
Address information. 

 

 

 

Otherwise, the Certifier information may be completed manually or the LOV lookup tool  can 
be used to search for and select the certifier. 

Steps for using the Certifier Lookup LOV Lookup to complete 

1. Select the LOV lookup tool  to search for a certifier. 

 The Attendant at Delivery is the individual physically present and responsible for the 
delivery.  
 



State of Arizona DAVETM User Guide  

 

  117 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

2. Enter in the Last and First Name of the certifier; if known.  If not known a wildcard 
search can be performed by entering at least two characters in the Last name field followed by 

%. 

 

 

 

 

 

 
3. From the Search Results List Select the link next to the correct attendant.  The system 
will then auto-populate the Attendant name and the associated Attendant Address information.

 

 

 
Certifier: If the Certifier is the same person who attended and is 
responsible for the delivery, select the Same as Attendant checkbox. 

Otherwise, the Certifier information may be completed manually or by using the LOV lookup 

tool  to search for and select the certifier. 

 
 

 The Attendant at Delivery is the individual physically present and responsible for the delivery.  
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Date Certified: Enter the date the record was certified manually, or select 

the calendar icon  to launch the interactive calendar. 

 

 
 

 

Once the Certifier page is complete, the Medical Information section of the death record is also 
complete. Select a navigation button at the bottom of the page: 

 

 

The Next button is no longer available as this is the final mandatory page to complete within 
the Death Registraton menu.  

Options for selection are the Validate Page button to check the page for errors, the Clear button 
to clear all entries, the Save button to save changes without leaving the page, or the Return 
button to return to the previous page.  

 

 

 

5.6.10 Certify the Fetal Death Record 

At this point in the process the Medical Information has been completed and the Medical user 
responsible for entering this information will need to Certify the record. 

 

 

 
 

 

 

 

 

 

 If the record is being entered at the State or a County Vital Records Office, affirmation is not 
required and the steps for this process can be skipped.   
 

 If both the Personal and Medical Information are being entered by a medical facility user, 
completion of this particular certification step is not required. 
 
Upon successful validation of both the Personal and Medical Information, the Affirm/Certify link 
will be made available allowing the medical facility user to Affirm the Personal Information while 
simultaneously Certifying the Medical Information. 

 If the user completing this section is logged in at a Medical Facility the Certifier information 
will be system-filled with the name of the user logged in and the Date Certified will be system-
filled case is certified.  

 More information on record validation can be found in section 6 - Validation of Records 
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The user affirming the record will select the Validate Page button or Validate Registration link 
to check the record for errors and/or omissions.  

 

 

 

 

 

 

 

 

 

Once the record has passed all validation rules, an Affirm link will appear at the bottom of the 
Personal Information submenu. 

 

 

 

 

 

Steps to Certify the Medical Information 

1. Select the Certify link 

2. Select the checkbox next to the listed affirmation(s) and then select Certify. 

 

3. An Authentication successful message will be displayed and a checkmark placed next to 
the Certify link indicating that the Personal Information has been affirmed.  

 More information on record validation can be found in section 6 - Validation of Records 
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Once the record is signed the pages within the Medical Information sub-menu are locked and 
cannot be edited.  

If the record is not yet registered and updates need to be made to any of the items in the 
Medical Information section, the record must first be uncertifed. Doing so unlocks the pages 
within the Medical Information sub-menu so they can once again be edited. 

Steps to Uncertify the Medical Information 

1. To uncertify the registration, select the Certify link.  

 

2. Select Uncertify.  

3. Select OK to confirm the reversal. 

Once uncertified, the pages are again available for editing. 
 

5.6.11 Affirm & Certify the Fetal Death Record 

At this point in the process the Personal and Medical Information has been completed and the 
Medical user responsible for entering this information will need to Affirm and Certify the record. 

 

 

 

 

 If the record is being entered at the State or a County Vital Records Office, affirmation and 
certification are not required and the steps for these processes may be skipped.   
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The user affirming and certifying the record should select the Validate Page button or Validate 
Registration link to run the validation edit rules for the record.  

 

 

 

 

 

 

 

 

Once the record has passed all validation edit rules, an Affirm/Certify link will appear at the 
bottom of the Medical Information submenu. 

  

 

 

 More information on record validation can be found in section 6 - Validation of Records 

 The combination Affirm/Certify link should be used for those medical facility users 
responsible for entering all of the Personal and Medical Information for a Fetal Death Record. 
 
Once both Personal and Medical Information is complete and all validation rules have passed 
an Affirm/Certify link will be made available allowing the medical facility user to Affirm the 
Personal Information at the same time as Certifying the Medical Information. 
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Steps to Affirm and Certify the Medical Information 

1. Choose the Affirm/Certify link 

2. Select the checkbox next to the listed affirmations and then select Affirm. 

 

3. An Authentication successful message will be displayed and a checkmark placed next to 
the Affirm/Certify link indicating the Personal Information has been affirmed.  

Once the record is affirmed and certified the fetal death record will receive a “Registered” 
status.  

If updates need to be made to any of the items in the Personal or Medical Information section, 
an Amendment will need to be submitted.  See section 8.1 Amendments for the steps to submit 
an Amendment.  

 

6. Validation of Records 

6.1 Record Validation 

A death or fetal death record may only be submitted for registration after the Personal and 
Medical Information has been completed and validated.  

 
DAVETM provides two ways in which to validate the Personal and 
Medical information that has been entered: 

During completion of the Personal or Medical Information pages 
the user may select the Validate Page button found at the 
bottom of each registration page. 
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The user may also select the Validate Registration link from within the Other Links submenu 
of the Death or Fetal Death registration menu.  

Regardless of the validation method selected, the exact same validation processes are used 
to check the registration for errors and/or omissions.  

A system of edit rule validations compare all Personal and Medical information pages in the 
process. This is done to ensure that all items within these pages are completed accurately, 
verifies that mandatory fields have been not been left blank and that valid values have been 
entered based on the type of entry required for each field, and checks the respective NCHS 
specifications affecting each field. 

The validation process is intended to show the user any outstanding issues with entries they 
have made and allow them to make corrections. In some cases corrections are not needed 
and the user will instead follow a process to affirmatively submit the items as they were entered. 

6.1.1 Viewing Validation Edits 

Once the Record Validation process has occurred there are two ways to review edit rules 
failures: 

Validate Registration Page  

If the user selected the Validate Registration link from within the Other Links submenu they will 
be taken to the Validation Results Page. 

 

The Validation Results page provides a list of all validation edit rules that have been triggered 
on the record and that need to be reviewed, corrected, and overridden. 
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Validatation Results Table  

If the user selected the Validate Page link, from within one of the Personal or Medical 
Information pages, then a Validatation Results grid will be displayed at the bottom of the page 
itself.  

 

Again, regardless of the Record Validation type selected, the process to validate the record 
is the same.  However, access to the Validate Registration link is based on user security 
setup. 

 

 

 

 In this example nothing has yet been entered into any of the pages except the items needed 
to start the record. This is why there so many errors being displayed within the Validate 
Registration page. Typically the Record Validation will not be run until the Personal or Medical 
sections have been completed.  
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6.1.2 Correcting Validation Edit Checks 

From the list of failed edit rules, either on the Validate Registration page or the Validation 
Results table within a specific page, the following options are available for correction of 
validation errors. 

6.1.2.1 Manually Selecting  

Upon validation, the individual pages within the Registration Menu are given a color coded 
symbol to identify those with pages with edit rule failures to review, the types of edit rules that 
failed, and any pages that passed all edit rule validations. 

In this example the following pages:  
Passed all edit rules: Fetus, Mother Address, Mother 
Attributes, Marital Status, and Place of Delivery 

Have soft edits triggered: Mother Health, Reporter 

Have hard edits triggered: Mother 

 

 

 

The user may then select a page to review from the Registration Menu. Once selected, the 
page will display and highlight the field that contains errors. The Validation Results table, 
found at the bottom of the page, provides information on what the edit rules that failed and 
how they may be corrected.  

 

6.1.2.2 Goto Field Option  

From either the Validate Registration page or the individual Validation Results table, select the 
fix  icon in the Goto Field column.  The DAVETM page containing the error will be displayed 
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place and the cursor placed in the field requiring correction. This option is very useful if 
corrections are being made to a single registration page with multiple edit rules to correct.  

6.1.2.3 Validation Popup Option 

To use this method of error correction, select the fix  button in the Popup column. DAVETM 
will then provide a Validation Pop-up which displays the validation error message and the field 
or fields in need of correction. 

 

This Popup window functionality is especially useful when trying to resolve validation errors 
that include conflicting entries across multiple pages.  Rather than requiring the user to search 
across many pages, the Validation Popup presents all of the conflicting fields in a single 
window. 

Once all listed errors have been corrected, select the Validate Registration or Validate Page 
link once again to verify that no errors remain. 

6.1.3 Override Validation Edit Checks 

The edit rule validation process produces two types of validation failures to review: 

Hard Edit Errors - These errors are triggered for item entries that must be corrected before 
the record can be submitted for registration.  

Fields containing hard edit rule failures are highlighted in red.  Note that the Validation Results 
table will not provide an option for overriding or bypassing hard edit rule failures.  

Soft Edit Errors - These errors are triggered for item entries that may be submitted ‘as 
is’ for registration but must first be overridden. 

Fields contaning soft edit rule failures are highlighted in yellow.  Note that the Validation Results 
table provides a mechanism that allows users to Override soft edit rule failures. 
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To override a soft edit rule failure, place a checkmark ( ) in the checkbox next to the field in 
question and select the Save Overrides button.  

The Override process allows the user to submit the record for registration even though errors 
may be present.  State and/or local registrars will know that the user did review the error and 
that the data entered was considered accurate. 

6.2  Record Status 

Record Validation also serves to apply statuses to the record. The record status is used to 
track progress of the record within the registration process. The statuses applied to the record 
are also used to place records in Registration Work Queues enabling users to keep track of 
the records they are working on. 

 

 

While working within a Death or Fetal Death registration the Record Status is easily viewed 
within the Status Bar located at the top of the page, just under the identifying information. 

 

When a Death or Fetal Death record is initiated it receives the Status of ‘New Event.’ As the 
record progresses through the registration process, the Record Status will update accordingly.  

Upon initial Record Validation, if any errors are found within the personal or medical information 
pages the New Event status will update to Personal or Medical Invalid. 

 

 

‘Invalid status’ applies a filter of Personal and/or Medical Pending to the Record. This means 
the user can now find this record within their Peronal or Medical Pending Registration Work 
Queue. 

 

 More information on Work Queues can be found in section 10 - Queues 
 

Left Side = Status Assigned Right Side = Status Filter Assigned 
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The table below provides information on Record Statuses assigned, status filers assigned (if 
any), and the filter name.  

Record Status Assigned Staus Filter 
Assigned? 

Status Filter (Work Queue) Assigned 

New Event No  

Personal Invalid Yes Personal Pending 

Medical Invalid Yes Medical Pending 

Personal Validw/Exceptions No  

Medical Validw/Exceptions No  

Unsigned Yes Signature Required 

Uncertified Yes Certification Required 

Unaffirmed Yes Affirmation Pending 

 

Record Validation may also cause Status Filters (Works Queues) to be assigned without a 
corresponding Record Status.  A few examples of this are Rare Cause of Death, ME Review 
Required, and Cause of Death Pending.  For more information on Work Queues see section 
section 10 – Queues. 

7. Search or Locate Records 

To access an existing record, a user will either be assigned the ability to Search for or Locate 
a Case. The options available are determined by the security privileges assigned to the user’s 
role. 

7.1 Search for a Record 

The Search feature allows a user to find all matching records entered within the system, not 
just those records owned by the Facility selected at login. 

To search for an existing record, from the Main Menu choose Life Events > Death -or- Fetal 
Death > Search. 



State of Arizona DAVETM User Guide  

 

  129 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

 

 

-OR- 

 

The Search page displays allowing for the user to choose between two differing ways to search:  

 

Search by Identifier Designed to return results based on case-specific record data such as 
File Number, Case Id, ME Case Number or Medical Record Number. Searching by this data 
will most often return a single record.  

 
Search by Registrant or Data Provider Designed to search on a wider array of record data 
such as Registrant Name, Facility Name, Medical Certifier Name, or Mother or Father Name.  
 
 
 

7.1.1 Search by Identifier 

The differences between the Death and Fetal Death Identifier search options: 

 

 

 

 

 

 

 

 

 

 

 

 

 Search fields are not case-sensitive. Upper and lower case letters are allowed. 
 

Death Record Identifiers Search Fetal Death Record Identifiers Search 
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Identifier Search Items Available in Both Death and Fetal Death Search 

File Number: A file number is composed of two elements: Year and Number.  

- Year is the year in which the death occurred (4 digits).  

- Number is the unique 6 digit number assigned to the record upon registration by DAVETM.  

The combination of both numbers comprise the State File Number (SFN). Both numbers are 
required in order to perform a search by File Number. 

Case ID: This is a unique number DAVETM assigns each case once it’s been created and saved 
regardless of registration status. 

ME Case Number: This is the unique number assigned by the medical examiner. Not all cases 
will have an ME Case Number as not all cases are worked on by the ME. 

File Date: This is the date on which the case officially received a “Registered” status. Any case 
filed on a particular date will be returned when searching by File Date. 

Date of Death or Date of Delivery: By using the Start and End dates, DAVETM will return all 
cases with the range entered. If only a Start date is entered, DAVETM will look for all cases that 
match the exact date entered in the Start field. 

Place of Death or Delivery Location Type: Used in conjunction with Place of Death or Place 
of Delivery to determine whether the search should be executed based on County or City of 
registration.  

Place of Death or Location Name: Select the Place Lookup icon  to choose from a list of 
County or City locations based on the selection made in Place of Death or Delivery location 
type. A direct manual entry can also be made. 

 

Identifier Search Items Available for Death Search Only 

Medical Record Number: This is the unique number assigned by the medical certifier. Not all 
cases will have a Medical Record Number as it is not a required field in DAVETM 
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7.1.3 Search by Registrant or Data Provider 

Search by Registrant or Data Provider includes the same search criteria whether searching for 
Death or Fetal Death cases, the difference being the types of Registrant or Data Providers that 
can be searched for. 

Steps to Search by Registrant or Data Provider 

1. Select the type of Persons/Organizations for which search criteia will provided. 

 

 

 

 

 

 

 

2. Based on the Person/Organization Type selected, enter specific search criteria. 

 

 

 

 

 

 

 

 

 

 If an Organization rather than Person Type is selected, the First and Middle Name 
fields will be disabled. The Last Name field is relabeled “Organization Name” instead. 
 
 

Death Person/Organization Options Fetal Death Person/Organization Options 
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The More button allows users to include more than one person or facility within a 
single search. 

 

 

As a general rule, searches should be as specific as possible to minimize the number of entries 
returned.  

Maximum records to display: The Maximum records to display field defaults to 200.  This 
means that, regardless of the actual number of records returned by the search, only 200 will 
be displayed in the Search Results data grid.  

 

For example, if a user enters a Start Date of Death of Jan-01-2011 and an End Date of Death 
of Dec-31-2011, then the total records returned might be greater than 200 but only 200 records 
would be displayed.   

This number can be increased on the Search page to display more than 200 results. However, 
the maximum numbere of records the system will ever display is 5,000. If a user cannot find 
the record they are looking for within the maximum number of results allowed, more search 
criteria should be entered to refine the search results.  

7.1.4 Search with a Wildcard 

At times, a user may be unsure of spelling or only have a partial name to locate a 
registration. In these cases, a wildcard search may be helpful. The wildcard can only be 
entered as search criteria in Name, Places, or Organization fields. 

Wildcard search criteria requires the entry of at least two characters followed by the percent 
sign (%) symbol. 
 
 
 

 Select the Clear icon to erase search entries and begin another search. 

 



State of Arizona DAVETM User Guide  

 

  133 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

Examples: 

 

 

 

 

 

 

 

 

 

 

 
 

7.1.5 Types of Searches 

Once the Search Criteria has been entered the user may 
select the type of Search the system performs with the 
criteria provided.  Three search options are available: 
Search, Soundex, or Swap Names. 

 

7.1.5.1 Search 

Selecting the basic Search button will perform a search and return results based on 
the exact criteria entered in the search field utilized. 

 

7.1.5.2 Soundex  

If the exact spelling of a name is unknown, the Soundex search feature may be 
used. Soundex searches for names, places, or organizations that sound similar despite minor 
differences in spelling.   

 

 

 

 

 

 Soundex cannot be used when Searching by Identifier  

 

 Wildcard searches have the potential to return many rows of data. Build searches 
carefully so that the fewest number of cases are returned. 

. 
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Soundex Example: 

 

Selecting Soundex returns several records where the last name “sounds like” Kaplin.  

 

 

7.1.5.3 Swap Names 

In certain cultures, a person’s family name often comes before their given name.  
When this is the case, a standard search can sometimes fail to return the 
desired record(s). 

The Swap Names feature is used to search for cases where there is some ambiguity between 
the First and Last names. 
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Swap Names Example: 

 

When the basic Search button is selected no results are returned. However, selecting the 
Swap Names button returns the expected case. 

 

 

7.1.6 Preview Search Results 

When multplie search results are returned use the Preview link to view a summary of the 
record. 

The record from which the Preview link has been selected will display highlighted and a 
summary now appears below the search results. 

 Like the Soundex feature, Swap Names cannot be used in Search by Identifier fields. 
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Upon selection, the Preview link becomes a Select link which allows the user to select and 
view the registration pages of the record being previewed. The user can also elect to preview 
additional cases until finding the correct record to select. 
 

7.1.7 Special Characters & Search 

DAVE™ allows the use of the following special characters within First, Middle and Last name 
fields:   

Character Name Symbol Allowed 
Combinations 

Tildes ~ ~ Ã ã Õ õ Ñ ñ 

Umlauts ¨ ¨ Ä ä Ë ë Ï ï Ö ö Ü ü Ÿ ÿ 

Acute accents ´ ´ Á á É é Í í Ó ó Ú ú Ý ý 

Circumflex ˆ ˆ Â â Ê ê Î î Ô ô Û û 
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Special characters other than those referenced above are not allowed and will trigger an edit 
rule failure upon page validation. See example below: 

 

Special Characters & Search: If allowed special characters are entered in the First, Middle, 
or Last name search fields, DAVE™ will return all matching names whether or not they contain 
the special characters. 

Example 

A search for a name containing allowed special characters returns all matches, even those not 
containing the special character: 

 



State of Arizona DAVETM User Guide  

 

  138 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

 

 

In contrast, standard keyboard characters (a-z, A-Z, ‘, -) entered as search criteria will return 
only an exact match. 

Example 

Searching for Henry O’Leary-Frank returns only the exact match. 

 
Even when the same name without the characters exists in the system 

 

7.2 Locate a Record 

The Locate Case feature allows a user to search for and access those records owned by the 
Facility selected at login. The Locate Case feature will not display any records not associated 
with the current facility. 

To locate an existing record that belongs to the facility selected at login, , select Main Menu > 
Life Events > Death -or- Fetal Death > Locate Case. 

 

  
-OR-      
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7.2.2 Death Record Locate Page Search Criteria 

The following fields are available for locating Death Records owned by the facility. 

 

First and Last Name: Only the Last Name is needed to locate a record. If the first and last 
name is entered, a narrower rangfe of search results will be returned. 

Date of Death: The system will locate all cases owned by the facility in which the Date of Death 
on the record matches the date entered on the Locate Case page. 

Sex: Sex cannot be the only search criteria entered when locating a record. Last Name or Date 
of Event must also be entered.  If Sex is the only item entered the following error message will 
be displayed: 

 

SSN: The system will locate any case owned by the facility in which the SSN on record 
matches that entered in the search criteria. 

Date of Birth: The system will locate all cases owned by the facility in which the Date of Birth 
on the record matches that entered in the search criteria. 

Case ID: The Case ID is a unique identifier assigned to each record. When using the Case ID 
to locate a record, only the specific record matching the Case ID entered will be returned.  

ME Case Number: The ME Case Number is a used to locate records in which a medical 
examiner has assigned a case number to the record.  If the case was not worked on by a 
medical examiner, no ME Case Number will be assigned to the record.  

Medical Record Number: The Medical Record Number is a used to locate records in which a 
medical record number has been assigned. Medical Record Number is not required and 
therefore not all records will have one. 

Place of Death Location Type: Used in conjunction with Place of Death to determine whether 
the search should be executed based on County or City.  
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Place of Death: Select the Place Lookup icon  to choose from a list of County or City 
locations based on the selection made in Place of Death or Delivery location type. Entries may 
also be keyed in manually. 

The Place of Death cannot be the only criteria entered to locate a record. If Place of Death is 
the only item entered the following error message will be displayed: 

 

7.2.3 Fetal Death Record Locate Page Search Criteria 

The following fields are available when using the Fetal Death Locate Case page. 

 

First and Last Name: Only the Last Name is needed to locate a record. If the first and last 
name is entered, a narrower rangfe of search results will be returned. 

Date of Death: The system will locate all cases owned by the facility in which the Date of Death 
on the record matches the date entered on the Locate Case page. 

Sex: Sex cannot be the only search criteria entered when locating a record. Last Name 
or Date of Event must also be entered.  If Sex is the only item entered the following error 
message will be displayed: 

 

Case ID: The Case ID is a unique identifier assigned to each record. When using the Case ID 
to locate a record, only the specific record matching the Case ID entered will be returned.  
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Place of Fetal Death Location Type: Used in conjunction with Place of Death to determine 
whether the search should be executed based on County or City.  

Place of Fetal Death: Select the Place Lookup icon  to choose from a list of County or City 
locations based on the selection made in Place of Death or Delivery location type. Entries may 
also be keyed in manually. 

The Place of Death cannot be the only criteria entered to locate a record. If Place of Death is 
the only item entered the following error message will be displayed: 

 

Mother’s Current Last Name: The system will locate all cases owned by the facility in which 
the Mother’s Current Last Name on the record matches the search criteria entered. 

Mother’s Last Name Before First Marriage: The system will locate all cases owned by the 
facility in which the Mother’s Last Name Before First Marriage on the record matches the 
search criteria entered.**** 

7.2.4 Types of Locate Searches 

Once the Search Criteria has been entered the user may select the 
type of Search the system performs with the criteria provided.  Three 
search options are available: Search, Soundex, or Swap Names. 

 

7.2.4.1 Search 

Selecting the basic Search button will perform a search and locate records based on 
the exact criteria entered in the search field utilized. 

 

7.2.4.2 Soundex Searches 

If the exact spelling of a name is unknown, the Soundex search feature can be 
used. Soundex looks for names, places, and organizations that are similar in sound despite 
minor differences in spelling.   

 

 

 

 See section 7.1.5, Preview Search Results, for using the Preview options within the 
Located Record Results  
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8. Other Links 

Other Links is submenu of the Death and Fetal Death Registration Menus that contains a 
variety of links used in the registration process. The availablity of links within the Other Links 
submenu is dependent upon the user security privileges assigned to the user role.  Also, some 
links may or may not be available depending on the current registration status. For example, 
records may only be amended after they have received a “Registered” status. Therefore, the 
Amendments link will not appear in the Other Links submenu until the registration has reached 
a registered status. 

The following pages are available through the Death and Fetal Death Other Links submenus.  
Some pages are common to both event types while others are specific to Death or Fetal Death. 

 

 

 

 

 

 

 

 

 See section 7.1.6, Special Characters & Search, for information on searching with 
Special Characters; which works the same when searching via the Locate Case feature. 
 

Death Other Links Submenu Fetal Death Other Links Submenu 
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8.1 Amendments 

Amendments are requests to change a record after it has been registered.   

Typical amendments can involve typographical errors which occurred during data entry. Other 
amendments might require the submission of documentary evidence supporting the request to 
change to item(s).   

The order processing module in the DAVE™ application provides the ability to link an order to 
an amendment by providing the ability to enter customer-initiated mail or walk-in amendment 
requests. If the amendment requires a fee to be paid by the individual requesting the 
amendment, the amendment can be initiated in the order processing module.  Once customer, 
payment, and search information has been entered within the order processing module, the 
user has the ability to navigate directly to the amendment page for the record selected.  Upon 
completion of the amendment, the user has the ability to return to the order processing pages 
and complete the order.   

8.1.1 Creating Amendments 

Amendments can only be created for records that have been registered. A registered record 
will have a State File Number and a status of Registered. 

 

 

 

 

Steps to Create an Amendment 

1. From within the registered record select Other Links > Amendments: 

 

The Amendment Page will be displayed. 

State File Number 

Registered Status 
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2. Select an amendment type from the Type dropdown.  

 

 

 

The remaining items are not required but may be beneficial during review and approval of the 
amendment.   

Order Number: This item may be system filled if the amendment is started through the 
Order Processing pages. If there is an order associated to amendment, but the amendment 
was not started from this order, the Order Number can be manually entered.  

Description: This field is intended to capture any brief information that may help the user 
processing the amendment to understand why the amendment is needed on the record. 
 

 

 

 

 

 

 

 

 

 The Amendment Types available will vary based on the security privileges assigned to 
the user. 
 

 
 

 

 

 

 

These items are only available for completion by State or County staff. To complete them select a 
value from the dropdown, or, if no dropdown exists, type the information manually into the field.  
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3. Once the items have been entered select Save.  

The Save function creates the amendment and:  

 

 

 

 

 

 

 
 

 The Amendments Menu appears in the left navigation 

 The Amendment Date is system-filled with the current date  

 The Year is populated  

 A unique Amendment Number is assigned. 

 The Page to Amend dropdown appears 
 

4. From the Page to Amend dropdown, select the page that needs to be updated.  

    

 

 

 

 

 

 

 

 

 

 

 

 

 

Fetal Death Pages 
Death Pages 
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5. The page selected to amend will be displayed within the Amendment page. The current 
registration data will be displayed. In this example the Disposition Page was selected. 

 

The items available to amend will differ depending on the page selected and individual user 
security. Typically a user can make changes by either manually typing over a current entry, 
selecting a new entry from a dropdown list, or by using LOV search tool. 

6. Once the desired change is made select Save. 

 

 

 

 

 The Pages available to amend will depend on the security privileges assigned to the User.   
 
For example, a funeral director will typically only be allowed to amend those Death or Fetal 
Death Registration pages containing Personal Information. Medical certifiers will typically only 
be allowed to amend those Death or Fetal Death Registration pages containing Medical 
Information.  
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Upon selection Save, the Amendments page will refresh and the changes entered are 
displayed in Item in Error data grid: 

 

 

 

 

 

 Additional options include: 

Cancel Amendment: The amendment will be cancelled and the Amendment Status will be set to 
Cancelled. 

Validate Amendment: Runs the validation process and determines if the amendments made to the 
page could cause data quality issues. The user does not need to correct these validation errors to 
submit the amendment request.  

Clear: Clears all information entered since last prior Save.  

Return: Returns user to the previous page.   

 
 

 If additional items need to be submitted to amend the record, simply follow these steps 
again. 

1. Select a Page to Amend 
2. Make changes 
3. Select Save   

This process can be repeated as many times as is necessary to ensure the amendment is 
submitted with all the corrections that may be needed on the record. 
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8.1.2 Adding Supporting Information 

The amendment Supporting Information page provides a place to enter court documentation 
information relevant to the amendment.  

Steps to Enter Supporting Information 

From the Amendments Menu, select Supporting Information. 

 

The Amendments Supporting Information page displays.  

 

District Court Information: For court ordered amendments or other amendments that require 
judicial approval, the District Court Information section should be completed. Enter the Court 
Name, Court District, Court Docket Number, and Court Date fields with information relevant to 
the specific jurisdiction. 

Court Location: Enter the County and State manually or select the location using the Place 

lookup icon . 

Once all the Court Information is entered select Save and the information entered will be saved 
to the amendment.   
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8.1.3 Adding Attachments to Amendments 

 

Certain types of amendments require the submission of supporting documentation. This 
documentation may include court orders, birth certificates, death certificates, geneological 
records, etc.  

To upload supporting documents into DAVETM, the document must first be rendered into an 
electronic format. Any document that is not already an electronic file must be scanned first. 

Steps to Add an Attachment 

1. From the Amendments Menu, select Attachments. 

 

2. The Attachments window appears as a pop-up.  Select the New Attachment button. 

3. Select the Browse button to access local or network drives. 

 

4. Select the document to be uploaded as an Attachment to the Amendment. 

 The ability to view, edit, and/or delete attachments is based on security privileges. 
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5. Once the supporting documentation is selected, select the Save button. 

 

Selecting the Save button uploads the attachment to amendment. The Attachments pop-up 
displays the name of the attached file.  

 

Once the document has been attached, users with the appropriate security privileges will be 
able to view and/or delete the attachment using the View or Delete links. 
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8.1.4 Change History 

Change History contains comments relevant to the amendment.  Comments may be system 
generated or manually entered.  

 

Upon selection of the Change History link, the Comments pop-up window is displayed.  
Selecting the New Comment button will display the comment entry field. 

 

1. Select the Comment Type from the dropdown and then enter the comment in the text 
box. 
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2. Select Save to save the comment, Clear to remove unsaved comments, or Cancel to 
leave close the comments window. 

 

 

 

Once saved the comment will be displayed in the main comments tab. If the comment is longer 
than the data grid display, the user can allow the cursor to hover over the field to display the 
full comment. 

Select the Edit link to view and change the comment or the Delete link to remove the comment. 

A checkmark is placed adjacent to the Change History link once a Comment has been added 
in the Change History section to a death record. 

 

8.1.5 Amendment Affirmation 

The Amendment Affirmation process is used by external data providers to affirm an 
amendment before submitting it to the state for approval. 

 

 

 

 State and County users are not required to affirm amendments.  

 

  Select Clear to clear the comment entry.  
      Select Cancel to cancel and exit out of comment entry field. 
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Steps to Affirm the Amendment 

1. Select the Amendment Affirmation link from the Amendments Menu 

 

The Affirmations page displays.  

 

2. Select the checkbox next to the affirmation and then select Affirm. 

The affirmation will be saved and an Authentication Successful message displayed. 

 

A checkmark will be displayed next to the Amendment Affirmation link within the Amendments 
menu.  The Amendment page will be disabled and any further corrections will require the entry 
of a new amendment. 

 

Steps to Unaffirm the Amendment 

If further corrections need to be added to the amendment, and the amendment has not yet 
been Approved, the amendment may be Unaffirmed.  
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To unaffirm an amendment, the user should select the Amendment Affirmation link once again 
from the Amendments Menu.  

The Affirmations page displays an Unaffirm Amendment button used to remove the affirmation. 

 

Upon selection of the Unaffirm Amendment button, the following message will be displayed:  

 

Select OK to Unaffirm the amendment. 

The Amendment page will then be re-enabled and additional correction information may be 
entered. 

 

 

If the office creating the amendment selects to exit amendment process before affirmation is 
provided the following error message will be displayed:   

 

 If the OK button is selected, the Affirmations page will be displayed and the user can 
affirm the amendment.   

 Amendments MUST be affirmed before they may be submitted to the State or County official 
for approval.  
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 If the Cancel button is selected, the user will leave the amendments page without 
affirming the amendment.   

Return to Affirm Amendment 

There are two ways a user can return to affirm an Amendment at a later time. 

1. Selecting the amendment from the Amendment Work Queue titled Affirmation Required 

 

2. From within the Death or Fetal Death Registration select the Amendment List link from the 
Registrar menu 

 

The Amendments List page will be displayed. The user can now select the amendment from a 
list. 

 

Either options will take the user back to the amendment where they can add more items to 
correct and/or affirm the amendment. 

 

8.1.6 Approving Amendments 

In some jurisdictions, amendments must be reviewed and approved before taking effect.  
Select the Processing History link from the Amendments menu to proceed with review or 
approval of the amendment.  Typically, amendments go through a review process where the 
change is ultimately either approved or rejected.  The Processing History page supports this 
process.  Depending on office size and/or delegation of roles and responsibilities, an 
amendment may be processed by one person or several.  The abiltiy to review and approve 
amendments is typically restricted to State and County users.  

 

 

 More information on Work Queues can be found in section 10 – Queues. 
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 Steps to Amendment Approval 

1. Select Processing History in the Amendments Menu 

 

2. Complete the fields on the Processing History page. 
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Date Received: On the Processing History page, most of the date controls are either system-
filled or disabled. The Date Received is system-filled with the date the amendment was keyed 
inot the DAVE™ system. If the user has the security privileges to do so, they can update this 
field. Otherwise the field will be disabled. 

Date Mailed: Sometimes requests for amendments are made that cannot be granted.  In these 
cases, a rejection notice is mailed to the individual requesting the change. The Date Mailed is 
for recording the date on which a rejection notice was mailed to the individual requesting the 
amendment. 

Date Returned: If the notice of rejection is returned by the United States Postal Service as 
“undeliverable”, then a checkmark should be placed in the Returned As Undeliverable 
checkbox, and the Date Returned field completed with the date on which the rejection letter 
was returned. 

Date Completed: Date Completed will be system-filled with the date the amendment is either 
approved or rejected. 

Action: The Action dropdown list moves the amendment through the approval steps. The first 
Action is always Data Entry Complete.  As the amendment is processed, additional actions will 
be available.   

Facts Supported: The Facts Supported field is used to enter information about facts given to 
support the requested change.  

Reject Reason: This dropdown provides a list of reasons as to why an amendment may 
be rejected. If the amendment is being rejected a reason should be selected from this 
list. 

Other Reject Reason: This is an open text field to collect additional information relevant 
to the reason the amendment was rejected. Or, if none of the options available in the 
Reject Reason list apply, the reject reason may be entered manually. 

Comment: Any additional comments pertaining to the amendment can be entered here.  While 
it is not necessary to enter comments as part of the amendment process, it is recommended.  
Detailed comments can provide much needed information to the next user working on the 
amendment and can help eliminate needless rejections or invalid approvals. 

Comments entered in the Comment text entry control are only saved if a selection is made 
from the Action dropdown.  

Upon selection of the Save button, if the user has entered text in the Comment field and there 
is no amendment Action selected from the dropdown, the following error message is displayed: 



State of Arizona DAVETM User Guide  

 

  158 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

 

Amendment Status: Amendment Status is system-filled and is not a user-editable control. 
When an amendment request is first entered, the status defaults to Keyed. As the amendment 
is processed, the status will change accordingly. 

3. From the Action dropdown menu, choose Data Entry Complete then choose Save 
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The Amendment Status changes from Keyed to Amendment Pending Approval 

 

 If the Amendment has been submitted from a Funeral Home or Medical Facility the data 
entry will already be complete and the Amendment status set to either Keyed (Requires 
Affirmation) or Pending. 
 
Keyed (Requires Affirmation) status indicates that the Amendment has not been affirmed by 
the Funeral Home or Medical Facility. The Amendment cannot be processed any further until it 
has been affirmed. 
 
Amendment Approval Pending status indicates that the amendment has been affirmed and is 
awaiting review and approval or rejection.  
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4. A new list of values is now available from the Action dropdown. 

Approve: Selecting Approve will set the amendment status to Approved 
and save the corrections to the record. 

Reject to Keyer: Selecting Reject to Keyer will set the amendment 
status to Rejected to Keyer. It will also send the Amendment back to the 
user who originally keyed it for review. The user can then make updates 

and resubmit the amendment for approval. 

Reject Amendment: Selecting Reject Amendment will set the amendment status Rejected 
and the requested corrections will not be saved to the record. 

8.1.7 Amendment Correspondence 

DAVE™ provides the ability to generate correspondences related to amendments.  Upon 
selection of the Correspondence link from the Amendments menu, the Correspondence page 
appears. 

 

The Correspondence page provides the same features described in the Correspondence 
section of this user guide, yet filters the correspondence templates available for selection to 
include only those correspondences where the correspondence template type is amendment. 

 

  

 Further information on sending and receiving Correspondance is be found in section      
8.6 Correspondence. 
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8.2 Assign Status 

A special status assigned to a record serves as an alert mechanism for the person viewing 
and/or issuing the record.  The ability for a user to view and/or edit a special status is based 
on assigned security privileges.  

The special status functionality is primarily used to assign or remove one of the statuses 
referenced in the table below, yet can also be used to assign statuses that are unique to a 
specific jurisdiction. 

Status Description 

Hold Assigned to prevent the issuance of a certified copy 

Void Assigned when it is determined a registered record is a duplicate or invalid 

Abandoned Assigned when it is determined that a non-registered record has been 
orphaned. This status is also assigned by the system when a 
jurisdictionally defined time limit has been exceeded for the submission of 
a record for registration 

 

Steps to Assign a Status 

1. From the Death or Fetal Death Registration Menu, select Other Links > Assign Status. 

2. The Assign Special Status pop-up window will display. Select the New Special Status 
button. 

 

3. Make a selection from the the Status dropdown list.   

 



State of Arizona DAVETM User Guide  

 

  162 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

 
 

4. In this example, Hold has been selected as the status to assign. Notice that Staus and 
Reason are mandatory fields and must be completed.  Once both items are entered, select 
Save to assign the status or Cancel to exit without saving the status to the record. 

 

5. Upon selecting the Save button, the Save and Cancel links are updated to allow the user 
to Edit or Delete the currently assigned status. 

 

EDIT: Selecting Edit allows the user to edit the Reason but not the Status itself. 

 

DELETE: Selecting Delete prompts the user with a warning message. Select OK on the popup 
to clear the status from the record.  

 The status of ‘Void’ is not available until a record is registered.  Once registered, the 
Abandoned status will be removed Status Dropdown.  
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Select the Close button to close the Assign Status pop-up window. 

8.2.1 View Assigned Status 

Upon assigning a special status to a case, it is viewable: 

 - Within the status bar of the registration: 

 

 

- Within the search results, by hovering the mouse over the Decedent or Fetus Name:   

 

 

 

 

- Within the Registration or Order Processing record Preview: 
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A checkmark is also placed next to the Assign Status link in the Other Links section of the 
registration menu to serve as an indicator that a status is assigned to the record. 

 

 

 

 

8.2.2 Delete a Status 

A user’s ability to edit or delete a status is based on the security privileges assigned. To delete 
the assigned status select the Other Links > Assign Status menu option. 

 

The Assign Special Status dialog opens. Select the Delete link. 

 

A warning message appears.  Select OK to delete the status assigned to the record. 
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8.3 Attachments 

The Attachments link allows users with the appropriate security to attach documentation 
submitted in support of a Death or Fetal Deah registration. This is accomplished by scanning 
the document to be attached, selecting the Attachments link, and then uploading the scanned 
documentation to be stored within the Death or Fetal Death Registration. 

 

  

 

Steps to Attach Electronic Documentation 

1. From the Other Links menu, select Attachments. 

 
 

2. The Attachments popup appears.  Select the New Attachment button. 

 
3. The popup expands to display the New Attachment section.  

 

4. Select an Attachment Type from the Dropdown. 

 Only users with appropriate security privileges are able to view, edit, and/or delete 
attachments through the Attachments link. 
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5. Select the Choose File button to open a Windows dialogue box.  

 

6. Select the document to be attached and select the Open button.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The selected file name and path appear in the Upload new attachment field.  Select Save.  

 Any file type may be uploaded to the system, however not all DAVE ™users will have 
access to the same programs on their computer.  Therefore it is recommended that only 
common formats such as MS Office, Adobe PDF, and standard Image file types (.jpg, .png, 
.tiff, etc.) be attached. 
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The Attachments popup displays the file selected. 

 
 

7. Select Save to attach the selected document. 

 

 

The attach document is now uploaded to the Death or Fetal Death record and may be Viewed 
or Deleted. 

 

 

 

 Select Cancel or Close to close out from the selection options without attaching the 
document. 
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8.3.1 View Attachment 

Once a document is attached to a Death or Fetal Death registration a checkmark will be 
displayed next to the Attachments link within the Other Links submenu. 

 

Steps to View Attachment(s) 

1. Select the Attachments link. 

2. The Attachments pop-up will display a list of all attached files. Select View next to the 
attachment you wish to view. 

 

3. The attachment will be download and, depending on the browser, automatically opened to 
view. 
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8.3.2 Delete Attachment 

Steps to Delete an Attachment(s) 

1. Select the Attachments link  

 

2. The Attachments pop-up will display a list of all attached files. Select Delete next to the 
attachment you wish to view. 

 

3. A pop-up will be displayed: “Are you sure you wish to delete this attachment?  Press OK to 
continue, Cancel to abort.”  Select OK to delete the attachment. 

 

The Attachments pop-up will be displayed and the document will have been removed from the 
list. If the attachment removed was the only attachment, the checkmark will be removed from 
the Attachments link as well. 
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8.5 Comments 

Comments can be used to add additional workflow information, detailed information regarding 
data entered, information associated with the need for amendments and corrections, or 
reasons for changes made to user profiles and expirations. Entering comments can be very 
helpful to all users, serving as reminders or instructions to others who might access or work on 
the case, amendment, or user setup.  

 

 

Steps to Add Comment 

1. Select Other Links > Comments. 

 

The Comments popup page appears, displaying the State File Number (if registered), 
Registrant Name, Event Type, and Event Date.  This default information is displayed for 
reference.  

 

2. To add a new comment to a death case, select the New Comment button. The page expands 
to display the Enter New Comment section.   

 The ability to Edit or Delete comments is based on assigned user security privileges. 
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3. Select a Comment Type from the dropdown.   

 

 

4. Enter the comment in the Comment field. Comments are limited to 4000 characters.  A 
running total of the characters remaining is displayed at the bottom of the window.   

 

5. Once a comment has been entered, select the Save button.   

 
 
 
 

Selecting Save will add the comment to the registration. A portion of the comment displays in 
the Comments window.   

 Comment types available vary based on user assigned security privileges. 

 Select Clear to clear the comment text, or Cancel to close the comment window. 
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Select the Close button on the comments popup window. A checkmark appears next to the 
Comments link in the Other Links sub-menu to indicate that a comment has been added to the 
registration. 

 

8.5.1 View Comment 

If a comment exists on a record a Comments icon will be displayed next to its listing within 
the Registration Search Results and any Work Queue Listings the record is included in. 

This icon can be selected and the comment pop-up window will be displayed showing the 
comment(s) which exist on the registration. The user can read any comments that may exist 
for the selected registration without opening the registration. 

This is the same comment pop-up window which can also be accessed from within the 
registration by selecting Other Links > Comments. 
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If the comment is too long it will not be fully displayed in the comment table. To see the full 
text of the comment the user can select the Edit link or allow the mouse to hover over the 
comment text. 

 

8.5.2 Edit Comment 

 

From within the comment, select the Edit link.  

 

The page expands to display the Update Existing Comment page section. The previously 
entered comment can then be updated.  Once the update is complete select Save. 

 The ability to Edit comments is based on user security privileges. 
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Once comments have been edited, select Close to exit the Comments popup. 

8.5.3 Delete Comment 

 

From within the comment, select the Delete link adjacent to the coment. A system message 
prompts the user to press OK to continue or Cancel to abort. 

 

Selecting OK will remove the comment from the registration. Selecting Cancel will return the 
user to the comment pop-up window without making changes.  

 The ability to Delete comments is based on user security privileges. 
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Once comments have been deleted, select Close to exit the Comments popup. 

8.6 Correspondence 

The registration Correspondence feature uses MS Word merge-field templates that can be 
system-filled with specific information from a registration.  For example, a correspondence 
template may be created to query the medical certifier in regards to the cause of death specified 
on the record.   

The Correspondence feature allows selection of a specific template which is then system-filled 
with information specific to the registration. A MS Word document is presented to the user who 
selected the template. Any changes made and saved to the document itself will also be saved 
with the registration ensuring that all correspondance sent in regards to the registration can be 
recalled and reviewed if needed. 

 

 

Steps to Create Correspondance 

1. From the Death Registration Menu, select Other Links > Correspondence. 

 

The Correspondence - Registration popup opens.  

 

 

 

 

 For information on updating or adding new Correspondence Templates, please refer to 
the Correspondence Update section in the Table Maintenance User Guide. 

 An add-in for MS Word may needed to take advantage of the full functionality of the 
correspondence feature.  See section 8.6.1 Install Correspondence Add-In for steps to 
install this add-in.  
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2. Select the New Correspondence button.  

The New Correspondence – Registration popup displays with a list of the correspondence 
templates available.  . 

 

3. Select the correspondence template.  

 

The selected template appears in the data grid on the Correspondence popup.  
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4. From the column labeled ‘File’ in the Correspondence data grid, select the Download link to 
download an available correspondence template.  

Once downloaded, and depending on browser, the selected template may open automatically 
or the user may be prompted to select to open it.   

The MS Word template will then be displayed. The fields specified by the template wll be auto-
populated with record-specific data from the specific regsitrtaion. Since it is a MS Word 
document, depending on the security level set in regards to the template itself, more 
information can be added, or current information can be edited. The template can then be 
saved to the registration. Once the correspondence is complete, it can be printed and mailed. 

Once correspondence has been added to a record, select the Close button on the 
correspondence popup. A checkmark appears next to the Correspondence link in the Other 
Links sub-menu. 

  

 Reject Reasons 

Some Correspondences are created based on a need to reject information submitted for 
the specified registration. In these instances a listed of Reject Reasons will be displayed for 
the correspondence.  

Use the checkboxes to select a rejection reason to add to correspondence. Multiple reasons 
may be selected. At least one Reject Reason must be selected before the template will be 
displayed in the Correspondence data grid. 
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8.6.1  View Correspondence  

To view correspondence that is currently attached to a registration, select the 
Correspondence link from the Other Links submenu. 

A data-grid list of correspondence(s) currently attached to the registration will be displayed. 
Select Download to view any of the correspondence documents. 

8.6.2 Delete Correspondence 

If a Correspondence should no longer be associated with a record, or a mistake was made, 
select the Delete link beside that correspondence. 

 

Select OK on the popup. The Correspondence will be removed from the case. 

8.6.3 Install Correspondence Add-In 

A one-time install of a MS Word Add-In is needed for the full features of the system 
correspondence feature to be utilized. 

 
 

To Install Add-In 

1. From the Correspondence pop-up select either the 64 or 32 bit ‘Correspondence Add-In 
for Word’ link. 

 

 A system administrator may be needed to authorize the install. 
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Depending on the browser being used, the CorrespondenceSetup.exe file will either 
automatically be downloaded or the user will be prompted to select to either ‘save’ or ‘run’ it 
directly. 

2. Run the CorrespondenceSetup.exe 

 

The DAVE Correspondence install wizard will be displayed. 

3. Select Next 
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4. Select Install 

The setup wizard will step through the installation process. Upon completion, select Finish to 
close the install wizard. 

 

8.7 Cremation Clearance 

Cremation Clearance approval is required in all cases in which the method of disposition, for 
a death or fetal death, is cremation. In these cases a Funeral Director will send a request for 
cremation clearance authorization to the Medical Examiner or Tribal Authority responsible for 
the county in which the death occurred. In some cases, a Medical Examiner may start the 
death or fetal death record and can pre-authorize cremation clearance. 

8.7.1 Request Cremation Clearance 

From the Other Links menu, within either a Death or Fetal Death record, select the 
Cremation Clearance link. The Cremation Clearance page will be displayed. 
 

 
 

Office Name:  The LOV lookup control must be used to search for and select a Medical 
Examiner office to send the Cremation Clearance request to. Once selected the Lookup 
Medical Facility pop-up will be displayed: 
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Simply enter a % in the Facility Name field and select search to return a list all available 
Medical Examiner or Tribal Authority offices which serve the County of Event. 
 

 

Select the Facility from the Search results. 
 
Medical Examiner: If the Medical Examiner who will be reviewing the record and processing 
the Cremation Clearance Request is not known, then this field can be left blank. Medical 
Examiner name is not required to send the Cremation Clearance Request. If the Medical 

Examiner is known, select the  lookup control next to Medical Examiner. 
 
The Lookup Examiner pop-up will be displayed: 
 

 
 
Enter the Last Name of the Examiner you wish to send the request to and select Search. 
 
 

 

Select the name of the Medical Examiner the Cremation Clearance Request should be sent 
to and it will be populated on the Cremation Clearance page. 

 The Lookup Medical Examiner Office is filtered by County of Event, only those Medical 
Examiner or Tribal Authority offices which serve the County of Event will be returned in 
the Search Results.  
 
If only one Medical Examiner Office is associated to the County of Event, this office will 
auto-fill in the Office Name field and the LOV lookup controls shall be hidden. 

 % Wildcard can be used in the Lookup Examiner Last Name and First Name fields.  
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Cremation Clearance Status: The Status should be selected from the dropdown.  
 

 
 
For Funeral Home and State and County users, the only option available will be Request. As 
these user make request of the Medical Examiner to review and approve Cremation 
Clearance. 
 
For Medical Examiner and Tribal Authority users the options available will be Approved and 
Not Approved.  
 
ME Case Number: If known, the ME Case number should be entered into this field. 

Cremation Clearance Authorized By: The First, Middle, and Last Name fields for the 
Cremation Clearance Authorized By will be system filled based on the Medical Examiner who 
Approves or does Not Approve the request for cremation. 
 
Cremation Reject Reason: If the Medical Examiner selects Not Approved from the 
Cremation Clearance Status, the Cremation Reject Reason is required to be entered. What 
should be entered is the reason why the Medical Examiner chose not to approve the request. 

 

There are three action buttons in the bottom left of the Cremation 
Clearance page. 

Clear: Selecting this button will clear all entries made on the page. 

Save: Selecting this button will save and apply the Cremation Clearance status to the record. 
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When Cremation Clearance Status’ are saved they are displayed on the Disposition page, 
under the selected Method of Disposition. 
 
As well, the status is also displayed in the Status Bar of the record. 
 

 

Return: Selecting this button will return the user to the previous Death or Fetal Death 
registration page they had taken action on. 
 

8.7.2 Pre-Authorize Cremation Clearance 

In some cases the Medical Examiner will initiate the Death or Fetal Death record in DAVE™. 
In these cases the Medical Examiner can opt to pre-authorize cremation clearance by 
selecting the Pre-Authorize Cremation Clearance checkbox on the Certifier page. 
 

 

Once selected, if the Method of Disposition is a type that requires cremation, then the 
Cremation Clearance page will be displayed. All fields will be system-filled with the Medical 
Examiner information who pre-authorized the cremation clearance. 
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As well, the Cremation Clearance Status shall be set to Approved. The Approved status will 
be displayed on the Disposition page, under the Method of Disposition, and within the Status 
Bar of the record itself. 

 
 
All fields on the Cremation Clearance page will be greyed out and disabled as there is no 
processing that needs to occur. 

 

8.8 Disinter-Reinter Permit 

In some instances the decedent remains may be disinterred for examination and then 
reinterred. For these instances DAVE™ includes disinter-reinter permitting functionality.  
 
The disinter-reinter permit is created from within a registered death registration record within 
DAVE™. The information within the permit is completed by State or Local users who can 
print the permit themselves or select to send the permit to the Funeral Home handling the 
disinterment process to print. 

8.8.1 Create Disinter-Reinter Permit 

To create a disinter-reinter permit first the Disinter/Reinter checkbox must be selected on the 
Identifiers page. Once the checkbox selection is made the Save button is selected. 
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The Disinter/Reinter link will be displayed in the Death Registration menu within the Other 
Links section. Select this link to display the Disinter/Reinter page. 
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 Funeral Director Responsible & Funeral Home Handling Disinternment:  There are 
three ways to complete the Funeral Director/Funeral Home information.   

1. Manual entry of each item; 

2. The Funeral Director License Number and auto-populate  icon; or 

3. The standard LOV Lookup controls  
 

Steps for using Funeral Director License Number to complete  

1. Enter a Funeral Director’s License Number    
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2. Select the auto-populate icon  

The system will then auto-populate the Funeral Director name and the associated Funeral 
Home information. 

 

Steps for using the Standard LOV Lookup to complete 

1. Select the LOV lookup tool  to search for a funeral director. 

2. Enter in the Last and First Name of the funeral director; if known.  If not known a wildcard 
search can be performed by entering at least two characters in the Last name field followed 
by the percent sign (%). 

 

 

 

 

 

 

 

3. From the Search Results List, select the Select link next to the correct Funeral Director. 

The system will then auto-populate the Funeral Director name and the associated Funeral 
Home information. 
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Date of Disinterment: Enter the Date of Disinterment manually or select the Calendar  icon 
to launch the Interactive Calendar. 

Name of Authorizing Agent or Court Name: Enter the name of the Authorizing Agent or the 
name of the Court which authorized the disinterment. 

Relationship to Decedent or Court Order Number: Enter the Relationship of the Authorizing 
Agent or the Court Order Number provided by the authorizing court. 

Date Approved by Authorizing Agent/File Date: Enter the Date Approved by Authorizing 

Agent or the File Date of the court authorization manually or select the Calendar  icon to 
launch the Interactive Calendar. 

Method of Disposition: Select the Method of Disposition for the reinternment from the list of 
values. If the Method is other than what is available in the list, select Other, Specify and then 
enter the Method on the Other Specify field. 

 
Location Reintered or Cremated: 

If Other (specify) is selected from the Method of Disposition dropdown, the facility name. 
(if known or applicable), and address fields should be manually entered. The facility name field 
can be left blank. 

Auto-population of the Funeral Home data will occur only if the Funeral Director 
selected is associated with a single funeral home. If the Funeral Director is associated 
with multiple funeral homes, the correct funeral home data must be manually entered 
or searched for and selected. 
 
To search for a funeral home 

1. Select the Funeral Home LOV lookup tool   
2. In the Facility Name field enter the full name of the facility or use a wildcard search 
by entering the first two letters followed by a % and selecting search 
3. Select the correct funeral facility from the search results list and the system will 
auto-populate it on the page. 
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For all other Method of Disposition dropdown selections,the Location Reintered or 

Cremated can be entered manually or the LOV Lookup  icon can be used to launch the 
Lookup Place of Reinternment search tool. 

Steps to Use the Location Reintered or Cremated Lookup 

1. In the Faclity Name field, if known, enter the full name of the facility and choose Search.  

 
 

If the full name of the facility is 
not known, enter at least two 
letters followed by the %, 
then select search to perform 
a wildcard search.  

 
 

2. A list of available facilities will be returned. Select the Select link next to the correct facility 
in the list.  

 

 

 
The selection system-fills all of the corresponding fields for Place of Death on the Place of 
Death page. 

 

Cemetary or Crematory Manager’s Name: Enter the name of the Cemetart or Crematory 
Manager where the remains will be reintered. 

Once the Disinter page is complete, select a navigation button at the bottom of the page: 
 

 

Selection of the Validate Page button to check the page for errors, the Clear button to clear 
all entries since the last save, the Save button to save changes without leaving the page, or 
the Return button to return to the last page in which action was taken. 

 Facilities not listed in the LOV lookup tool can be entered by typing the Facility Name 
and address information manually.  All out-of-state records will contain non-listed facilities. 
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8.8.2 Print Disinter-Reinter Permit 

To access the Disinterment Permit select the Print Forms link from the Other Links within the 
Death Registration menu. 
 
 
 
 
 

Once the Disinter/Reinter page is completed and the Save button has been selected, the 
Disinterment Permit will be enabled to print from the Print Forms page. 

 

There are two options available: 
 
1) Print the Disinterment Permit 
 
Select the Disinterment Permit link and a PDF of the permit will be displayed to print. 
 
2) Send the Disinterment Permit 
 
Selecting the Send link next to the Disinterment Permit will send the permit to the Funeral 
Home listed on the Disinter/Reinter page. This allows a user at the select Funeral Home to 
directly print the Disinterment Permit. 

8.9 Event and Issuance History 

DAVE™ performs extensive auditing and logging of all actions, changes, extracts, 
amendments, orders, and issuances that occur for all Death and Fetal Death registrations. The 
Event and Issuance History page allows the user to review these registrations audit logs.   

Steps to View Event & Issuance History 

 If the information on the Disinter/Reinter page is not complete, the Disinterment Permit 
will not be available to print.  
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From the Death or Fetal Death Registration Menu, select Other Links > Event and Issuance 
History.  

The Event & Issuance History page displays a listing of activity associated with the selected 
death or fetal death record.  

 

 

Within the Event and Issuance History page, the activities auditied and logged are filtered into 
7 categories: Actions, Issuances, Amendments, Audit Logs, Change Logs, Extracts/Loads, and 
Orders 

 

The default setting selects all Include in List checkboxes so that all logged activities are 
displayed.  Results can then be filtered based on user preference by de-selecting checkboxes. 
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If a user does not have the security rights for a certain event or issuance history type, the 
associated checkbox is hidden and that type is filtered from the list. 

If the registration does not include any of the selected events or actions, the Event & Issuance 
History page will display “No data found.”  For example if no amendments have been made to 
the registration and only the Amendments Include in List item is selected the following will 
display: 

 

Actions: The Action Detail displays action taken on the record, the user who performed the 
action, the office the user was logged into, and the date and time the action took place.  

 

Issuances: Issuance Detail provides information related to the issuance of certified copies or 
other services.  This information includes the order number, service, security paper number, 
user, issuing office, date and time printed, etc.  

 

Amendments: Amendments Detail displays the information in regards to amendments made 
to the registration. Detail such as when the amendment was made, the status of the 
amendment, and the date it was completed or rejected.   
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Audit Logs: Audit Transaction Detail displays information regarding the DAVE™ database 
table that was affected by actions taken on the registration. The Old Value and New Value are 
displayed in the data grid listing in regards to the Table and Column affected in the database. 

 

Change Log: Change Log Detail displays changes made to field values within the registration. 
The user who made the change, date and time the change was made are displayed along with 
a grid showing the item changed, and old and new values. 

 

Extracts/Loads: 

Extracts/Loads displays any extracts and loads in which the registration was included. 
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Orders: Order Detail displays the information on orders processed in regards to the record. 
The order number, current order status, the user that last updated the order, the issuing 
office of the order, the date and time that the order was requested along with the order status 
history are displayed. 

 

8.9.1 Archiving Event and Issuance History  

The Event & Issuance History can be configured to archive at regular 30 day intervals. Once 
archiving has occurred, the user can review the Event and Issuance History without having to 
sort through older data. Archive data can be retrieved if needed. 

To retrieve archived data, select the Restore Archive notification button located at the top of 
the Event & Issuance History page following the statement: “Some or all history for this record 
has been archived.” 
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Upon selection of the Restore Archive button, the button will be removed and the following 
message displayed: 

 

Once the archived data is retrieved, an internal system message and external email will be 
sent to the user informing them that the data has been restored and is available for review. 

Once the archived data is retrieved, the Restore Archive button is no longer displayed and the 
Total Records count, located at the bottom of the Event & Issuance History page, will have 
increased. 

 

 

 

 

 

 

Before Archive Restore  

After Archive Restore 
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8.10 Geo Codes 

Geocoding is the process of converting an address into geographic coordinates, referred to as 
GEO Codes.  Geocodes facilitate population analysis to determine geographic health statistics, 
monitor the spread and outbreak of virulent disease, and perform mortality analyses for a given 
area or region. Geo Codes are also often used to ensure more efficient distribution of 
resources, assignment of personnel, and budgetary allocations. Some State registrars and 
other state agencies even use GIS technology to assign GEO codes to improve the 
determination of the geographic distribution of vital events.  

 

 

From the Other Links sub-menu within a Death or Fetal Death registration select the Geo-
Codes link. 

 

Death Registration Geo Codes 
There are four sections related to a death registrations GeoCodes page: Decedent Birthplace, 
Residence Address, Place of Death Address, and Place of Injury Address.  

 The ability to access the Geo Codes page is based on user security privileges. 
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Fetal Death Registration Geocodes 

There are four sections related to fetal death registrations GeoCodes page: Mother’s 
Birthplace, Father’s Birthplace, Mother’s Residence Address, and Place of Delivery Address.  
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The DAVE™ application auto-populates most of the controls on the Geo Codes page. This 
information is auto-populated based on the location information that is completed within the 
registration pages which contain these fields.  If no information is entered on these pages the 
fields on the Geo Codes page will not be auto-populated. 

If a value entered for a location control is not in the place LOV (such as rural areas where the 
place name is a village or is unincorporated), there would be no code assigned by the system.  
In cases like this, the user should manually enter the valid code in the necessary fields.  

 

 

Once codes have been verified and/or entered, select the Save button to save all GIS 
information for the death registration case. 

 It is important to review all system filled entries and enter any missing codes. Incomplete 
addresses will trigger error messages and prevent Geo-Coding. 
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8.11 Multiple Race and Ethnicity (MRE)  

DAVE™ contains MRE (Multiple Race and Ethnicity Codes) pages within the death and fetal 
death registrations. The MRE page serves as a checklist of statistical data and is used to collect 
and display data on race and hispanic origin . The MRE codes are provided by NCHS and the 
State.  

 

Death Registration - Decedent’s MRE 

From the Death Registration Menu choose Other Links > Decedent’s MRE.   

 

The selections in the Ancestry and Decedent’s Race sections are system-filled based on 
entries made on the Decedent Attributes page and are unavailable to edit.  
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When the MRE load file is received from NCHS the MRE page will be updated with the 
corresponding Hispanic and Race codes. 

Users with the appropriate security permissions are able to view and edit the Multiple Race 
and Ethnicity (MRE) load data including the Decedent’s selected race(s), and the 
corresponding race code(s).  

Fetal Death Registration – Mother and Father’s MRE 

From the Death Registration Menu choose Other Links > Mother’s MRE or Father’s MRE. 
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The selections in the Ancestry and Decedent’s Race sections are system-filled based on 
entries made on the Mother and Father Attributes pages and are unavailable to edit.  

When the MRE load file is received from NCHS the MRE page will be updated with the 
corresponding Hispanic and Race codes. 

Users with the appropriate security permissions are able to view and edit the Multiple Race 
and Ethnicity (MRE) load data including the Decedent’s selected race(s), and the 
corresponding race code(s).  
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8.12 Request Medical Certification 

Request Medical Certification assigns the ownership of the Medical Information to the selected 
medical facility. 

 

 

Steps to Request Medical Certification 

 
1. From the Death Registration Menu select Other Links > Request Medical Certification 

 

The Request Medical Certification page will display 

 

2. Select the Lookup icon  next to Certifier Name to access the Lookup Certifier page. 

3. Enter in the Last and First Name of the certifier; if known.  If not known a wildcard search 
can be performed by entering at least two characters in the Last name field followed by the 
percent sign (%). 

 

 The Request Medical Certification link is available based on user security privileges 
and is suppressed if the case already has a medical owner.  
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4. From the Search Results List Select the link next to the correct Certifier. 

 

 

 

Selection of a certifier will close the LOV search page and populate the certifier’s name fields 
on the Request Medical Certification page. 

 

5. Select the Lookup icon  next to Faciity/Office Name to access the Lookup Medical 
Facilities page. 

6. In the Faclity Name field, if known, enter the full name of the facility and choose Search. 

 

 

 

 The list of certifiers available from the Certifier Lookup dialog box will be filtered to 
include only those data providers that have been configured to sign death certificates and 
are valid (i.e., current) users of the DAVE™ application.   
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If the full name of the 
facility is not known, enter 
%, then select search to 
perform a wildcard search. 

 

 

 

 
 
 
7. A list of available facilities will be returned. Select the Select link next to the correct 

facility in the list. 
 
Selecting a facility will close the LOV search page and populate the Office name in the 
Certifier Information section of the Request Medical Certification page. 

 

8. The Message text entry box is system-filled with information related to the case and the 
request for medical certification. Additional information may be added if needed.  

9. Once all items are completed select the Save button to save changes and forward the 
request the selected certifier.  

When Save is selected: 

 The Request Medical Certification page refreshes with all fields disabled except the 
Return button.  This allows the user to review the message sent while simultaneously 
preventing the user from inadvertently saving and sending a new message. 

 An internal message and external email requesting medical certification are sent to the 
physician and facility to which the request is being made.  
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 The ownership of the Medical Information is assigned the medical facility to which the 
request was selected to be sent. 

 A status of “Medical Certification Requested” is assigned to the record. 

 

 

8.13 Refer to Medical Examiner 

In most jurisdictions, any death that is thought to be the result of an accident, suicide, homicide 
or any death that occurred in a suspicious or unusual manner, must be referred to a medical 
examiner (ME) . The Refer to Medical Examiner feature is used by funeral directors, medical 
data providers, and vital record offices to refer such deaths to a medical examiner. 

Additionally, DAVE™ edit rules check the cause of death entries for “referral” terms that may 
require review by an ME. Referral terms are terms such as accident, trauma, fall, poisoning, 
etc.  When an edit rule fails due to the use of a referral term, an error message will be displayed 
advising that the case should be referred to a medical examiner.   

 

 

From the Death Registration Menu, select Other Links > Refer to Medical Examiner.  

 

The Refer to Medical Examiner page will display and the County field will be pre-filled according 
to the county listed on the Place of Death page.   

 Access to the Refer to Medical Examiner page is dependent upon user security 
privileges. 

 The Refer to Medical Examiner link will be hidden 
from funeral home users and medical data providers if 
the case has a status of Registered or Dropped to 
Paper.   

 Selecting Clear will clear all information that has been entered on the page. 
     Selecting Return will return the user to the last page they took action on. 
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Select the LOV lookup tool  to search for the medical examiner office. 

1. In the Faclity Name field, enter the full name of the facility, if known, and select the Search 
button.  

If the full name of the 
facility is not known, 
enter at least two 
letters followed by 
the %, then select 
search to perform a 
wildcard search. 

 

2. A list of available facilities will be returned. Select the Select link next to the correct facility 
in the list. 

The selection system-fills the office selected on the Refer to Medical Examiner page. 

 

The message displayed is system filled and contains information related to the case being 
referred. The user making the referral may add additinonal information if needed. 

Once all items are completed, selecting Save will: 

 Assign a Referred to ME and ME Review Required status to the case. 

 Send an internal message and external email to the selected Medical Examiner office.  
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 Disable all fields on the Refer to Medical Examiner page to prevent a duplicate 
message from being sent.  

  
 

 

8.14 ME Review Case 

The ME Review Case page is used by the Medical Examiner to Accept or Decline ownership 
of the referred death record.  

1. From the Death Registration Menu select Other Links > ME Review Case.  

On the ME Review Case Page, the Referral Action and ME Case Number are marked with red 

arrows  indicating required fields.  

2. Make a selection from the Referral Action dropdown and enter an ME Case Number. 

 

Referral Actions 

Accept Referral is used when the ME decides to take ownership of the medical information. 
If Accept Referral is selected from the Referral Action dropdown, selecting the Save button 
results in the following:  

 An Under ME Review status is assigned to the case. 

 DAVETM prevents updates to the medical information by the original medical owner by 
assigning medical ownership to the ME user. 

 If the case has a Certified status, the status will be changed to Uncertified. 

 Selecting Clear will clear all information that has been entered on the page. 
     Selecting Return will return the user to the last page they took action on. 
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 If the current user is a medical examiner, the certifier and pronouncer information 
(name, license number address, etc.) will be replaced with the corresponding values 
for the current ME user. 

 If the current user is a medical examiner office user but not a medical examiner, the 
certifier and pronouncer information (name, license number address, etc) will be set to 
null or blank. 

 Upon successful certification, DAVETM will remove the Under ME Review and the ME 
Review Required Work Queue statuses. 

 The Medical Examiner facility now owns the Medical Information of the death record 
and can edit the medical pages and certify the cause and manner of death. See section 
4.6 – Death medical Information Pages for more nformation. 

Decline Referral is used to refuse ownership or control of a record. If Decline Referral is 
selected from the Referral Action dropdown, selecting the Save button will result in the 
following:  

 The case will be assigned a Referral Declined status. 

 The ME Review Required Work Queue status will be removed. 

 If the registration has a Hold special status, the work queue status ME Review 
Complete will be added. 

Pending is used when the ME determines that additional discussion is needed with the 
referring party before making a determination on the case or when the cause of death is 
incomplete. If Pending is selected from the Referral Action dropdown list, selecting the Save 
button will result in the following: 

 The case will be assigned an Under ME Review status. 

 The ME/Coroner will indicate in the comment the reason the case has been assigned 
a pending status.  Once the ME/Coroner has consulted with the certifier, the ME will 
update the Pending status. 

 Medical ownership of the case will not change 

 The medical information is not locked, however the case cannot be certified until the 
Pending status is changed to Accept Referral or Decline Referral which removes the 
Under ME Review Status. 

Take Control of Case is used when the ME  is not the medical owner of the case, but 
determines that the case falls under ME jurisdiction.  Once the ME user accepts or “takes 
control of a case,” then he/she is responsible for completing and certifying the medical 
information. If Take Control of Case is selected from the Referral Action dropdown, selecting 
the Save button will result in the following:  

 The Under ME Review status will be assigned to the case. 
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 The DAVETM application will prevent updates to the medical information section by 
changing the ownership of the case to the ME user. 

 The certifier information (name, license number address, etc.) will be replaced with the 
corresponding values for the current ME user.   

 A status of Uncertified will be assigned to the case if the registration was previously 
certified. 

 When the ME certifies the record, the following ME Referral statuses will be removed:  
Under ME Review and the ME Review Required Work Queue. 

 The medical information section will be set to null and the original medical information 
will be stored in event history.  

Overall, when the Save button is selected, DAVE™ sends messages to update the referring 
party, medical owner, and personal owner of the record as to the Referral Action taken on the 
record: 

 An internal message is sent to the medical owner of the case (all users of the office 
associated to the medical owner office will be able to see the message). 

 An internal message is sent to the personal owner of the case (all users of the office 
associated to the personal owner office will be able to see the message). 

 An internal message is sent to the user who referred the case if the user is not 
associated with personal owner office or medical owner office. 

 An external message is sent to the user that referred the case. 

 

8.15 Nosology 

Nosology is the science of classifying diseases. It is used extensively in public health to allow 
epidemiological studies of public health issues. Analysis of death certificates requires the 
coding of causes of death. Each cause or condition listed in the cause of death section of the 
death certificate is assigned an International Classification of Diseases (ICD) code.   
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In the DAVETM application, these codes are displayed on the Nosology page.   

From the Death Registration Menu, select Other Links > Nosology.  

The Nosology page displays. If no data is present, the fields may be completed manually. 
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The Nosology page will typically be system-filled by the NCHS Transax load. However, all 
fields can be manually edited if needed.   

To complete the Nosology page, enter valid ICD codes in the ICD Codes tab. When all changes 
and/or entries are complete, select the Save button to record the values entered. 

 

8.16 Order Certified Copies 

Part of the service a funeral home provides is obtaining certified copies of death and fetal death 
certificates for the decedent’s family.  Funeral home users can use the DAVETM order 
processing module to electronically submit a request for certified copies for cases for which 
they are responsible.   

 

 

There are four Order Processing pages that must be completed for a funeral home to submit 
an order: Applicant, Services, Payments, Summary. 

 

Refer to Order Processing section 10 for detailed instructions on completing these pages. 
 

8.17 Print Forms 

The Print Forms page within DAVE™ allows users to print 
registration-related documents such as working copies, vault 
copies, etc.  

From within the Death or Fetal Death record select Other 
Links > Print Forms to access the Print Forms page. 

 

 

 
 

 Access to the Order Certified Copies page is restricted based on user security 
privileges and is only available to Funeral Home users. 

 Access to the various print forms is determined by 
both user security setup and the statuses assigned to the 
registration. 
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Below are examples of some of the types of print forms that may be available. Disabled links 
are accompanied by a message explaining why the corresponding form is not available for 
printing. 

 

Selecting an available print form, such as the Working Copy displayed in this example, will 
launch the File Download window. Select Open to launch the pdf. 

 

8.18 Relinquish Case 

Relinquish Case  is used to surrender control of a case so that another facility may assume 
ownership.  For example, if two family members start services for the same decedent at 
different funeral homes, the funeral home that owns the record would need to relinquish 
ownership of the Personal Information to allow the correct funeral home to access to the record. 
(Transfer Case may also be used to accomplish this same task. See Section 8.18– Transfer 
Case for more information.)  

Steps to Relinquish Case 
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1. From the Registration Menu select Other Links > Relinquish Case. 

2. On the Relinquish Case page, select OK to surrender ownership, or Cancel to retain 
ownership of the record.  

 
Once Ownership is relinquished the user will be returned to the DAVE™ homepage and will 
no longer have access to that particular registration. 

 

8.19 Transfer Case  

From time to time, it may be necessary for a facility such as a Funeral Home or Hospital to 
transfer their ownership of a case to another similar facility.  For example, if the decedent had 
multiple survivors, and burial arrangements were inadvertently made at multiple sites, one of 
those sites might need to transfer ownership of the case. Once the case is transferred, 
ownership is changed and any actions the previous owner took within the record is retained in 
Event and Issuance History.  

 

 

Steps to Transfer Case 

1. Select Other Links > Transfer Case.  

 The Transfer Case link is disabled on records with a status of Registered.  
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2. The Transfer Case presents two options: Transfer Personal Ownership To and Transfer 
Medical Ownership To. The user type determines which transfer checkbox is enabled.  For 
example, a funeral director may only transfer personal ownership while a medical certifier 
may only transfer medical ownership.  

If the owner is the personal owner only The Transfer Medical Ownership field will be disabled.   

If the owner is the medical owner only The Transfer Personal Ownership field will be disabled. 

If the owner is both the personal and medical owner Both Transfer fields will be enabled. 

If the user is a state office user The Transfer Personal Ownership and Transfer Medical 
Ownership links will be enabled based on whether the 
case has an existing Personal or Medical Owner.  

 

Regardless of the type of ownership being transferred the steps are the same. In the example 
steps below we will transfer personal ownership. 

3. To transfer ownership, place a checkmark in the box next to the ownership type to be 
transferred.  

 

4. Select the LOV lookup tool  associated with the type of ownership to be transferred.  The 
Lookup office to transfer window is displayed. 
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5. In the Faclity Name field, enter the full name of the facility, if known, and select the Search 
button. 

If the full name of the 
facility is not known, enter 
at least the first two 
letters followed by the 
%, then select search to 
perform a wildcard search  

 

 

6. A list of available facilities will be returned. Select the Select link next to the correct facility 
in the list. 

7. The selection system-fills the funeral home name on the Transfer Case page.  

 

8. The Message text entry box is pre-filled with information relevant to the case being 
transferred. Additional information may be added if needed.  

9. Once all items are completed select the Save to transfer the case. Once transferred the 
user will be returned to the home page and will no longer have access to the record. 

When Save is selected: 

 Ownership of the Personal or Medical Information is transferred from the facility that 
performed the transfer to the facility selected. 

 An internal message will be sent to the facility to which the record has been transferred 
to. 

 If the office is receiving ownership of the personal information:  

On the Disposition page, the funeral home office and address will be system-filled with the 
office name and address of the office selected. 

On the Disposition page the funeral director information will be cleared. 
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If the record was signed, the signed status will be removed and the date signed will be cleared. 

 If the office is receiving ownership of the medical information: 

On the Certifier page the certifier name will be cleared.  

On the Certifer page the certifier address will be system-filled with the address of the office 
selected to receive the transfer. 

If the record was certified, the certified status will be removed and the date certified will be 
cleared. 

 

 

8.20 Trade Calls 

A trade call occurs when one funeral home acts as a broker for another funeral home, 
frequently one that is out of state.  

The Trade Calls page in the DAVE™ application supports the trade calls practice by allowing 
dual ownership of death records.  Users from either funeral home will be granted the same 
security access to the case with the exception of the funeral director and funeral home fields 
located on the Disposition page.  
 

 

 

 

 

 

 

 

 

 

 

Steps to Set-up the Trade Call 

1. From the Death Registration Menu select Other Links > Trade Calls. 

 The ability to select the Trade Calls link is based on user security privileges and is 
generally restricted to Funeral Directors only.   
 
The Trade Call link is disabled when the record has a status of signed.  

 Key points concerning the Trade Calls page: 

 The funeral home responsible for Disposition should start the record in DAVE™   
and initiate the Trade Call. 

 The funeral home on the Trade Calls page cannot change the funeral home listed 
on the Disposition page. 

 

 Selecting Clear will clear all information that has been entered on the page. 
     Selecting Return will return the user to the last page they took action on. 
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The Trade Calls page displays.   

 

2. Select the Lookup icon  next to the Funeral Home Lookup field to launch the 
Lookup Funeral Home window. 

3. In the Faclity Name field enter the full name of the facility, if known, and select the 
Search button. 

If the full name of the 
facility is not known, 
enter the first two 
letters, a percent 
sign (%), then 
select search to 
perform a wildcard 
search. 

 

 

4. A list of available facilities will be returned. Select the Select link next to the correct 
facility in the list. 



State of Arizona DAVETM User Guide  

 

  218 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

The selected funeral home information will be auto-populated on the Trade Calls page. 

5. Select the Lookup icon  next to Funeral Director Lookup to access the Search 
Funeral Directors page. 

 
6. Enter in the Last and First Name of the certifier; if known.  If not known a wildcard 

search can be performed by entering at least two characters in the Last name field 
followed by %. 

 
 

7. From the Search Results List select the link next to the correct Funeral Director. 
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The selected funeral director information will be populated on the trade calls page. 

 

  

 

To complete the Trade Calls page, select Save to save changes and complete the trade. If 
both funeral homes use DAVE, they will now share ownership of the personal information. 
Allowing both funerl homws to have access to work on the record.   

 

 

 

8.21 Switch User 

Many processes performed in the registration and issuance of vital events requires 
participation by multiple individuals with different roles and security privileges.  In order to make 
the processes more efficient, DAVE™ shall provide the ability to allow users to switch users 
without exiting the application.  

Examples of user accounts that are commonly switched are as follows: 

• Funeral home clerk to funeral home user and vice versa 

• Medical facility clerk to medical certifier and vice versa  

• Order processing clerk to order processing supervisor  

• Amendment clerk to amendment supervisor 

From the Other Links sub-menu, select the Switch User link. 

 If either the Funeral Director or Funeral Home are out-of-state, the information can be 

manually keyed rather than selected using the  lookup tool.  

 Selecting Clear will clear all information that has been entered on the page. 
     Selecting Return will return the user to the last page they took action on. 
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The Switch User login page displays. 

 

 

The user temporarily signing in will enter their user name and password.  If the user name and 
password are valid, DAVE™ will switch the login to that of the new user while remaining on the 
same page as the previous user. 

 

 

Exceptions to the information and page that displays after a switch occurs: 

1. If the user being switched to is not associated to the same office as the current user an 
eror shall be displayed: “Switch to user must be in the same office as current user.” 

2. If the user being switched to does not have the required security access to view the same 
registration, an error shall be displayed:  “Switch user is unable to load this registration as 
you do not have permission to access it.” 

3. If the user being switched to does not have the required security access to view the same 
order, an error shall be displayed:  “Switch user is unable to load this order as you do not 
have permission to access it." 

 

 The user being switched to must be a user who is associated to the same office as the 
current user. 
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4.  If the user being switched to does not have the required security access to view the 
currently displayed registration page the following pages will be displayed instead: 

 

 

5. If the account of the user being switched to has expired, an error shall be displayed: 
“Cannot switch users. Password has expired or requires changing.” 

 

9. Registrar Information 

9.1 Identifiers 

The Identifiers page is used to store and display registration-related information accessible 
only at the state level.  Some fields on the page may be system-filled as the case is processed 
and registered in DAVE™. Some fields may be edited manually. 

 

 

From the Registrar sub-menu select the Identifiers page: 

 

 

 

 

 

 

 

 

 

 

 

 

Death Decedent Page 

Fetal Death Fetus  

Death Identifiers Page 
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Shared Identifier Page Fields 

Record Source is set when a case is started in DAVE™. A Record Source of Paper indicates 
that the State or County office completed the record from a piece of paper received. A Record 
Source of Electronic indicates that a funeral home, medical facility, or medical examiner started 
the record and it was completed electronically. 

State File Number and File Date are automatically assigned and system-filled once a case 
has been registered. These items are typically automatically completed, but user’s with 
appropriate security privileges assigned can edit these fields. 

The Out of State Death or Out of State Fetal Death checkbox and Out of State File Number 
are selected and completed when the record is an Out of State Record. These items are 
typically automatically completed, but user’s with appropriate security privileges assigned can 
edit these fields. 

The folllowing items are system-filled when the record information is pulled and included in any 
of the related extract jobs: NCHS Extract Date, SSA Extract Date, Interstate Exchange 
Extract Date, STEVE Extract Date, Refresh Report Extract Date. 

The Interstate Exchange Printe Date is system-filled when an Interstate Exchange record 
has been printed for the selected case.  

Date Disposition Permit Printed is system-filled with the date the permit is printed.  Number 
of Permits Printed is system-filled and indictaes the number of disposition permits printed. 
Disposition Permit Number is system-filled and indicates the number assigned to the permit. 
These items are typically system-filled, but users with appropriate security privileges can edit 
these fields. 

Identifier Page Fields Related to Death Only 

The folllowing items are system-filled when the record information is pulled and included in any 
of the related extract jobs: Super-Micar Extract Date, Insterstate Roster Extract Date. 

Fetal Death Identifiers Page 
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The Local Registration Number may be entered manually or system-filled.  The Local 
Registration Office is system-filled with the County associated to the place of death listed on 
the record. 

The Birth Linkage section contains fields for recording data and information in regards to a 
matched birth record. The State File Number is the number associated to the matched birth 
certificate, and is only system-filled if the matched record occurred  in-state. The Out of 
State File Number is the state file number assigned to the matched birth record and is only 
system-filled if the matched record is out-of-state. Date of Birth displays the date listed on 
the matched birth record. Birth State and Birth Country display the state and country found 
on the matched birth record. These items are typically system-filled but users with 
appropriate security privileges may edit these fields. 
 

9.2 Amendment List 

The Amendment List page is informational and allows a user to review any amendments 
associated with the record.  

 

 

From the Registrar sub-menu select the Amendment List 
page link: 

 

 

If no Amendments are currently associated to the record, the Amendment List page will appear 
blank. 

 

 

 

 

If amendments exist for the record, the Amendment List page will display them in a grid view.  

 The ability to select the Amendment List link is based on user security privileges.  

 The New Amendment button may be selected to start a New Amendment associated 
to the record. Please see section 8.1 Amendments for more information in regards to the 
Amendments process. 
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The Amendment Id and Processing History columns contain links that, when selected, take the 
user into the specific amendment to continue processing or review the items amended.  

 

10. Order Processing 

Vital Records are the legal documents which preserve information about the vital events of 
people in our society. The issuance of certified copies of vital event records, primarily birth 
and death, is an integral part of the services provided by a Vital Records agency. Certified 
copies of vital records are used for legal and administrative purposes. Most jurisdictions 
require the completion of an application, which serves several purposes, for each certificate 
requested. 

The order application is used to locate the certificate, to verify the applicant’s eligibility, and 
to detect and prevent fraud. Fraudulent requests for vital records are often not discovered 
immediately; therefore it is necessary to retain applications permanently or for an extended 
period of time. As a result, DAVE™ retains all application information provided by the 
customer including information related to the certificate requested. 

The Order Processing pages are used to process and track customer orders for certified 
copies of vital records. Users with the appropriate security privileges will be able to enter 
customer orders (including payments), search for events, or print and issue certificates. 

Order Processing information is distributed across several pages in DAVE™, beginning with 
Applicant and continuing to Match Events, Services, Payments, Order Summary, and 
Issuance History. 

Later sections will cover accounting, which includes the processing of the payment part of 
orders, balancing a cash drawer, and reconciling the day’s transactions. 

10.1 Process a New Order 

From the Main Menu select Order Processing and then select New. 
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10.2 Applicant 

The Applicant page will be displayed. 

 
 
The Applicant page is used to gather information on the person requesting the service. 
Complete as much information about the applicant as is known. 

 

 

 

The applicant can be either an Organization or a Person. From the two radio buttons at the 
top of the Applicant page, select which Applicant type will be ordering. 
 
 
 
 

 If the user is an external user and has accessed the order processing module via the 
Order Certified Copies feature, the applicant page will be system-filled with the office the 
user selected at login. 
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Organization as an Applicant 

For Hospitals, Government Offices, and/or other Vital Records partners requesting certified 
copies of records and other services, choose the Organization radio button on the Applicant 

page. Doing so reveals the required  Organization Name field. 

 

 Select the LOV Lookup tool  to access the Facility lookup page.  The Lookup 
Organization pop-up will be displayed. 
 

 
 

 Enter the name of the facility if known. If unknown, enter at least one letter followed by 
the wildcard % symbol. Select the Search button to display a list of facilities.  Click the 
select link adjacent to the desired facility. 
 

 Once selected, the Facility information populates the Organization Name and Address 
fields on the Applicant page. Select Save to save changes. 
 

 
 
 
 
 
 

 If the Organization is not found in the list, the Organization Name and Address can be 
manually entered on the screen. 
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Person as an Applicant 

For applicants that are individuals and not associated to an Organization select the Person 

radio button as the Applicant type. Doing so reveals the required  First and Last Name 
fields for manual entry. 

 

 

 
 

 

Remaining Applicant Page Items 

Id Type - Displays a list of standard forms of identification that are acceptable when 
requesting vital event records. 

Expedite Order - The Expedite Order checkbox is used to flag a rush order. The order is 
placed in the Issuance Queue with all other orders, but when the Priority filter is used, only 
those marked as Expedite Order are returned.  The order approval and completion process 
for expedited orders takes priority over other orders within the Issuance Queue. 

Fraud Suspect – If the applicant is found to be suspect of fraud, this checkbox can be 
selected. This triggers a fraud suspect validation rule on this and any subsequent orders the 
applicant submits. 

Address - This is the address information of the applicant. 

Contact Information - This is the contact information of the applicant.  If the applicant is an 
organization and the organization is selected from the LOV, this information will be system 
filled from the organization information stored in DAVE™.  

Shipping Information Same as Applicant - DAVE™ is set to automatically select this 
checkbox which assumes that the shipping address will be the same as the applicants 
address. If the shipping address differs from the applicant address, uncheck this selection 
and the page will display a section in which to collect shipping address information. 
Additional contact information is also made available to collect if needed. 

 The only required fields on the Applicant page, when Person is selected as the 
Applicant, are the First and Last Name fields. However, the more information provided, 
the easier it will be to contact the customer if follow-up is needed 
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Once the Applicant page is complete, choose a navigation button at the bottom of the page: 

Most often selection of the Next button will be used to save what has been entered and proceed 
to the next page.   
 
Other options include selection of: the Clear button to clear all entries, the Save button to save 
changes without leaving the page.  

Upon selection of Save or Next the Order will: 

 Be assigned a unique order number is assigned consisting of a four digit year + two 
digit month +  five digit sequential number (i.e., 20100600032).  The system-assigned 
order number is displayed at the top of all order processing pages at the top of the 
Order Status Bar. 

 

 Be initially validated and assigned Order and Issuance statuses of Invalid and 
Incomplete. The Order and Issuance statuses will be displayed in the Order Processing 
Status bar, just under the Order Number and Applicant Name. 

 

 Display the Order Processing menu. The Order Processing Menu leads the user 
through the pages necessary to process an order. 
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 Display the Match Events page. 

 

10.3 Match Events 

The Match Events page has three sections, Events Requested, Eligibility, and Event Search. 

Events Requested: Initially, the Events Requested section is empty. It will be populated after 
the Eligibility and Event Search sections are complete and search performed. 

Eligibility: The Eligibility section is used to determine the Event type and Applicant 
Relationship. Based on these two items, the applicant’s eligibility to receive the service(s) 
requested can be determined. 

 

 

 

Event Search: The Event Search section offers a number of fields that can be used to locate 
the record for which service is being ordered.  

10.3.1.1 Eligibility and Event Search 

 It is important to select the Event Type before choosing an Applicant Relationship. The 
Event Type affects the values available for selection within the Applicant Relationship 
dropdown. 
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 First, select the Event Type as this determines what Applicant Relationship types and 
what Event Search fields are available. 
 

 Next, select the Applicant Relationship type from the LOV. 
 

 Enter all information available for the Event Search fields.  
 
 
 
 

 
 Once Event Search fields are completed, select or de-select the checkboxes next to each 

field which contains an entry. 
 

a. Selecting a checkbox will include that item in the system performed Search for the 
record. 

b. De-selecting a checkbox will excluded that item in the system performed Search 
for the record. 

        
      DAVE™ only looks for matches on elements selected with a checkmark. If text is entered 

in a field, but the checkbox next to the field is not selected, the field will not be included in 
the search. 

 
 

 
 

 
 Once the Event Search information is complete, choose from the Event Search 

navigation button at the bottom of the page: 
 

 
 
Most often selection of the Search button will be used to search, using the selected Event 
Search items, within the Event Type selected.   
 
Other options include selection of: the Soundex button to search for names that sound 
like those entered, the New Event button is used to add an additional Event Request to 
the Order.  
 

 Once the Search is performed, the Match Event page expands, below the Event Search 
section, to display the Select Matching Event section.  
 

 It is best to enter all information provided from the applicant regarding the Event 
Search items. Each Order becomes a historical record of the complete application 
submitted for services. If follow-up is needed, the more information available the better. 
 

 It is not necessary to deselect checkboxes for any field left blank. If a field is left blank, 
it is not used in the search. 
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Within the newly displayed Select Matching Event section, the potential matching records 
are listed with Preview links beside them. Selecting a radio button, or the preview link, 
next to a listed potential match will display the Preview page. The Preview page contains 
details about the record selected and can be compared to the Event Search items 
entered, to ensure a correct match is found. 

 

10.3.1.2 Select Matching Event 
 

The Select Matching Event pane displays the search results  

The No Matching Event and the Legacy Record rows are displayed at the top of the Select 
Matching Event search results table. 

No Matching Event should be selected if no results are returned or if none of the matches are 
the desired record. 

Legacy Record should be selected if it is known that the case is on file within the jurisdiction, 
but is not in the DAVE™ database.  These cases are usually on paper or other non-electronic 
media only. 
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Selecting a Match 

If a correct match is found within the search results list, select the radio button next to the 
match.  
 

 
 
Right below the Select Match Event pane in the Images pane. The Images pane will display 
any images that exist for the selected Matched Event. If no images exist then the Images 
page will only list the Issue from electronic record selection. 
 

 

If an image, or images, exist for the selected Matched Event, the Images pane will list these 
images. 
 

 

To issue from the electronic record and not the image, select the radial button next to the 
Issue from electronic record option. 

 The following event types are excluded from the search results list within the Select 
Matching Event page: Out-of-state, Voided, and Abandoned. 
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Otherwise, select the radial button next to the listed Image. 
 

 

10.3.1.2.1 Edit Image Selection 

Upon select of the radial button next to a listed image within the Images pane the Image 
Editor control will be presented with the selected image displayed. 

 

10.3.1.2.2 Image Editing Controls 

 

The Image Editor Controls are located across the top of the image editor.  
 

Select: If more than one page of images are displayed, this tool allows you to select 
an image from the left menu of the Image Editor tool.  
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Magnify: The magnifying tool provides magnification of a selected area of the 
image. Simply select the magnifying tool and hold the left mouse button down over 
the area you wish to magnify.                          

 



State of Arizona DAVETM User Guide  

 

  235 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

Crop: Selecting this tool will place a rectangle on the page which can be used to 
crop the image. Simple adjust the size of the rectangle then double-click the left 
mouse button to crop the image. 

 

              

 

Fit: Selecting this button will fit the full image to display on the screen if it is 
displaying larger than the frame of the image editor itself. 
 

Actual Size: Selecting this button will display the image at its actual size, which 
may be larger than the frame of the image editor. 

 
Zoom In or Zoom Out: These buttons allow you to zoom in and out on the 
image.  

 
Flip or Reverse: These buttons allow you to flip the image or reverse 
(mirror) the image display. 

 
Rotate: These buttons allow you to rotate the image counter-clockwise or 
clockwise. 
 

Invert: This button will invert the image to display in the negative colors of what is 
currently displayed. 
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Auto-Crop: This button will automatically crop off excess white space from the 
select image. 

 
Deskew: This button will automatically adjust the image, straightening it so it is not 
slanting too far to the right or left. 

 
Despeckle: This button will automatically remove spots and “speckles” from the 
image. 

 
Revert: This button will revert any changes made to the image. 

 

Print: This button will allow you to print the image. 

 

 

 

 
Save: This button will save all changes made to the image and close out the image 
editor. 

 

 Images printed from the within the Image Editor are not for issuance and will display 
a Government Use Only watermark. 
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Close: This button will close the image editor without saving any updates made. 

 

 

 

 

 

10.3.1.3 Save Matched Event 

Once the Matched Event and Image are selected from the Select Matching Event and 
Images pane, select the Save Match button. 
 

 
 
The page will refresh and the Events Requested section, at the very top of the page, will now 
display the event request information. 
 

 
 
 
 

 All changes made during the image editing process will be used to create and issue 
the final Certified Copies. Please be sure to select the Save button to saveyour 
changes before exiting from the image editor. 
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If there are additional events to process within this order then, select the New Event button. 
The Match Event page will refresh and the Eligibility and Match Event section will be open to 
allow for an additional event to be searched for, matched to, and added to the Events 
Requested. You can repeat this process as many times as is necessary to add all of the 
requested events to the Order. 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



State of Arizona DAVETM User Guide  

 

  239 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once the Match Events page is complete, choose a navigation button at the bottom of the  
page: 

 
Most often selection of the Next button will be used to save what has been entered and 
proceed to the next page.   
 
Other options include selection of: the Previous button to return to the previous page worked 
on, and the Return button to return to the previous page worked on. 

 The saved Match Events within the Events Requested section can be updated if any 
changes are needed.  
 

 

From the Events Requested section on the Match Events page Select the Edit link next to the 
requested event that needs to be updated. The Event Search section, with the information 
originally entered, for the selected matched event will be displayed. This information can be 
updated and a new search performed by selecting the Search button. 
 

 

Upon Save, any changes made will be displayed in the Event Requested section. 

  If the event requested already has issuances associated to it then, a View link is 
displayed rather than an Edit link. Changes cannot be made after issuances have already 
been made for the event. 
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10.4 Services  

Services requested by the applicant are entered on the Services page. Services refer to the 
documentation or certified copies being requested by a customer. 

 

10.4.1 Add Services 

Source: On the Services page, locate the Source dropdown.  The source indicates how the 
order was received. 

Will this order be paid for by Credit Card? If customer is paying for the requested service 
with a credit card, place a checkmark in the Will this order be paid for by Credit Card 
checkbox. 

 

 

 

This determines if VitalChek fees and Shipping and Handling fees should be applied and 
displayed on the Payments page. Additionally, this is used to include the credit card payment 
option in the Add Payment dropdown on the Payments page 

Received and Fee Effective Date: Use the Received Date field to enter the date the request 
was received. The Fee Effective Date is the date on which the fees are to be applied and is 
used to calculate the fees. 

Both Received Date and Fee Effective Date are automatically populated with the current 
day’s date when the page is opened 

 
 

   
If the order was received prior to the date it was entered, the Received Date should be 
updated to reflect the actual date received.  If the fee changed shortly after the order was 
received, the Fee Effective Date should be changed to the date received.  For example, if an 
order received Dec-23-2010 was not entered until Jan-02-2011, and the fees increased by 

 If the Credit Card checkbox is checked by default and disabled, the user may be set 
up to only allow this type of payment. 
 

 These dates are security controlled.  Not all users will be able to edit these dates. 
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$5.00 per copy Jan-01-2011, then changing the Fee Effective Date to Dec-23-2010 would 
allow the customer to be charged the fee effective on the date the order was received. 
 

Add Service: Select the Add Service button to select the desired service for this record. 

 
 

The name section will expand to display the services section. 

 

Service: Select the Service (i.e., the type of product the applicant is requesting). The Service 
dropdown is filtered by office and event type. 

Quantity: Enter the number of the selected service being requested. 

Priority: The selection made here determines if the order requires expedited processing and 
whether additional fees should be applied. 

Delivery: Select a method of delivery from the Delivery dropdown (i.e., Counter, Mail, UPS). 

Request Reason: Select the reason for the request from the Request Reason dropdown. If 
Other is selected then the Other Specify field will be enabled for entry 

When all information is complete select the Save button to save and add the service to the 
event requested. Or select Cancel to close without adding services. 
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You can add additional Services to the order by selecting the Add Service button again and 
saving additional services. You can repeat this step as many times as is necessary to get all 
of the requested services added to the event. 

 

 

 
 
 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

Multiple Events 
If your order has multiple requested events, you will need to add services for each event. 
Simply select the Add Service button under each event to add services. Repeat this as 
many times as is necessary to add all the requested services to the events. 
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10.4.2 Editing vs. Reversing a Service 

If any errors are found in this service request, click the Edit link to make necessary changes.  
The Reverse link is used after a service has been completed and a determination has been 
made that the applicant is entitled to a reimbursement of fees already paid. 

 

Edit Service 

Upon selection of the Edit link, all other buttons and links for other services and events will be 
disabled and the Add Service button will be conditionally enabled based on whether the order 
has been cashed out.  If the order has not been cashed out, the Add Service button is enabled.  
If issuances exist, the Service dropdown is disabled.  All other values are enabled for editing 
(except Delivery and Priority for manual fee services). 

Reverse Service 

In order to provide proper auditing of transactions and prevent accounting errors, a service row 
cannot be deleted if the order has been cashed out.  The services table does provide a Reverse 
link for each service entered.  The Reverse link will be used to reverse the charges and quantity 
of the service. 

The Reverse link is disabled if issuances exist for the service. Issuances must first be 
deleted from the Issuance Queue page in order to enable the Reverse link. 

 

 

When selecting the Reverse link, the following message is displayed: 

 

Select OK to reverse the service. The quantity and fees of the original service are reversed 
and the Edit and Reverse links are disabled. Select Cancel if you do not wish to reverse the 
Service. 

 

 The Reverse link will be completely disabled if the event request has been rejected. 
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Once the Services page is complete, choose a navigation button at the bottom of the page: 
 
Most often selection of the Next button will be used to save what has been entered and 
proceed to the next page.   
 
Other options include selection of: the Clear button to clear all entries, the Save button to 
save changes without leaving the page.  

10.5 Payments 

Once a record is located and specific services for that record are requested, payment must be 
collected for any fees that are due.  The fees charged for a certified copy of a vital record are 
defined by law and sometimes go to multiple agencies.   

Fees may also be charged for expedited delivery, such as express mail and other expedited 
couriers like FedEx, UPS, etc, or for expedited services.  These fees are often required to be 
deposited into separate accounts.  Additionally, in some jurisdictions local offices may charge 
more for a service than the state office.  In order to support the various combinations of fees, 
DAVE™ provides the ability to assess fees and collect payments at the service, delivery, 
priority of service (expedited versus regular), and office levels. 

Once a record has been located and specific services have been requested, any/all fees must 
be collected that are due.  DAVE™ is capable of accepting the following payment types:  Cash, 
Check, Money Order, Credit Card, Electronic Funds Transfer, and Invoice.  The application 
also has the ability to Waive or Refund payments. 

Any/all payments are entered on the Payments page. Here, the user can add, update, or 
delete payments for the order.  An instructional message appears under the payment 
dropdown when accessing the Payments page for the first time and no payments have been 
entered for an order. 
 

 
 
 
 
 

 

 

 Options in the Add Payment dropdown depend on security privileges assigned to the 
user. If a user has not been assigned a specific payment type through the security setup 
by the System Administrator, the payment type will not be displayed in the Add Payments 
dropdown. 
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The first step in completing the Payments page is to select one of the valid payment options 
from the Add Payment dropdown. 

Based on the payment type selected, a table displays in which to make the payment. The 
Payment Date, User, and payment type (e.g. “Cash,” ”Check,” etc.) are system-filled. 

 

 

 

Enter the payment information and select Save, (or Authorize if Credit Card payment). The 
page will refresh and display the payment applied to the page. 
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10.5.1 Available Payment Types 
 

10.5.1.1 Cash Payment 

Access the Payments page. 

In order to reduce the Balance, payment must be applied. From the Add Payments dropdown, 
select Cash. 

Choose Cash from the Add Payment dropdown and select the Add Payment button 

 

If there is a Balance due it carries over from the Services page. 

 Balance must be equal to $0 before an Issuance link will be enabled on the Order 
Summary page.  Order status will remain invalid if balance due is greater than $0. 
 
 

 



State of Arizona DAVETM User Guide  

 

  247 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

 

Enter the amount of cash within the Amount column.  Choose Save. 

 

The page refreshes, updating the Balance. It has been reduced to $0.00 with no Change 
Due. 
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If there had been an overpayment, as would be the case if a customer offered $30 to pay a $9 
balance, the amount due back to the customer would be displayed as Change Due.   

 

10.5.1.2 Check/Money Order Payment 

On the Payments page, select Check from the Add Payments dropdown and click the Add 
Payment button. 
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A Check / Money Order section displays. 

 

Enter the check number in the Check # field and the Amount. The Type dropdown automatically 
displays the payment type selected from the Add Payments dropdown, but this can be altered 
if needed. Select the Save link in the far right column to save this payment.  

 

10.5.1.3 No fee/None 

DAVE™ provides the ability to waive payments for an order when circumstances provide a 
certified copy at no charge. 

Select No fee/None option from the Add Payments dropdown, and click the Add Payment 
button. 

 

The Waive section is displays. 
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To waive a payment, select a Waive Reason from the dropdown. This is a required  field.  

If the selection from the dropdown is Other, then a reason for waiving a portion of or all of a 
fee must be entered into the Other (Waive Reason) field.  

 

After entering the amount of the fee to be waived within the Amount field, select the Save link. 
The Waive amount is calculated in the Balance due. 

 

Upon selection of the Save link, if the payment type is Waive and the payment amount plus 
any other existing payment types of waive or refund exceeds the amount due, then the 
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following message will be displayed: Cannot waive more than the total amount due on the 
order. 

 

10.5.1.4 Credit Card 

All major credit cards can be processed in the DAVETM application. 

If the applicant wishes to pay for the service(s) via credit card, the Will this order be paid for by 
Credit Card? checkbox on the Services page must be checked. This adds the Credit Card 
value to the Add Payments dropdown. 

 

Select Credit Card from the Add Payment dropdown and choose the Add Payment button. 

 

When the Credit section expands, continue with the order by entering the applicant’s credit 
card number, (manually or by swiping through a card reader), within the Card Number field.  
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Enter the credit card expiration date within the Exp Date field by selecting the month from the 
first dropdown and the year from the second dropdown. Enter the security code found on the 
back of the credit card in the CVC field.  

 
 
 
CVC code: DAVE™ requests the card validation code be entered for credit card transactions. 
These validation codes combat counterfeit fraud through the use of special numbers that are 
encoded on the magnetic strip of credit and debit cards. The VISA Card Verification Value 
(CVV) and the MasterCard and Discover credit cards’ Card Validation Code (CVC) are found 
on the back of the card. The American Express unique card code (CID), is found on the front 
of the card above the credit card number.  

 

 

Hover over the information icon  for help in locating and entering the CVC code information: 

Upon entering the CVC code and monetary amount, select Authorize or Cancel to confirm 
entries.  Both links are available for selection if the transaction status has not yet been 
“approved” or “voided.”  When the Authorize link is selected, statuses of “Approved” or 
“Declined” determine the next system-generated action that occurs. 

 

 
Approved 
If the credit card order receives an Approved status from the credit card processor, the Will this 
order be paid for by Credit Card? checkbox on the Services page is disabled.  

 

 The transaction will not be authorized if the code is left blank or if it does not match the 
code maintained by the card processor. 
 
 

 

 If card information is inputted using a card reader this information will autocomplete. 
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The Credit Card checkbox is disabled because a credit card order cannot be combined with 
any other payment type. This locks down the functionality. 

Once a credit card has been approved for an order, no other additional payments can be made 
on that order. The user is required to route back through the Order Processing pages and enter 
a new order if additional payments are needed. 

 

 

 

If approved, a Void link will appear in place of the Authorize and Cancel links.  Upon selection 
of the Void link for a credit card transaction, the Will this order be paid for by Credit Card? 
checkbox is re-enabled.  The user will be required to uncheck the checkbox to select another 
method of payment. 

 

Declined 
If the credit card authorization status is Declined the checkbox will be re-enabled, for further 
re-selection/use. The user will be required to uncheck the checkbox to select another method 
of payment. 

DAVE™ provides the ability to enter new credit card payment information if a credit card is 
declined.  The user can add new credit card payments until one is successfully authorized.  
The original declined transactions remain visible on the page 

Authorization - General 

During the credit card authorization, DAVE™ will display popup messages to inform users 
when a credit card entry is invalid for the Card Number, CVC code and Expiration Date. 

If during a credit card Authorization or Void an unknown error message is returned, the 
following popup error message will be displayed: Error Processing Credit Card Authorization 
with Credit Card Payment Provider. 

 

 

 

Once a credit card payment has been authorized, DAVE™ prevents a user from adding 
another credit card payment.  If the user selects the payment type of Credit Card again, the 
following error message is displayed, Invalid transaction. Only one credit card payment is 

 Multiple services CAN be included in the same order using a credit card as payment. 
However, once the credit card is approved, DAVETM prevents adding additional services 
(or payments) on the order. 
 
 

 

 Credit card numbers are NOT stored in the DAVE™ database.  Upon selection of the 
Authorize or Void links, the credit card number will be passed to the VitalChek 
authorization server and will be cleared from the Payments page. 
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allowed per order. The Edit and the Reverse link on the Services page is disabled for every 
service listed. 

Selection of the Void Link 

If a transaction is approved, a Void link appears in place of Authorize and Cancel links. 

 

Selecting the Void link prompts a confirmation message. Select the OK  to send a request to 
the VitalChek authorization server to void the credit card transaction.  The transaction will then 
be assigned a “Voided” status. 

 

 

If the credit card payment has already been distributed following the VitalChek Close process, 
the application will also create a special “Credit Card Void” payment with an amount equal to 
the amount on the voided credit card payment.  The “Credit Card Void” payment cannot be 
modified.  The purpose of this payment is to reverse the previous payment distribution for the 
credit card payment. 

10.5.2 Multiple Payment Types per Order 

Payment types can be combined in any way, with the exception of credit card payments.  

 

 

 Credit card payments cannot be combined with any other form of payment on an 
order. This includes any kind of debit or check card. A debit card would be run as credit, 
and handled like all other credit card payments. 
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To enter and collect multiple payments on an order, select Check from the Add Payments 
dropdown, then select the Add Payment button. 

 

The Check/Money Order section displays. In the Check # field enter the number found in the 
upper right hand corner of the check.  Under Type, make sure Check is selected.  In the Amount 
field enter the amount of the check presented.  In most cases this will be for the full amount of 
the Balance due.  In this example, a split-payment will be used.  Enter $3.00 in the Amount box 
and select the Save link. 

 

With the partial payment saved, this time select Cash from the Add Payment dropdown and 
select the Add Payment button again. 

 

The page refreshes and a new payment section, Cash, is displayed.  The Balance due at the 
bottom of the page is updated to reflect the previous payment.  In the Amount field, enter an 
amount and select the Save link. 
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The page refreshes again, showing both payments and updating the Balance. The Change 
Due line is $0.00.  If there had been an overpayment, as would be the case if a customer 
offered a $50 bill to pay a $20 balance, the amount due back to the customer would be 
displayed here. 

The Balance has been reduced to $0 with no change due.  The navigation buttons at the bottom 
of the page are now enabled. 

 

Select Next to proceed to the Summary page and continue with order entry. 

 

 

 

 

 Balance must be equal to $0 before a service/certificate can be issued. Order status 
will remain invalid if the Balance due is greater than $0. 
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10.5.3 Edit Payer 

The payer and applicant are not always the same entity.  An applicant may be requesting a 
certified copy of his or her death certificate, but a family member is paying for the order. If the 
payer and applicant are not the same person or entity, select the Edit Payer button. This allows 
the user to change the payer without changing the applicant. 

 

Selecting the Edit Payer button launches the Payer page.  The default setting on this page sets 
Applicant and Payer as the same person.  De-select the Same As Applicant checkbox.  This 
clears the fields to allow new payer information. 

 

Complete this page for the Payer and select Save. 
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Once the Payments page is complete, choose a navigation button at the bottom of the page: 

Most often selection of the Next button will be used to save what has been entered and 
proceed to the next page.   
 
Other options include selection of: the Clear button to clear all entries, the Save button to 
save changes without leaving the page. 

10.6 Order Summary 

On the Order Summary page, the user can examine the results of the order, place comments 
on the order if necessary, validate the order, and perform several other order-related 
functions.  Begin by reviewing all information previously entered. 
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The top-most section of the Order Summary page displays the Order Source, Received 
Date, and Fee Effective Date.  

 

 
 
 
The Applicant Information section is displays the name and contact information of the applicant.  
The Payment Information section contains the amount that was due for the order, the amount 
paid by the applicant, and the balance. For each payment entered, the Payment Information 
section contains the payment type, amount, and user name. If any of the fees were waived, 
the waive reason is displayed below the totals.  

 

If the Payer page was completed, the information will be displayed within the Payer Information 
section.  The Shipping Information section will be displayed if the Shipping Information Same 
as Applicant? checkbox on the Applicant page was de-selected and the Shipping Information 
was completed.   

 The ProChek/ProID Status is only displayed for those customers who utilize 
VitalChek’s identity verification services and is not currently applicable in Arizona. 
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These sections won’t display if there was not a separate payer entered on the order or if the 
Shipping Information is the same as the applicant’s address. 

 

The Event Requested section allows the user to perform several operations related to the 
order.  At the top of the Event Requested section is the Event Type and the Relation of the 
applicant.  The user has the ability to add comments to an order by selecting the Comments 
link. 

 

The Status of the event requested is also displayed for every event requested that has a 
match. Statuses are helpful in determining whether the case may be issued. 
 
For example, if the case has an “Unregistered” status or a “Hold” the status, the case cannot 
be issued and the Issue link is disabled.  

The Matched Events section contains the Registrant column heading.  If a case was matched 
to the order, the Registrant column displays the name of the registrant requested by the 
applicant. 

 

If no matches are found, “No Matched Events Found” is displayed in the Registrant column.  If 
Legacy Record was selected, “Legacy” record is displayed. 

When the Registrant link is selected, the Match Events page is displayed. Click the Return 
button to return to the Order Summary page. 
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Within the Match column, if a case was matched to the order and the user has the proper 
security, then a Yes link is displayed. 

 

If the event requested is a Death, then selecting the enabled Yes link take the user to the 
Decedent page for the Matched Event. Select Return for the Decedent page to go back to the 
Order Summary page. 
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If the event requested is a Fetal Death, the user will be taken to the Fetus page instead. 
 
This feature allows the Customer Service Representative to review the registration requested 
to determine if any business rules or procedures not covered in the order processing rules 
prevent the case from being issued.  If the user does not have access to the case or to 
registration pages, the Yes link will not appear as an active link. 

The Total Number of Issuances and the Date of Last Issuance columns display the issuance 
history of the matched event. 

To display the Event and Issuance History page for the matched event, select the Total Number 
of Issuances link. 

 

The Event & Issuance History page displays. Select the Detail link next to the Order to view 
order details. 
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The order detail displays. 

 

If no previous issuances exist for the matched record, a zero will be displayed as the Total 
Number of Issuances. 

 

Date of Last Issuance and Total Number of Issuances are based on issuances with a complete 
status. An issuance with a void or incomplete status is excluded. 

Within the Services section, an active link for each service requested is displayed in the Service 
Name column. 
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When the Service Name link is selected, the Services page is displayed. Select Return to go 
back to the Order. 

 

If one or more copies of a service have been printed, an icon is displayed next to the Service 
Name link. Hover the mouse cursor over the icon and the application displays a hint dialog with 
the following text: “Issuances exist for this requested service.” 

 

The Quantity, Priority, Delivery, and Fee columns display the information was entered on the 
Services page. 

The last column within the Services section will conditionally provide an Issue link. Conditions 
for display of the Issue link include: 

 If the order has passed all edit rules. 

 If the issuances have not been printed and set to complete. 

If all issuances are printed or deleted from the queue, the Issue links for the services are 
disabled. 

10.6.1 Issue a Record 

Upon selection of the Issue link, the Issuance Queue page displays and allows users to print 
the certified copies of records based on the service requested. 

To issue/print a certificate, place a checkmark next to the desired record. Select Print Issuance. 
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Select the Print Issuance link to launch and display the PDF of the Issuance.  
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

Once the record is printed, enter the security paper number in the Security Paper Number entry 
box and select the Save button.  This saves the Security Paper Number and auto-fills the Date 
Printed box with the current date. 

 Dependent upon which browser you use, you may need to select the Open link for the 
PDF to display.  
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If the service printed properly without paper jams or errors, click the complete link.  This is 
the final step in processing an order.   

 

 

 

If the Security Paper Number field is left blank, the order cannot be completed and the user 
receives the following error message: 

 The Security Paper Number is a pre-preprinted number used to identify and track 
pieces of security paper. This pre-printed number is unique to the paper type (e.g. wallet, 
short, long, etc.). 
 
 

 

 Once an order has been marked complete, the Print link on the Order Summary page 
is disabled. 
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Other links available for selection on the Issuance page: 

Delete - Select the Delete link to delete or remove issuances from the issuance queue.  This 
may be necessary if a customer reduces the number of copies requested or changes the 
service. Upon selection of the Delete link, if all rows are deleted, the actions are disabled.   

 

Void - If a certificate did not print properly, or the paper jammed, etc., and needs to be voided, 
use the Void link to void the selected item’s print record and start over.  This voids the security 
paper number and allows a new certified copy to be reprinted. 

AutoNumber Ascending - The AutoNumber Ascending feature is used to assign security 
paper numbers to a group of certified copies in sequential ascending order. 

AutoNumber Descending - The AutoNumber Descending feature is used to assign security 
paper numbers to a group of certified copies in sequential descending order. 

Follow these steps to use the AutoNumber features: 

 Place a checkmark in the All column of the records to be updated. 

 Enter the starting number in the Beginning Number textbox. 

 Select the AutoNumber link to start the numbering process. 

Select the Close button to close the Issuance page. 
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10.6.2 Event Requested Links 

 

10.6.2.1 Correspondence 

If insufficient or inaccurate data is presented, the DAVE™ Correspondence link can be used 
to automatically complete and prepare correspondence requesting additional information.  
Upon receipt of additional information, pending orders may be retrieved directly from a work 
queue. 

 

Please see the “Correspondence” section in the DAVE – Table Maintenance guide for more 
information regarding Correspondence. 
 

10.6.2.2 Work Order 

The work order is intended to be used as an aide for conducting manual paper searches for 
legacy records.  
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To print a work order, select the Work Order link.  A File Download dialog box will display: 

  

Select Open to open the Work Order for printing. 
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Work Order example below. 
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10.6.2.3 Receipt 

Sometimes customers require a receipt to demonstrate they have paid for services rendered.  
It may even be a requirement in certain offices. When the customer requires a receipt, select 
the Receipt link located in the Event Requested section.  

 

Select Open in the File Download Dialogue Box to view/print the order receipt  

 

 

  
 If the applicant is different from the payer, the receipt will print the name of both the 

applicant and the payer; otherwise just the applicant will be printed. 
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10.6.2.4 Mailing Envelope 

DAVE™ provides the ability to print shipping information of the applicant directly onto a Mailing 
Envelope by selecting the appropriate link on the Order Summary page.  

 

Selection of the Mailing Envelope link produces a PDF document displaying the shipping 
name and address as recorded on the Applicant page of the order. 

 

The Mailing Envelope feature will print a size 10 envelope with the following shipping 
information included: 

Line 1: <Shipping First Name>, <Shipping Middle Name>, <Shipping Last Name>, <Shipping Suffix> 

Line 2: <Street Number>, <Pre-Directional>, <Street Name>, <Street Designator>, <Post Directional>, <Apt> 

Line 3: <City>, <State>, <Zip Code> 

Line 4: <Country> (Print only if Country is NOT United States) 
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Example of mailing envelope: 
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10.6.2.5 Mailing Label 

DAVE™ provides the ability to print shipping information of the applicant directly onto a Mailing 
Label. Select the Mailing Label link in the Event Requested section on the Order Summary 
page.  

 

Selecting the Mailing Label link produces a pdf document with the shipping name and address 
as recorded on the Applicant page of the order.  In the File Download dialogue box, select 
Open to open the file for printing, or select Cancel to close without printing. 

 

Below is the shipping information included on the label: 

Line 1: <Shipping First Name>, <Shipping Middle Name>, <Shipping Last Name>, <Shipping Suffix> 

Line 2: <Street Number>, <Pre-Directional>, <Street Name>, <Street Designator>, <Post Directional>, <Apt> 

Line 3: <City>, <State>, <Zip Code> 

Line 4: <Country> (Print only if Country is NOT United States) 

 

The measurements of the label will be 2.625” by 1”. Once the PDF file is open, select the print 
icon  displayed on the PDF file.  The icon/picture  will not print onto the paper. Example of 
a Mailing Label: 
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10.6.2.6 Suspend 

This feature is used to exclude an order from the cash out until a customer provides proper 
entitlement documentation.  

 

Selection of the Suspend link displays a message confirming suspension of the event. By 
selecting OK, the event is suspended and the order will be excluded from the cash out process.  
 
A Cancel Suspend link is now available. Once the proper entitlement documentation is 
provided the suspend can be cancelled by selecting this link. The order will then be included 
in the cash out process. 

 

10.6.2.7 Reject Request 

Occasionally, a customer is not legally entitled to a copy of the event requested and it is 
necessary to reject the request. The user will not be allowed to edit the event request 
information or add new services once the Reject Request link has been selected on the Order 
Summary page. 

 

 

Reject a request by following these steps: 

 Locate and select the Reject Request link on the Order Summary page. 

 

 Select the OK button from the confirmation message that is displayed. 

 Rejecting a request cannot be undone.  Once rejected, a new order will have to be 
initiated. 
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If OK is selected, the Order Summary page will refresh and the Reject Request link will be 
replaced with a non-selectable Rejected label. 

 

All fields on the Services and Match Events pages associated with the rejected request will be 
disabled.   

If issuances exist, the following error message will be displayed: "Issuances must be deleted 
before rejecting request."   

10.6.3 Order Summary Page buttons 

The buttons across the bottom of the Order Summary page can be used to process the order.  

 

New Order: If selected, a blank Applicant page will be displayed 

Copy to New:  If selected, a new Order will be created copying the Applicant and Match 
information into the New Order. 

Validate Order: If selected, all order processing validation edit rules will be triggered to ensure 
accurate completion of the order. 

Void: If selected, DAVETM  prompts according to whether the order has issuances and it is 
voided based on user response to the prompts: If issuances exist (i.e. certified copies have 
been printed), the verification message “All completed issuances will be voided. Do you want 
to void this order?” is displayed. If issuances do not exist, the user is prompted to confirm the 
void “Do you want to void this order?” 
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Issuance History: If selected, the Issuance History page will be displayed; a row will be 
displayed for each item printed/issued.  Example of Issuance History page: 

 

 

 

Previous:  If selected, returns the user back to the last or previous page. 

Return:  If selected, returns the user back to the first or original page (search results or work 
queue only). 

10.7 Validate Order 

DAVE™ provides the ability to validate the information entered for a customer order.  Order 
processing validation rules may be based at the event request, order, or service level.  For 
example, if a customer requests several different records within one order, in order to verify 
the customer’s legal entitlement, an entitlement rule must be triggered for each event 
requested. 

To validate an order, DAVE™ provides a Validate Order link within the Order Processing 
Menu and a Validate Order button on the bottom of the Order Summary page. 

 

To check an order for any possible errors, locate and select the Validate Order button at the 
bottom of the page. 

 

 

 

Validation checks the order against all business and jurisdiction rules in the system.  If any 
errors are returned, they must be corrected and the order re-validated until all edit rules pass. 

 The Issuance History button is available based on security privileges. 
 
 

 

 The Funeral Home User or Funeral Home Director roles will not include the Validate 
Order button. Rather, upon selection of the Submit button, the order will be validated and 
saved and the user will be returned to the Decedent Page. 
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If there are no errors reported and the order passes all validation rules, a confirmation popup 
message appears. The order can then be processed. 

 

If errors are found, the Validation Results window is displayed below the Order Summary page.  
Correct or override errors and return to the Summary page and re-validate the order.  

 

 

If the errors can be overridden, a checkbox appears in the Override column.  To override and 
continue with order processing, select the Override column’s checkbox and click the Save 
Overrides button. 

 

If the order contains multiple requests and/or multiple services, each request and service will 
be validated.  If all Validation Rules PASS upon selection of the Validate Order link or button: 

 A green indicator will be displayed on the Summary menu link. 

 

 Not all errors can be overridden! 
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 The Validation Results page will not be displayed.  Instead, the user receives the 
following confirmation message: 

 

 An Issue link will be enabled within the Services section of the Order Summary page. 

 

If one or more Validation Rules FAIL, upon selection of the Validate Order link or button: 

 A red indicator will display on the Summary menu link. 

 

 The Validation Results page will display failure details that include columns for Error 
Message, Event Id, Service Id and Override. 
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Event ID: The value displayed within the Event Id column is based on the event request that 
caused the rule to fail.  For example, if Request 1 caused the rule to fail but Request 2 did not, 
then the value of “1” would be displayed in the Event Id column. 

Service ID: The value displayed for the Service Id is based on the service that caused the rule 
to fail.  For example, if Service Request 1 caused the rule to fail but Service Request 2 did not, 
then the value “1” would be displayed in the Service Id column.  If a rule fails for 2 services 
(line items) and/or event requests (order subjects), then “(1:2)” would appear within the Service 
Id column. 

An order can be processed even if there are validation rule failures. Place a checkmark  in 
the Override checkbox next to the Error Message to be overridden and select the Save 
Overrides button. 

 

10.8 Void Order 

Voiding an order in DAVE™ is possible through the Void button on the Order Summary page.  

 

The void is handled differently according to whether the order has issuances.  The application 
prompts in the following ways: 

Issuances exist: If certified copies have been printed, a verification message gets displayed: 
All completed issuances will be voided.  Do you want to void this order? 
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Issuances do not exist: A user prompt appears asking the user to confirm the void action: Do 
you want to void this order? 

Upon selection of OK to either message, if the Payment Type is Credit Card and the status is 
Approved, the following error message is displayed: Please void the credit card payments prior 
to voiding the order. 

If a credit card payment with an Approved status does not exist: 

Example of negative value that is inserted on the Order Summary: 

 

 All work queue status(es) will be end dated. 

 Each event requested in the order will be assigned a status of Void. 

 A row will be inserted into the services section service that reverses the quantity and 
fees of the original service. 

Example of negative value that is inserted on the Services page: 
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If the Reverse link is selected from a row on the Services page prior to selecting the Void 
button, the “negative” row (i.e. the row displaying “($9.00)” in the example above) will not be 
inserted.  Since the quantity was already set to zero by selecting the Reverse link, it is not 
necessary to insert a negative quantity. Since the amount due on the order is set to $0.00 after 
a “Void” is performed, the order may be overpaid (have a negative balance).  The user must 
add a refund payment in order to return the overpaid amount to the customer.  Or, if payments 
have not been cashed out, the user may delete the payment and return the payment to the 
customer. 

Before Cash Out, the payment can be deleted:  

 

Once a payment is cashed out it cannot be deleted and a Refund must be added to change 
the balance to zero. After Cash Out, a Refund payment can be added. 

10.9 Issuance History 

Locate the Issuance History button at the bottom of the Order Summary page. 

 

Click on the Issuance History button to display the Issuance History page.  This page displays 
a listing of all certified copies that have been issued for this record on this order only.  In other 
words, this display is order specific.  In the example below, a certificate was printed on May 
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27, 2014 on Security Paper Number DOL000000020. (Please see “Event and Issuance 
History” section earlier in this document for more detail on viewing issuance history.) 

 

10.10 Order Processing Attachments 

Scenarios where attachments might be uploaded and attached to orders for certified copies of 
death certificates include: 

 An application which was completed manually and handed to a clerk could be scanned in 
for evidence 

 A scanned copy of “identification” for the person requesting the order (such as a valid 
driver’s license) to support giving a certified copy to the individual 

 Scanned evidence of a signature if a credit card payment is used for the order 

 Scanned copies of court documents (such as a letter requiring a certified copy of a death 
certificate) to attach to the order for supporting documentation. 

Attaching scanned documents to orders in Order Processing is done through the Attachments 
menu link on the Order Processing menu. 

 

Selecting the Attachments link launches the Attachments dialog.  Select the New Attachment 
button. 
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The Attachments dialog expands to allow the user to upload a new attachment.  Select the 
Browse button to access documents residing on a local or network drive. 

 

Browse the local (or network) directory to locate and select the desired document to upload. 
Select the Open button. 
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Click the Save button to complete the process and upload the file. 

 

The document appears is saved as an attachment. 

 

 

 

10.10.1 View an Attachment to an Order 

To view an attachment that has been uploaded and attached to an order, select the View link.  
The File Download dialog appears.  Select Open. 

 

 Attachments can be any file type. Users can upload as many attachments as necessary 
to an order. 
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10.10.2 Delete an Attachment to an Order 

It may be necessary to delete an attachment that has been uploaded.  Click the Delete link on 
the Attachments dialog. A warning message appears prompting for certainty about deleting the 
attachment.  Select OK to proceed with the deletion. 

 

10.11 Search for an Order 

This section describes how to search for and access a previously entered order by using the 
Search feature of the Order Processing module.  The Search option will be used by central 
office users (State) and local office users (City, County, or Municipality) to locate customer 
orders. 

From the Main Menu of DAVE™, select Order Processing > Search. 

 

The Search for an order page opens.  Search types available are organized by section. 

 A user must have software installed on their computer appropriate for viewing the 
specific attachment file type.  For example, for a PDF, they must have a PDF reader; for 
a spreadsheet, they must have spreadsheet software, such as Excel. 
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There are four search options to choose from: 

1. Search by Order 

2. Search by Event Requested 

3. Search by Applicant 

4. Search by Matched Event 

 

 

 

10.11.1 Search By Order  

 

 To utilize any of the searching sections on this page, the user must input at least one 
of the requested pieces of information from within a search tab.  The search controls are 
NOT case-sensitive. 
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To Search by Order, information must be entered into at least one of the controls: Order 
Number, VPS Order Number, Security Paper Number, Tracking Number or Date Received 
Between.  Select Search at the bottom of the page. 

Order Number: 
The order number is a unique identifier and will consist of the 4 digit year + two digit month + a five digit 
sequential number (e.g. 20040600001).  A Search by Order can be performed using only this data field. 

VPS Order 
Number: 

Orders placed via Vitalchek.com are assigned a VPS Order Number. Enter the VPS Order number in this 
field. 

Security Paper 
Number: 

Also called “safety paper” by some jurisdictions, the security paper number is a pre-preprinted number 
used to identify and track pieces of security paper.  This pre-printed number is unique to the paper type 
(e.g. wallet, short, long, etc.).  A Search by Order can be performed using only this data field. 

Tracking Number: 
Typically the tracking number is only assigned to orders being shipped by FedEx, UPS or other express 
mail service.  A Search by Order can be performed using only this field. 

Received between 
___ and ___: 

The dates entered should be an estimate of when the order was received by the office that entered the 
order.  To search by date range both the start date and end date must be entered.  If only the Start Date 
is entered, then a search will be performed on an exact match of the Start Date.  Date based searches 
may not always be successful.  If End Date is earlier than Start Date then no results will be returned.  If 
Start Date is used without an End Date then only those orders requested on that specific date will be 
returned.  It is possible to search using an End Date without a corresponding Start Date.  This search 
criteria returns all orders entered up to that date.  The resulting list of orders would likely be too large to 
be useful. 

 

 

 

An example of a Search by Order using a date range is as follows: 

 

The results returned appear below.  To open an order, select the Order Number link of the 
desired record. 

 A successful Search by Order should always return at least one order. 
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10.11.2 Search by Event Requested 

 

Search by Event Requested permits a search for an order based on the First Name and/or 
Last Name of the decedent. 

First Name Entering the first name is optional.  If a value is entered in the First Name field it must 
exactly match the name entered on the customer’s application. 

Last Name When searching by event requested, the last name is a required field.  The name 
entered here must be the name provided on the customer’s application and 
subsequently entered on the Match Event page. 

 

A successful Search by Event Requested most often returns a list of orders.  By entering 
“Anderson” in the Last Name field, the search returns the following results: 
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Using the wildcard is permitted in a Search by Event Requested. Enter a letter (here the 

letter “g” was used), followed by the wildcard symbol “%.”  

 

This searches for all orders entered for a death event with a Last Name beginning with the 
letters “gr.” The Results of a Search by Event Requested using a wildcard appear below. 

 

10.11.3 Search by Applicant 

 

To Search by Applicant (the person or organization originally placing the order) the user must 
input at least the applicant’s Last Name.   

Organization Name When searching for an order by Organization Name (i.e., state agency, hospital, etc.), no 
other fields are required. 
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First Name When searching by applicant name, if a value is entered in the First Name field, the Last 
Name is required. 

Last Name When searching by applicant name, the Last Name is required. 

Phone When searching for an order by an applicant’s telephone number, no other fields are 
required. 

 

To Search by Applicant, enter a valid applicant name and select the Search button at the 
bottom of the page. To reduce the number of orders it is highly recommended that both First 
Name and Last Name be used.  Supplying additional information such as Phone and/or 
Organization Name helps narrow the results further.  

Wildcard searches are permitted when performing a Search by Applicant. Enter a letter 
followed by the wildcard symbol % in the Last Name field. In this example the letter “a” is used. 

 

The search Results page displays all orders with Applicant Last Name beginning with the 
letter “a.” 

 

 

 

 If only the Applicant First Name is entered, the system will generate an error message. 
. 
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Select the Order Number link to open an order.  The Order Summary page displays the details 
of the specific record. 

 

10.11.4 Search by Matched Event  

 

A Search by Matched Event is based on the Event Type selected from the dropdown and on 
whether a successful match was performed and associated with an order.  This search ONLY 
returns orders where the event requested was successfully matched to a record in the 
database.  

Event Type Death must be selected from the dropdown for death registration-related orders. 

Search Criteria 1 
Upon selection of the Event Type, the Search Criteria 1 dropdown is populated with data 
controls found on the pages associated with death events. 
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Value 1 
Upon selection of a value from the Search Criteria 1 dropdown, the user must enter valid 
data in the Value 1 text entry control that ties directly to the selection made in Search 
Criteria 1. 

Search Criteria 2 
Upon selection of the Event Type, the Search Criteria 2 dropdown is populated with data 
controls found on the pages associated with the event. 

Value 2 
Upon selection of a value from the Search Criteria 2 dropdown, the user must enter valid 
data in the Value 2 text entry control that ties directly to the selection made in Search 
Criteria 2. 

 

 

 

Select the Search Criteria 1 from the dropdown, and enter the corresponding information in the 
Value 1 field. 

 

The following example shows Search Criteria 1 & 2 selections and Values 1 & 2 . 

 

 

 

Key in valid entries for one or more Search Criteria and Value fields and select the Search 
button at the bottom of the page. 

 The Search by Matched Event section allows searching for the matched event by 
more than one criterion 
. 
 
 
 
 

 When searching by Matched Event, a minimum of Event Type, Search Criteria 1, and 
Value 1 must be selected/entered. 
. 
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Event based searches may not always be successful.  When they are successful, they can 
return one or many records.  The results below include all orders for records with decedent’s 
last name of “Anderson” on the death certificate. 

 

Wildcards are permitted in a Search by Matched Event. Here the Search Criteria 1 selected is 
the Decedent’s Last Name, and the letters “ad” and the wildcard symbol % are entered for 
Value 1. 

 

The search Results page returns orders where the decedent Last Name begin with the letters 
“ad.” 
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10.11.5 Performing the Search 

 

To initiate a search based on the criteria and values entered, select the Search button.  Or, to 
remove search criteria and start over, select the Clear button at the bottom of the page.  

Another search option is the Soundex search.  Soundex searches are used when the spelling 
of a name is uncertain.  Users can enter a sounds-like name (i.e., “Smith” for “Smythe”) and 
still successfully locate a record.   

DAVE™ also allows use of a wildcard feature via the % character to search for records when 
only a partial spelling is known (i.e., searching for “Mur%” returns names like Murdock or 
Murphy. 

The Maximum records to display defaults to 200.  This means regardless of the number of 
orders returned by the search, only 200 rows will be displayed.  It is possible to increase the 
value for maximum records to display. But, when the number is increased, the user receives a 
warning message about system performance. 

 

 These types of searches should be kept to a minimum and performed after hours.  If 
possible, users should enter more search criteria to refine the search. 
. 
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Selecting any of the underlined column headers will re-sort the search results based on the 
contents of that column.  Selecting the Order Number link opens directly to the Order Summary 
page for review/editing of the order. 

 

After reviewing the Order Summary page, select the Previous or Return button to return to the 
Results page. 

 

 

10.12 Order Certified Copies 

From the Death or Fetal Death Registration Menu select 
Other Links > Order Certified Copies.  
 
 
 

The Order Processing Menu is displayed replacing the Death Registration Menu. 
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The Applicant page is also displayed and pre-filled with the name and address information 
associated to the Funeral Home completing the order. 
 

 

10.12.1 Applicant Information 

The pre-filled Applicant Name and Address items cannot be edited. However, Contact 
Information fields remain available so information can be added to specify a contact in 
regards to the order. 
 
The Shipping Information Same as Applicant? Checkbox defaults to checked. If the certified 
copies should be sent somewhere other than the Funeral Home listed, select the check box 
to remove the checkmark and enter shipping information. 
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The page will expand and allow for information to be entered in regards to where the certified 
copies should be shipped. 
 

 
Once the applicant page is complete, select Next. 
 

 
 
 

 

10.12.2 Services 

The Services page will be displayed. 
 

 

Select the Source for the Order. 
 
Next Selecting the Issuing Office. 

 

 

 

Once the Issuing Office is selected the page will refresh and display the Name section.  
 

 
 

 Selecting Clear will clear all information that has been entered on the page. 
     Selecting Save will save the information that has been entered on the page. 
     Selecting Return will return the user to the last page they took action on. 
 

 The Issuing Office dropdown list is filtered based on the County of Event. If the more 
than one issuing office exists per county a selection will need to be made. However, if 
only one issuing office exists, this Issuing Office field will be pre-filled with the specific 
issuing office. 
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Select the Add Service button to add services to the order.  The name section will expand to 
display the services section. 

 

Service: Select the Service (i.e., the type of product the applicant is requesting). The Service 
dropdown is filtered by office and event type. 

Quantity: Enter the number of the selected service being requested. 

Priority: The selection made here determines if the order requires expedited processing and 
whether additional fees should be applied. 

Delivery: Select a method of delivery from the Delivery dropdown (i.e., Counter, Mail, UPS). 

Request Reason: Select the reason for the request from the Request Reason dropdown. If 
Other is selected then the Other Specify field will be enabled for entry. 

Select Save to add the services. Selecting Cancel will close the Add Services section without 
adding services to the Order. 

 

 

 

Once the Services page is complete, select Next. 
 

 
 
 

 

 

 

 

 
 

 If additional services need to be added to the Order simply select the Add Service 
button again to add additional services. 
 

 

 Selecting Save will save the information that has been entered on the page. 
     Selecting Previous will return the user to the last page they took action on.    
     Selecting Return will return the user to the last page they took action on. 
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10.12.3 Payments 

The Payments page will be displayed. 

 

Select Credit Card from the add payments dropdown and then select the Add Payment 
button. 

 

Enter a credit card number within the Card Number field. 
 
Enter the credit card expiration date within the Exp Date field by selecting the month from the 
first dropdown and the year from the second dropdown.  
 
Enter the security code found on the back of the credit card in the CVC field.  
 
CVC code: DAVE™ requests the card validation code be entered for credit card transactions. 
These validation codes combat counterfeit fraud through the use of special numbers that are 
encoded on the magnetic strip of credit and debit cards. The VISA Card Verification Value 
(CVV) and the MasterCard and Discover credit cards’ Card Validation Code (CVC) are found 
on the back of the card. The American Express unique card code (CID), is found on the front 
of the card above the credit card number.  

 

 

Hover over the information icon  for help in locating and entering the CVC code information. 

 The transaction will not be authorized if the code is left blank or if it does not match the 
code maintained by the card processor. 
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Select the Authorize link to submit the credit card information for payment. Select the Cancel 
link to discard the Credit Card information without submitting for payment. 

 

 

 
 
Once the payment has been approved, select the 
Next button. 

 
 
 
 

 

 

10.12.4 Order Summary  

The Order summary page will be displayed.  

 

Select to Validate the Order button to review any issues that may exist and correct them. 

Select the Void button to void the Order. 

Select the Submit Order button to submit the Order to the Issuing Office selected on the 
Services page. 

 

 

 Selecting Save will save the information that has been entered on the page. 
     Selecting Previous will return the user to the last page they took action on.    
     Selecting Return will return the user to the last page they took action on. 
 
Select the Edit Payer button if the payment is going to be submitted by someone other 
than the Funeral Home submitting the Order. See section 10.5.3 Edit Payer for more info. 
 

 Credit card numbers are NOT stored in the DAVE™ database.  Upon selection of the 
Authorize or Void links, the credit card number will be passed to the VitalChek 
authorization server and will be cleared from the Payments page. 
 
 

 

 More information regarding items on the Order Summary page can be found in section 
10.6 Order Summary. 
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11. Queues 

DAVETM provides work queues which contain records, orders, issuances, or amendments that 
are in process. These item are placed in queues based on the assignment of a work queue 
status. Work queue statuses are assigned after a record or order has been validated or, when 
a specific action has been taken by a user that sets a status. Queues are used to group items 
together based on the type of work that needs to be done. 

Users with the appropriate security privileges will be able to access particular work queues and 
work queue types. 

11.1 General Functionality in All Queues 

There are two ways to access Queues within DAVETM.  

Current Activities - From the Main Menu, select Main > Current Activities, or select the 
Current Activities Fast Link icon on the home page. 

 

 

 -or-  

 

 

 

The Current Activities queue is unique to the user type selecting to view it. Unlike selecting a 
specific queue from the Main Menu, the Current Activies displays on a single page all of the 
different work queues containing cases and orders needing attention. 
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Main Menu – The second way to access queues is via the Main Menu where you can select 
Queues and a menu of available queues is displayed: 

 

 

 

Queue Types:  

 Registration Work Queues 

 Order Work Queues 

 Issuance Queues 

 Amendment Work Queues 

11.1.1 Queue vs. Queue Summary 

There are two ways to view Queue Information: by selecting a specific work queue 
(Registration Work Queue, Amemdments Work Queue, Issuance Queue, or Order Work 
Queue), or via a queue summary page,  (Registration Work Queue Summary, Amemdments 
Work Queue Summary, Issuance Queue Summary, or Order Work Queue Summary). 

Seletcting a Queue Menu Page 

Select Main Menu > Queues > Registration Work Queues. The Search by Registration Work 
Queue menu page will load from which a particular queue can be selected. 

 

 

 

 The ability to access particular queues is based on user security privileges.  
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Select a Queue Summary Page 

The Work Queue Summay page will display a summary of all the queues of the type selected 
which items appear in. 

 

11.1.2 Work Queue Pages 

Work queue pages are separated into three sections: Search Options, Search Results and 
Actions: 

 

Search Options Fields for entering search criteria—provides search functionality 

Search Results Data grid listing with hyperlinks—displays all rows within a given queue, or only 
those rows matching the search criteria 

Actions Hyperlinks—provides functionality for user actions such as accessing the item 
directly, assigning a case to another queue, certifying, printing, entering comments 
or attaching correspondence, etc. 
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11.1.3 Search Options 

The Work Queue page allows the user to search for specific cases within a queue type.  

1. Four search options are provided: Queue, Search Type, Value, and Filter. 

 

 

2. Select a queue name from the Queue dropdown.  

 

3. A Search Type may also be chosen, but only if a value is provided in the Value field.   

 

 

 

 

4. Selection of a Filter will also help narrow search results. If a Filter Value is required, 
DAVE™ will prompt users to enter one. 

 The actual work queues available vary based on user type & security setup. 
 

 Search criteria entries work together to refine a search. It is possible to use both the 
Queue and Search Type search criteria dropdowns.   
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Display - Determines the number of rows that will be displayed on the page. 

 

5. After all search criteria is entered, select the Search button. 

 

 

 

Queue – Queues available to the user based on security privileges. 

Search Type – The search types include Case Number, Employee, and SFN (State File 
Number).  If a search type is selected from the Search Type dropdown, then a value MUST be 
entered into the Value textbox. 

(Search Type) Value – Enter the case number, employee name or SFN from the case for 
which the user is searching.  Alphanumeric entries are allowed. 

If the Search Type selected is Case Number, the queue will list only the case that matches 
the case id entered.  Note, a Case ID is a unique identifier across all events. Searching by 
Case ID will always return a single record. 

If the Search Type selected is Employee, the queue will list only those cases where the last 
name matches the last name of the user who performed the most recent Action. 

If the Search Type selected is SFN, the search will return only the case that matches the SFN 
entered. 

 It is possible to view all cases in a specific queue by making a selection from the 
Queue dropdown and NOT making a selection from the Search Type and Value fields. 
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Filter – The values for the Filter dropdown will vary based upon the type of work queue 
selected. A detailed description of each filter can be found within the specific queue sections 
of this user guide. 

(Filter) Value – A Filter value may be required. 

 

 

11.1.4 Search Results 

Search results always display in a data grid. The results are organized based on the type of 
queue: Registration, Order, Issuance, or Amendments. 

For example, the Registration Work Queue column headers… 

 

…are different from the Order Work Queue column headers. 

 

All column headers displayed in blue allow the user to sort and re-sort rows. Select a header 
to sort the search results by that specific column. To access one of the 
cases/orders/amendments listed, select any of the blue links within a row. 

 

 

 The Filter dropdown is replaced by an Age dropdown on the Order Work Queues 
search page.  
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Show All Rows vs. Show Number of Rows 

1. Enter a number in the Display field, choose Search. The number of designated rows 
displays. To view all rows, choose the Show All Rows button. 

 

2. The page will expand to reveal all search results and display the Show Number of Rows 
button.  

 

3. The Show Number of Rows button will return the user back to page view where the number 
of rows is designated in the Display field. 
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11.1.5 Actions 

Users can perform certain actions on cases directly from the queue search results page. The 
actions available are based on security privileges and queue type. 

The Actions links are located at the bottom of the search results page. 

 

The following table describes the functionality of each Action. 

Register Event 
Enabled for 
registration 
queues only. 

Displays the registration approval page for the row selected. 

 Due to database constraints, if more than 2000 matching results are found only the 
first 2000 results will be displayed. 
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Abandon Case 
Enabled for 
registration 
queues only. 

Changes the registration status for the row(s) selected to 
“Abandoned”.  If a user attempts to assign an “Abandoned” status 
to a case with a “Registered” status, the following error message 
will display: “One or more cases are registered.  Registered case 
(Case ID #####) cannot be abandoned.”  If more than one case 
with a registered status is selected, the last line of the message 
will be repeated for each case with a registered status. 

Certify Registration 
Enabled for 
registration 
queues only. 

Displays the Certification Affirmation page for the row selected.  
Upon selection of the Certify Registration link, if the case does not 
have a certification required status, then the following error 
message will be displayed:  “The registration you have selected is 
invalid and cannot be certified.  Please correct errors.”  If the 
event has a certification required status, then the Certification 
Affirmation page will be displayed. 

Assign To Another Queue 
Enabled for all 
queue types. 

Provides the ability to assign selected row(s) to manual work 
queue. 

Remove from Queue 

Enabled for 
temporary 
registration work 
queues only. 

Removes the case from the work queue by end-dating the work 
queue status.  The ‘Remove from Queue’ link will only be enabled 

if the queue selected from the ‘Queue’ dropdown is a 
temporary/manual work queue. 

 

 

 

11.1.6 Actions – Remove from Queue 

To remove a case from a queue, use the Remove from Queue link under the Actions. 

Select the checkbox   next to the record to be removed and select the Remove From Queue 
link.  

 

 

 

 

 To select a case, place a checkmark in the checkbox  next to the case in the All 
column.  

 This end dates the status that placed the record in the queue.  
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11.1.7 Actions – Abandon Case 

A registration office can use the Abandon Case link when appropriate. For example, when a 
Potential Duplicate error reveals a case is a non-registered duplicate; or when it’s determined 
a case is an orphan — one that was started, but never completed. Additionally, a status of 
Abandoned is assigned by the system when the jurisdictionally-defined time limit has been 
exceeded for completion of a case.  

1. To Abandon a case, select the checkbox  next to the case to be abandoned. 

2. Select the Abandon Case link.  

 

3. A popup message appears. Select OK. 

 

The record is removed from the queue. 

 

 

 

 

 No further work may be performed on a case once it has been abandoned. 
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11.1.8 Actions – Assign to Another Queue 

The Assign To Another Queue link allows users to assign cases from a central queue to smaller 
employee-specific queues in order to distribute the workload. 

1. To move one or more cases from one queue to another, select the checkbox(es)  next to 
the case(s) to be re-assigned and select the Assign To Another Queue link. 

 

2. A dropdown of available queues appears. The list displayed will be filtered based on the 
type of originating queue (registration, order, or amendment) and the user’s security 
privileges.  The list will include only those queues which have been configured as “Manual” 
in the Table Maintenance module. 

 

3. Select the desired manual work queue and select the Assign button to move the case to 
the new queue. 
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After selecting a new queue from the dropdown: 

• The new work queue assign status will update/replace the original work queue status. 

• The work queue page refreshes and the new queue to which the case was assigned 
displays. 

11.1.9 Add – Comments 

DAVE™ provides the ability to view, create, or update comments on a case from within a 
queue.  Comments are messages associated with a particular record such as reminder notes 
concerning special conditions. 

1. Select a record and choose the Comments link. 

 

2. The Comments popup window is displayed. Select the New Comment button to add a 
comment. 

 If the Assign button is disabled, a case cannot be moved to the selected queue.  
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3. Select a value from the Comment Type dropdown.  Every comment must be associated 
with a type. 

 

4. Enter text into the Comment field.  Comments can be up to 4000 characters. A counter at 
the bottom of the page provides a real time character count.  Keep in mind spaces count 
as characters. 

5. Once a comment has been entered, select the Save button to save the comment, Clear to 
erase the text, or Cancel to close the Comments dialog without saving the comment. 

6. Once the comment has been saved, it appears in the comments list.  If the user has the 
appropriate security, the Edit and Delete links will be available. Select Edit or Delete to 
change or remove the comment, New Comment to enter another comment, or Close to 
close and return to the queue search results page. 
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The Comments icon now appears adjacent to the case in the All column to indicate there is a 
comment attached to the record. 

 

11.1.10 Add – Correspondence 

DAVE™ provides the ability to view, create, or update case correspondence from within a 
queue. The Correspondence link provides access to MS Word templates within DAVETM that 
can be used to produce letters and other forms of communication for a case when needed.  

 

 

 

1. Place a checkmark next to the desired record and select the Correspondence link  

 

2. The Correspondence page displays.  Select the New Correspondence button to access the 
correspondence templates. 

 Templates are created using MS Word and may be used for amendments, rejection 
letters, requesting corrections to a record, for special statuses, and other correspondence 
purposes.   
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3. Templates that have been saved and made available for use appear in the table.  Select 
the Select link adjacent to the desired template. 

 

4. The Correspondence dialog expands to show template details.  Select the Download link 
in the File column. 

 

5. In the File Download dialogue box, select Open to access the template.  MS Word opens 
the template file.  Enter content for the correspondence and select Save. 
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11.1.11 Print – Queue List 

The Print menu at the bottom of any Queue page will always have at least one option: Queue 
List.  

1. Select Queue List to print the page displayed. 

 

2. The printout only includes the number of records selected in the Display field. If a listing of 
all records in the queue is desired, select the Show All Rows button. 

 An electronic version of every correspondence is saved and linked to the specific 
Death Registration to which it was attached. 
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3. The Print dialog box appears. Select the desired printer and Print. 

11.1.12 Queue Aging Report 

The Queue Aging Report link produces a list of cases sorted by how many days they have 
been in the queue. 

1. Select the Queue Aging Report link under the Print menu. 

 

2. The File Download dialog appears.  Select Open to view the .pdf, Save to save the file 
locally, or Cancel to return to the Queue page 
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3. The following is a sample of the .pdf output.  The columns to the right contain “x” marks 
denoting the number of days a record has been in the queue. 

 

 

12. Accounting 

The Accounting pages within DAVE™ allow users with appropriate security privileges to close 
cashier transactions, reconcile transactions, and print reports.  The system allows for 
reconciling payment transactions by user and office, and generating accounting-related 
reports, such as revenue reports.   

Vital Records agencies typically have one-to-many cashiers who process orders for a specific 
time period (daily or per shift).  At the end of this time period, all non-credit card payments are 
counted and reconciled.  The following steps outline the process a cashier would go through 
to cashout and reconcile their transactions: 

1 The cashier totals each type of payment collected (cash, check, money order, etc.). 

2 After each payment type is manually counted and totaled, it is compared to the 
DAVE™ application total for the payments the cashier entered. 

3 If the two totals differ, the cashier must try to reconcile the difference. 

4 In some cases, a cashier may be unable to reconcile the difference. 

5 The cashier has the ability to close transactions with a discrepancy. 

 

The DAVE™ application provides an Accounting menu used to access cashout and 
reconciliation functions, Cashier Close and Cashier Reconciliation, two specific search 
options, Invoice Search and Refund Search, and a separate menu option that is used 
exclusively for closing out credit card transactions, VitalChek Close. 
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12.1.1 Cashier Close 

DAVETM includes a Cashier Close module designed to help registration staff perform a daily 
“cashout” of the payments processed, and balance a cash drawer.  The Cashier Close option 
is used to process payments for customer orders.  The process of cashing out is performed 
daily. It begins with the cashier entering the amount of money received into the Cashier Close 
page.   

From the Main Menu select Accounting -> Cashier Close. This opens the Cashier Close 
page. 

 

The top of the Cashier Close page displays the Start Date and End Date of the transactions 
to be included in the cashout. The Start Date is system-filled with date and time of the last 
transaction of the current user (user that is currently logged into DAVE™) at the time the report 
was last run. The End Date is system-filled with the current date and time. These are the range 
of dates/times that the transactions were performed that will be included in the Cashier Close 
report. 

On the left of the page are the Qty $ accounting controls for entering cash amounts, and the 
Total Cash control which increments the sum as all cash entries are made.  The quantity of 
each denomination of currency listed and the total monetary amount of coins collected get 
entered in these accounting controls. 

 

Qty $ Accounting controls—down the left side of the page which allow entry of the ‘quantity’ of each 
type of bill collected 

Coins Accounting control—allows entry of the total amount of coinage collected 

Total Cash All the amounts entered in the Qty $ and Coins controls above are totaled here 

Cashier Total Amount accumulated in the Total Cash control is copied here. 

 

 The accounting controls allow numeric entries and commas only. 
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In the illustration, the cashier collected four $5 bill and eight $20 bills. The bill amounts are 
entered in their respective Qty $ accounting controls. As the entries are made, the Total Cash 
amount is incremented accordingly [$180.00].  This amount is then carried over to the Cashier 
Total. 

At the bottom of the page are five navigation buttons: Clear, Reconcile, Save, Transactions 
and Calculator. 

  

 

Clear Clears the values entered on the Cashier Close page and resets the page to zeros. 

Reconcile Settles the cashier’s transactions.  When the “Reconcile” button is selected, the application compares 
the “Cashier Total” (sum of all values entered on the Cashier Close page) with the total of all the 
payment transactions entered by the cashier between the date and time of last close and the current 
date and time. 

If the two values do not match, the application displays an onscreen message that there are 
discrepancies.  If the two values match, the application displays an onscreen message that there are 
no discrepancies. 

Save Stores the cashier’s entries, and closes the transactions.  The cashier is indicating he/she agrees with 
the application (no discrepancy) or that he/she is unable to reconcile a discrepancy.  Once the values 
are saved all controls are disabled. 

Transactions Displays the Cashier Transactions page listing all transactions for the current cash out. 

Calculator Provides standard calculator functionality. 

 
If there are no cashouts for a cashier to perform, DAVE™ displays a message below the 
Cashier Total control. 

 

In another illustration, there is one check that equals $45. “45” is entered into the Checks 
control The DAVE™ application adds the necessary zeros (i.e., “45.00”). 

 The Save button is disabled until a cashier does a cash out/reconciliation. 
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As the amounts, are entered, the Total control on the right is incremented accordingly and the 
Cashier Total will be the summation of both the Total Cash control and the Total (checks and 
money orders) control.  It is not necessary to enter a zero if no quantity of a denomination 
exists.  
 

 

 
If a cashier does not have security privileges to enter all payment types (i.e., cash, money 
order, checks, etc.), the Qty $ accounting controls for cash entry and the Money Orders control 
are “restricted” and show as disabled, but cashier has access to enter data in the Checks 
control. 

   

12.1.2 Closing a Check Payment Order 

Check payments are closed differently than cash payment orders, but the two must eventually 
be combined for each cashier. From the Cashier Close page, click the Transactions button. 

The Cashier Transactions page displays a data grid listing containing the Order Id numbers 
for orders that have been entered into the DAVE™ application. Click the Return button to go 
back to the Cashier Close page. 

 The Cashier Close option does not include credit card payments. Credit card 
payments are reconciled using the VitalChek Close option. See section 12.1 VitalChek 
Close 
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Enter an amount ($45.00) in the Checks accounting control. Click the Reconcile button. 

 

Because there was also a cash payment associated with this Order Id number it must entered 
as well. The application issues an error message on the page to alert that there is a 
discrepancy. 

 

Enter all cash payments in the appropriate Qty $ accounting control; a $10.00 amount appears 
in the Total Cash control and gets added to the check payment and totaled as $20.00 in the 
Cashier Total control. Click Save. 

 



State of Arizona DAVETM User Guide  

 

  325 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

If the cashout was successful, an application-generated onscreen message appears in red 
showing that there are now no transactions to cashout. 

 

12.2 Cashier Reconciliation 

After a cashier closes daily transactions, a supervisor or other authorized staff person verifies 
the cashier’s totals.  The supervisor repeats the process followed by the cashier and if a 
discrepancy exists he/she will try to resolve it by comparing the application total payments and 
cashier total payments to the application total for amount due (the total fees charged for the 
services associated with the payments being counted). 

If an error is discovered in the payment transactions entered by the cashier, the supervisor 
must correct the order(s).  If the supervisor is unable to resolve the discrepancy (most often 
the discrepancy happens in providing change to a customer), the supervisor closes the 
transactions and adds a comment describing the amount and reason for the discrepancy.  
  

 

Often there is a legitimate reason for the amount due to differ from the total payments.  For 
example, mail orders are often received with insufficient payment.  In this case, when the order 
is entered the amount due may be $15.00 but the payment entered may only be $10.00.  The 
amount received ($10.00) is entered and closed the day of receipt.  A correspondence is then 
sent to the customer informing them that their order cannot be processed until additional 
payment is received.  The remaining balance is entered upon receipt. 

Once a user has cashed out, a supervisor must post the transactions and adjust any 
discrepancies that may exist.  The feature that accommodates this process in DAVETM is known 
as Cashier Reconciliation and it helps ensure transactions are reconciled accurately.  It is 
essential that a supervisor reconciles cashouts on a regular, scheduled basis. The frequency 
that cashouts are performed is based upon jurisdictional requirements and business 
processes, i.e., some state do three times daily, others at least once daily. 

From the Main Menu select: Accounting -> Cashier Reconciliation. The Search for 
Cashout page is displayed.   

 Use of comments is not mandatory, but can be very helpful in resolving discrepancies 
and is highly recommended. 
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To search for transactions to reconcile for a specific cashier, select the Cashier Name from 
the dropdown.  

 

Options for populating the controls on this page in order to narrow a search are as follows: 
Setting a Start Date and End Date will return all transactions processed within those dates. 

The Verified? dropdown contains three options:  

All Displays all cash outs, regardless of status 

No Returns a listing of cash out transactions that have not been reconciled or verified 

Yes Allows review of previously reconciled transactions 

 

Although most agencies do not allow cashiers to process additional orders until the previous 
batch of transactions have been verified by a supervisor, some agencies require cashiers to 
begin processing orders immediately upon “close” of the previous batch.  As a result, the 
application must provide the ability to link a cashier’s transactions by cashout time period so 
that the supervisor’s reconciliation will include the same transactions as the cashiers, even if 
new transactions have been entered since the time the cashier closed. 

When a cashier takes the first payment, DAVE™ creates a Cash Out ID and associates all 
payments with that ID until the cashier closes out the daily transactions.   

 

On the Search for Cashout page click Clear to clear all entries and begin again or Search to 
find cashouts that match the selected criteria.  In this illustration, the search criteria is for All 
cashouts processed by the cashier or State Office Administrator, between Apr-13-2010 and 
Jul-19-2010. 

 

Example scenario: Select State Office Administrator from the Cashier Name dropdown and 
Yes from the Verified? dropdown, then click the Search button. 

 

 Only cashiers with outstanding cash outs are displayed in the list. 
 

 If the cashier deletes the first payment, the cash out ID will be deleted as well. 
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The page expands with a data grid listing.  From the data grid listing select the number link in 
the Cashout Id column that corresponds to the transaction that needs to be reconciled. 

 

The Cashier Reconciliation page appears.  

 

The following descriptions explain the controls used on the Cashier Reconciliation page. 

Cashier Displays the name of the Cashier associated with this particular cash out. 

From: and To Displays the date range for which transactions were retrieved. 

Payment Type Indicates the type of payment for which entries will be made in the columns to the 
right. 

System Total Displays the amount of cash (including coins) that the cashier should have based on 
the number and amount of transactions retrieved. 

Cashier Total Displays the totals entered by the Cashier on the Cashier Close page. 

Discrepancy Displays the difference between the System Total and the Cashier Total.  This Cash 
out contains a discrepancy of -$30.00. 

Supervisor Total Displays the amount of funds as counted by the cashier’s supervisor. 

Supervisor Cash 
Details 

As the supervisor counts the Cashiers funds, the number of each denomination of bill 
collected is entered in the appropriate control. 

Comments Allows Supervisor to explain any discrepancies found. 
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Reports Includes a number of reports that system user can print. 

Total Amount Due Displays the total fees due for the orders associated with the payment transactions. 

 
Under Supervisor Cash Details, begin entering the numbers of denominations of bills 
collected by the cashier.  In this example the cashier collected two one dollar bills so the 
supervisor entered 2 in the Qty $1 text entry control.  The totals are reflected in the Total Cash 
control. 

 

As entries are made in the Supervisor Cash Details column a running total is also kept in the 
Supervisor Total column. 

In the Comments text entry control comments can be added to explain any discrepancies 
between the System Total, Cashier Total and Supervisor Total, or general notes about 
anything. Comments from a supervisor can be used to confirm and explain any discrepancies. 

 

 

The buttons at the bottom of the Cashier Reconciliation page function as follows: 

 

Select the Transactions button to view a listing of all transactions associated with this cashout. 

 Use of comments is not mandatory, but can be very helpful in resolving discrepancies 
and is highly recommended. 
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Select Save to save all results, including any comments.  This locks in all entries and prevents 
future changes to the cashout. 

 

Select Clear to clear all Supervisor Cash Details entries. 

 

  

 

Select Return to return to the Search For Cashout page. If the user has not clicked Save, all 
unsaved data will be lost if the Return button is selected. 

 Entries in the System Total, Cashier Total, and Discrepancy columns are unaffected 
by the Clear button. 
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Select Calculator to launch the DAVE™ application calculator, which is useful in double 
checking figures and limiting errors.   

Standard functionality exists: the / symbol divides, the * multiplies; the AC button clears 
contents.   

Click on the X in the upper right corner to close the calculator window. 

 

 

12.2.1 Retrieving Transactions and Reconciling 

Although the review of transactions is not required prior to reconciling an account, DAVE™ 
provides the Cashier Transactions page in order to view each transaction that was entered 
by a specific user based on the last Cashier Close (the Start Date) and the current date (End 
Date), which are displayed at the top of the page.   

To access the Cashier Transactions page, select the Transactions button at the bottom of 
the Cashier Close page. 
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The Cashier Transactions page displays and lists all transactions that were processed from 
the Start Date through the End Date. 

 

 

 
In addition to all transactions entered, the Cashier Transactions data grid listing also displays 
the total dollar amount of all transactions along with other pertinent transaction-related 
information. The Transaction Total shown is the total to reconcile against. 

The data grid listing displays a row for each order payment received.  The rows initially sort in 
descending order by Order Id (i.e., the most recent transaction appears at the top of the list), 
but can be changed by clicking on any of the column header links.  The Cashier Transactions 
page also includes the following information. 

Order Id 
Application-assigned identification number—assigned to the order when it gets 
created.  If the order is part of a batch file that will be paid for by an invoice, 
then the invoice number appears in this column in place of the order number. 

Date Entered Date the payment was entered 

Registrant Name Name on the certificate requested 

 The Cashier Total on the Cashier Closeout page should match the Transaction Total 
on the Cashier Transactions page. 
 



State of Arizona DAVETM User Guide  

 

  332 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

Fees Charged Amount of money that was charged for the service provided 

Payment Type Type of money received for the service: cash, check, money order, or invoice 

Check Number Number of the check or money order that was entered on the Payments page 

Amount 

Total amount of money received by the cashier, refunded to the 
customer/applicant, or is a result of a bad payment (e.g. NSF, etc.).  If 
parenthesis surrounds the amount, i.e., ($5.00), the amount enclosed is a 
refund and must be subtracted from the Transaction Total. 

 

At the bottom of the Cashier Transactions page is a Transaction Total and a Revenue Total, 
and since these totals are similar in nature, the tooltips text explains the primary differences. 

 

DAVE™ also provides a Print button and a Return button at the bottom of the Cashier 
Transactions page. Click the Return button to close the Cashier Transactions page and 
return to the main Cashier Close page. 

Selecting Print launches the File Download dialog. Click the Open button to open the Cashier 
Transaction Report for printing. 
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The following extract of the Cashier Transaction Report shows the layout of this report. 

 

 

Once all monies have been entered into the Cashier Close page and the cashier reviews the 
transactions, select the Reconcile button. Once the Reconcile button is selected, the Save 
button is enabled and the user can save all entries made to the Cashier Close page.   
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If there are differences between the totals entered on the Cashier Close page and the system 
calculated payment total, an error message displays below the Cashier Total control. 

 

The cashier must re-count the money received, make any necessary corrections, and select 
the Reconcile button again. The discrepancy must be cleared up and the transactions 
reconciled until everything is balanced. 

Entering the amounts shown (in Total Cash) balances the cash drawer. The error message 
has been replaced and the Save button is now enabled. All discrepancies must be resolved 
before Save will be enabled. Select the Save button to finish balancing/reconciling. 

 

Verify and re-enter values (if necessary) on the Cashier Close page so that the total matches 
the total on the transactions report.  Click Reconcile again. 

When a discrepancy occurs, it is a good practice for the cashier to print and review the Cashier 
Transactions Report to help locate potential discrepancies, and correct the data entry for any 
incorrectly entered payments.  

When the reconciliation of the cashout is complete and there are no discrepancies, the Save 
button is enabled and the cashier must select it to save all entries and complete the close out.  
Selecting Save enables the Reports links for generating cashier-related reports that can be 
viewed or printed. To print any of these reports, click its link and select Open from the File 
Download dialog. 

If no discrepancies exist, the system issues a successful popup message. Click OK. 

 

All controls and buttons on the Cashier Close page are disabled signifying that there is no 
further action required for the close out. The confirmation message “No transactions to 
cashout” appears below the Cashier Total box in red, and the links below Reports are 
enabled. Select the OK button from the popup message and exit the Cashier Close page by 
selecting any link from the Main Menu. 

 

 Once Save has been selected, no further changes are allowed. 
 



State of Arizona DAVETM User Guide  

 

  335 of 351 

March 2017 

LexisNexis VitalChek Network, Inc. Proprietary and Confidential Information (c) 2014.  All rights reserved.  
 

12.2.2 Accounting-Related Reports 

Multiple accounting-related reports are available, such as: Cashier Deposit, Cashier 
Transactions, and Cashier Close, and Cashier Worksheet. Select any report link to launch 
the File Download dialog.  Click the Open button to open the report for viewing and/or printing. 

 

Sample Cashier Deposit Report 
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Sample Cashier Transaction Report 
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Sample Cashier Close Report 

 

 

 

 

12.3 VitalChek Close 

Credit card and EFT payment closeouts are handled separately from other closeout processes.  
The VitalChek Close page is used for cashing out credit card orders only.  

The DAVE™ application includes a VitalChek Close feature. The VitalChek Close page is 
used to reconcile daily credit card transactions and deposit the credit cards funds via an ACH 
deposit. 

Typically, the VitalChek Close process occurs at the end of the business day.  Some 
jurisdictions choose to close out their credit card transactions more than once per day.   
VitalChek credit card payments can be configured to be closed by a single person in an office 
or by each cashier.  
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The standard process used to reconcile credit card transactions is: 
 

1 User reviews all credit card transactions since the last close was performed. 

2 
If correct, user accepts or closes the transactions. If incorrect, user tries to reconcile the 
difference or calls The Provider Services Unit at the VitalChek corporate office. Once the problem 
is resolved, user accepts transactions. 

3 
User prints the VitalChek check. The VitalChek check includes the sum of all the state fees for 
the credit card orders processed since last close. 

 
 

To run the VitalChek Close process, from the Main Menu select 
Accounting and then select VitalChek Close. 

 

The VitalChek Close page will be displayed. 

 
 
 

 
 
 

 

If there are no credit card transactions since the last date the VitalChek close was run, when 
the VitalChek Close page initially displays, the View Credit Card Report, and Deposit Funds 
buttons are disabled. A message is also displayed in red stating, “Check cannot be printed. 
There are no transactions to close. 
 

 
If there are credit transactions since the last date the VitalChek close was run, when the 
VitalChek Close page initially displays only the Deposit Funds button will be disabled.   
 
The VitalChek Close page displays the following items: 
  

Credit Card Transactions Total number of authorized transactions since the last close. 

Start Date System-filled with date and time of the first transaction in the close. 

End Date System-filled with current date and time. 

 Access to the VitalChek close feature is based on security privileges.  
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Total State Fees 
Sum of the state fees (excludes VitalChek fee and shipping fee[s]) for all 
authorized transactions—minus the sum of the state fees for all voided 
or canceled transactions between start and end date. 

Check Number Pre-printed check number on the check paper provided by VitalChek. 

 
The VitalChek Close page determines the appropriate account and amount of transactions to 
cash out based on the current office or cashier performing the VitalChek Close. 
 
Select the View Credit Card Report to initiate the VitalChek Close process.  Once selected a 
message will be displayed stating, “The VitalChek Close Report Job has been created. 
Please check your message for results.” 
 
 
 
 
 
 

 

 

 

 

 

 

 

Depending on the amount of transactions to process the job may take a few sections to 
several minutes to run.  
 
Once the job is complete, return to the VitalChek Close page and the View Credit Report 
button will be disabled, however the Deposit Funds buttons will be enabled. A VitalChek 
Close Report link will also now be displayed. 

 
Select the VitalChek Close Report link to view the transactions and ensure there are no 
errors. 
 
 

 You can also remain on the VitalChek Close page and simply select the Refresh 
button that is displayed. 
 

 
 
Once the VitalChek Close job is complete, the Refresh link will be updated with a link to 
the VitalChek Close Report. 
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SAMPLE VC CLOSE REPORT 

SAMPLE VC CLOSE REPORT 
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Once the VitalChek Close Report is reviewed and all transactions are deemed correct, select 
the Deposit Funds button the VitalChek Close page. 

The funds will be deposited via the ACH process into the offices designated account.  

 

13. Reports 

 

 

13.1 Running Reports from the Reports Menu 

To generate reports, authorized users select one of the report menu options from the Reports 
Menu.  

 

Each Reports menu option may have multiple types of reports listed when expanded.  Select 
one of the reports and the page refreshes for entry of parameters. 

Enter the required parameters and select the Load Report button and print and/or save the 
PDF document. 

 The ability to select the Reports link and the individual reports is based on user 
security privileges.   

 If the VitalChek Close Report is incorrect, then reconciliation of the difference will need to 
occur before selecting the Deposit Funds button. Call the Provider Services Unit at the 
VitalChek corporate office for assistance. 
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13.2 Running Reports from the Job Scheduler 

Complex reports requiring multiple calculations or queries must be run from the Job Scheduler.  

From the Main Menu choose Table Maintenance > Jobs, select the Job Scheduler link. 

 

The Job Scheduler in DAVE™ is a job wizard that steps through seven different pages.  
Running reports using this functionality enables specific critera to be entered to affect the data 
that is being output to the report. 

 If the user is not a State agency user, DAVE™ filters the report to include only those 
cases owned by the facility or office running the report. 
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Step 1: The opening page of the Job Scheduler displays the Select Process Type dropdown 
list.  This is Step 1 of completing the job wizard.  

 

Select Reports from the Select Process Type dropdown and select Next. 

 

Step 2: Step 2 requires the selection of a specific report from the Select Reports Process 
dropdown.  Samples of the reports available for output in DAVE™ are included in the 
“Core_Att_K_Reports” documentation. 
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Steps 3-6: Continue to enter desired criteria on all the pages of the Job Scheduler wizard 
through Step 6. Select the Finish button. 

 

Step 7: In Step 7, DAVE™ will acknowledge successful completion of the job wizard. A link to 
the job schedule appears. The user is also given the option to Schedule another job, or Return 
to the Main Menu. Select the job schedule link. 
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The completed page appears with all the details of the job. Select the Report results link. 

 

Select Open to open the file for viewing. 
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The report is opened for viewing.  The following is an extract from the Interstate Exchange 
Death Abstract report, as selected in Step 2 above. 

 
There are a number of reports that authorized users can access in DAVE™.  These reports 
can be a valuable aide in managing the vital records business.  For more information on reports 
and access to reports, see the System Administrator. 
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